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CUSTOMER SUPPORT
Dear MAGIX customer,

Our aim is to provide convenient, fast and solution-focused support, which is why you can get unlimited
web support and help through our online community at www.magix.info.

As a registered MAGIX customer, you have unlimited access to web support offered by the MAGIX
service portal in the Support area at www.magix.info. You have access to an intelligent help wizard,
high-quality FAQs, patches and user reports that are constantly updated.

The Online Community is available for free to all registered MAGIX customers in the Forum area. The
community enables you to ask members questions concerning MAGIX products as well as use the
search function in order to search for specific topics or answers. In addition to questions & answers, the
knowledge pool includes a glossary, video tutorials and a discussion forum. The multiple experts, who
are on www.magix.info everyday, guarantee quick answers, which sometimes come within minutes of a
question being posted.

Note: A free registration is required for a support request at www.magix.info.

MAGIX Sales Department

You can reach the MAGIX Sales Department workdays for help with the following questions and
problems:

n Orders
n Product consulting (pre-purchase)
n Upgrade requests
n Returns

Phone: +49 5741 3455-31, Monday to Friday 10:00 am - 4:00 pm CET

Email: infoservice@magix.net

Address:MAGIX Software GmbH, Borsigstrasse 24, 32312 Lübbecke

Particularities for purchases made through Steam™

Different conditions apply if you have purchased the program through Steam™. You can find more
information at https://support.steampowered.com.
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BEFORE YOU START...

Note regarding special program versions: This documentation describes the full functionality of
MOVIE STUDIO. The functionality and service may vary depending on the program version/edition
you have purchased.

System requirements

n For Microsoft Windows 10 | 11
n 64-bit systems

Minimum configuration

n Processor: Intel Core i-series, AMD FX series
n RAM: 4 GB min.
n Graphics card: Onboard, 2 GB VRAM and DirectX 12 support
n Hard drive space: 2 GB free disk space for program installation; 10 GB recommended for

Platinum/Suite versions
n Internet connection: Required for registering and validating the program, as well as for some

program functions. Program requires one-time registration.

Recommended configurations

n Processor: 6th generation Intel Core i-series or higher, AMD Ryzen or higher
n RAM: 16 GB min.
n Graphics card: INFUSION Engine 3 provides hardware acceleration for import and export using

Intel, NVIDIA and AMD GPUs:
l Intel Graphics HD 620 or higher with 4 GB (Intel driver version 27.20.100.9466 or

higher)
l NVIDIA Geforce GTX 1050ti or higher with 4 GB (GeForce Game Ready driver

version 496.76 or higher)
l AMD Radeon RX470 or higher with 4 GB
l Recommended for 4K/8K editing:

▬ NVIDIA Geforce GTX 1070 8 GB or higher
▬ AMD Radeon RX5xxx 8 GB or higher

n Hard Disk Space: 10 GB free space.

Serial number

A serial number is included in each product. This serial number is required for software activation.
Please store this number in a safe place.
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Use of a serial number

With a serial number your program license is clearly assigned to you and only you. This allows you to
use the free customer service via email.

Serial numbers also help protect against software piracy. This makes it possible for us to offer our
customers the most value for their money.

Where is the serial number located?

If you have purchased a download version, you will receive a confirmation email containing the serial
number that you can use to activate the program. This will be sent immediately following purchase to
the email address you provided.

For boxed versions of the program, the voucher code can be found inside the box. You can redeem this
code at https://www.magix.com/redeem and will then receive a serial number by email.

When is the serial number needed?

The serial number is required when you start the program the first time, as well as for program
registration.

Using the serial number on another computer

If you want to use the serial number on another computer or after reinstalling your operating system,
you must deactivate the program on your current PC.

This "releases" the serial number from the current computer so that it can be used on another.

Note: You can also deactivate the program in the MAGIX Service Center, but it is much more
convenient to do this with the integrated feature in MOVIE STUDIO.

Uninstall program

In Windows 10, you can uninstall MOVIE STUDIO under "Windows Settings" > "Apps".

In older Windows systems, go to the Control Panel and select "Software" or "Programs and Features" to
uninstall MOVIE STUDIO.
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WHAT IS MOVIE STUDIO?
MOVIE STUDIO is a complete all-in-one movie studio for your PC. With MOVIE STUDIO you can easily
transfer your recordings to your computer and then to DVD, AVCHD or Blu-ray Disc after you have
enhanced them. It's perfect for theater-quality presentation on TV, screen, or monitor.

Videos, photos as well as additional audio and video material can be transferred from various devices to
PC. Longer movies can be automatically separated into chapters or scenes. You can also do the
opposite and automatically combine individual recordings to make a single movie.

Add music, theater-quality transitions, text and selected effects to your own movies with a click. The
easy-to-use interface, advanced technology and handy assistants guarantee perfect results at lightning
speed!

Once your video is finished, you can use it in different ways: transfer it back onto the tape or to your
camcorder. You can also burn it to disc and view it on TV. Or share your video on the Internet.

Tip regarding special program versions

Note: This documentation describes the full functionality of MOVIE STUDIO. Depending on the
program version/edition you have purchased, the functionality and service may vary.

Four program versions

n The entry-level versionMOVIE STUDIO is aimed first and foremost at beginners who want to
easily make and edit videos on their PC without the need for previous video editing experience.
This program version contains helpful picture and sound wizards that help make the video
editing process easier, as well as an intuitive user interface.

n The advanced versionMOVIE STUDIO Plus offers all of the features of the standard version
plus extra tools and features for video editing. This version is intended for advanced users.

n MOVIE STUDIO Premium contains all of the features of the Plus version. This version also
comes with powerful add-on programs from third party providers.

n MAGIX Video Pro X delivers the full extent of video functions by MAGIX – the entire toolkit
from the Premium version as well as additional features.

See the MAGIX website for an in-depth version comparison. Click here ...

Features

Record options
n AVCHD camera
n HDV cameras: HDV1 and HDV2 camcorders
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n DV cameras: Mini DV camcorders or DV video recorders
n Video: Analog TV, video input, VHS recorders, webcams
n Audio: Microphones, cassette recorders, MiniDisc players, turntables
n Screen (only in the Plus/Premium): PC monitor.
n Single frame: Single and series images from webcams, video recorders, video cameras, or TV

cards
Analog capture requires capture cards compatible with DirectShow. DV recording take place via
FireWire.

Supported formats

Import:

Video: (DV-)AVI, MJPEG, MKV, MPEG-2/4 (HEVC/H.265*), WMV(HD)

Audio:WAV, MP3, OGG, WMA; multichannel sound also in Plus/Premium versions

Image: BMP, GIF, JPEG, TGA, TIF, PNG, HEIF

Export:

Video: (DV-)AVI, MJPEG, MPEG-1/2/4 (HEVC/H.265*), WMV(HD)

Audio:MP3, WAV

Image: BMP, JPEG

Other: DVD, Blu-ray Disc, AVCHD disc

Note: This program requires an Internet connection for many of its functions. MP3 export requires
installation of Windows Media Player Version 10 or higher.

*The codec requires a fee-based activation in MOVIE STUDIO Classic the first time you import or
export HEVC material.

Burnable disc formats
You will find the following burning options in the "Burn" area:

n DVD
n Blu-ray Disc
n AVCHD disc (on DVD and Blu-ray Discs)

In the "File" menu you can make and burn backup copies.
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Multimedia editable disc menus
Many templates for DVD menus that are later used on TV to aid in film and chapter selection are
included with the program. The majority are also in 16:9 widescreen format. These may simply be
applied during burning to provide a professional appearance to the disc.

Every menu template may be customized with personal photos, thematic animations, 3D captions,
sound, intro videos, etc.

What's new?

n High-Speed Timeline
The timeline is now rendered much faster, which makes navigating projects smoother.

n Intel Hyper Encode
Both graphics cards are simultaneously enabled on Intel desktop and laptop systems equipped
with an onboard GPU and an additional Intel GPU, such as the brand-new Intel® Arc™.

n Media Pool: View settings and filters
l Mark favorites
l Intelligent search feature
l Expand and collapse categories
l Switch between List and Icon view
l New releases and special offers in the In-app Store
Media Pool (⇗26)

n INFUSION Engine 3
The brand-new INFUSION Engine 3 enables you to edit even complex projects in up to 8K with
super smooth playback, and it harnesses the full speed of your GPU to export your videos.

n Easily design your own animations
The new handles allow you to adjust both the position and scale of video objects directly in the
program monitor. Flexible anchor points offer new creative possibilities for your animations – in
this way you can create dynamic movements just the way you imagined.

Size/Position/Rotation (⇗119)
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PROGRAM INTERFACE OVERVIEW

Menu bar

The menu bar offers access to most functions and buttons and allows quick access to important
commands.

New project Creates a newMOVIE STUDIO project. This will open the Start
dialog.

Load project With this option you can load a project or a media file.
Please note that to load a project fully, all of the files associated with
the project must be available. MOVIE STUDIO will search for all
used sounds and video files in the folders in which they were located
when the move was saved.

Save project The current project will be saved under the name you specify for it. If
you have not yet specified a name for your project, a dialog will open
asking you to do so.

Note: The project file contains all information about the used
media files, cuts, effects, and titles, but not the picture and
sound material itself. This is always contained in the recorded or
imported media files, which remains unchanged during editing
with MOVIE STUDIO. In order to save a movie in its own folder,
e.g. for use on another PC, go to "File > Backup" and use the
function "Copy film and media to folder".
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Switching the interface

You can switch back and forth between two different interfaces top right in the program.

»EDIT« screen »BURN« screen

The Edit interface is the main view. You can
load your videos here and edit them in a project
window.

The Burn screen is a special interface for burning
discs. This enables you to design a selection
menu for use on DVDs, Blu-ray Discs and
AVCHD discs.

"Edit" interface (⇗19) The "Burn" interface (⇗47)

The third symbol opens a dialog for finishing the movie.

More information

Finish movie, dialog (⇗208)

"Edit" interface

1 Program monitor (⇗20)
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2 Media Pool (⇗20)

3 Project Window (⇗20)

Program monitor
Video and image objects are displayed and files from the Media Pool can be previewed here.

Program monitor with transport controls (⇗21)

Media Pool
Here you'll find your hard drive content and the areas for editing and designing your video's media, as
well as the MAGIX Store.

Various content will be displayed depending on which area of the Media Pool you are in. You can
preview templates or import media to your project. In the »EFFECTS« area you can fade in the effects
to create effect curves.

Media Pool (⇗26)

Project Window
The project window is where video editing takes place. Media from the Media Pool are imported as
objects into the project window and can be sorted there. There are various display modes for editing.

Scene overview
The scene overview provides a scaleable overview of the scenes. You can use this to
comfortably view, sort, and delete unnecessary scenes.

Storyboard mode
This view offers an easy, streamlined interface to simplify the editing process. All scenes from
your film are listed sequentially in the "Storyboard" mode. Every scene is displayed with a
preview picture in the storyboard.

Timeline mode
More complicated editing takes place in this mode. All files are displayed as an object on a
timeline.

Best audio solution
Multicam editing enables easy cutting of various recordings of the same scene from different
camera perspectives.

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Project Window (⇗33)
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Customizing the workspace
project window and Media Pool can be positioned anywhere on the screen or completely hidden.

Saving a custom window arrangement

You can save your customized window arrangement and restore it anytime:

1. In the menu, click »WINDOW«»WINDOW ARRANGEMENT«»SAVE...«.
2. In the dialog that opens, enter a name under which the window arrangement should be displayed

in the menu.
3. In the Media Pool you can define whether the main navigation and subnavigation should be

saved along with the alignment.

Custom settings are automatically saved when MOVIE STUDIO is closed and remain when the
program is reopened.

Tip: If you are working with two monitors, you can use one to display the program monitor as a
fullscreen. To do this, move the cursor to the upper border of the program monitor and click and drag it
to the other screen. Then click on the small rectangle in the upper right. The program monitor will now
be displayed in fullscreen mode.

Reset window arrangement

If lose track of the settings, you can use »WINDOW« > »RESET WINDOW ARRANGEMENT« or the
keyboard shortcut F9 to reset the basic settings.

Program monitor with transport controls
The program monitor shows the content of the current movie. In some cases the program monitor is
also used for editing certain effects. Examples of this are:

n Title editor
n various movement effects
n The program monitor additionally shows the time position of the playback marker as well as the

length of the movie.
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1 Program monitor menu

2 Playback marker position

3 Title bar; shows the name of the current film

4 Length of current film

5 Full-screen mode button

6 Area to view

7 Transport control

In addition to showing the current film, the program monitor also performs the following functions:

n Preview of video and image files
n Inserting sections of video files into the movie
n Movie overview
n Full screen mode

Options

n 3D display
n Set size (resolution)
n Move position (with time bar)

Menu in program monitor

The program monitor menu is opened with the menu button.

The following functions can be selected:

n Define zoom factor
n Specify image position for preview
n Activate movie overview
n Fade jog and shuttle in and out.
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n Set program monitor standard (2D) view
n Activate 3D playback
n Activate 360° display
n Access to the Performance Menu (this is also in the context menu of the Preview quality

button)

Zoom

The video image in the program monitor can be minimized and maximized with the help of the menu
entry. This comes into use especially during effect animation.

Note: This zoom applies only to the current view in the program monitor and will not be applied as a
video effect.

Full screen mode

The program monitor can be expanded to full-screen size.

Activate full-screen mode:

1. Double-click in the program monitor display area,
2. press the key combination Alt + Enter or
3. click the button at the top right edge of the program monitor.
4. Pressing escape (Esc) exits full-screen mode.

Note: The program monitor can also be moved in full-screen mode. A special context menu (right
mouse button) is also available. The transport control can be faded out.

Show/hide transport control:

Requirement: Full-screen mode must be active

1. Right click to open the context menu in the program monitor display area. You can see the
current status of this setting in the check box before the menu entry »SHOW TRANSPORT
CONTROL«.

2. Select the entry »SHOW TRANSPORT CONTROL«. The transport control will be shown or
hidden accordingly.

Set size

Tip: Useful presets for the arranger and program monitor can be found in the tab "Display templates"
in the program settings.

Set size:
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1. Move the mouse cursor to the edge of the program monitor. This turns the mouse pointer into a
double arrow.

2. Click and hold the left mouse button over the edge of the program monitor.
3. Drag the program monitor to the desired size.
4. Release the mouse button.

Note: Setting the size of the program monitor is easier when you set the height and width one after
the other.

Set size via the context menu:

1. Right click to open the context menu in the program monitor display area.
2. Select the desired size in the context menu:
n By default: Choose an entry in the »DEFAULT RESOLUTION« submenu.
n Manually: Select the entry »OTHER RESOLUTION« and enter the desired resolution in the

dialog.
Use movie to define size:

You can also determine the size according to the size of the movie or an individual video clip in the
movie.

1. In the project window, select the video object you want to use to determine the size of the
program monitor.

2. Right click to open the context menu in the program monitor display area(6).
3. Select the entry »ADJUST PROGRAMMONITOR TO SELECTED VIDEO«.

MOVIE STUDIO will adjust the size of the program monitor to fit the resolution of the selected video
object.

Use movie settings to define size:

1. Right click to open the context menu in the program monitor display area(6).
2. Select the entry »ADJUST PROGRAMMONITOR TOMOVIE SETTINGS«.

MOVIE STUDIO sets the resolution in the movie settings as the new program monitor size.

Note: If the program monitor resolution is bigger than the screen being used, you will receive a
warning message from MOVIE STUDIO and will be given the option to cancel or continue the
operation.

Transport controls

Transport controls on the program monitor enable you to play back video and image material in the
project window or as a preview in the Media Pool.

Note: To use the jog/shuttle functions, they must be made visible in the menu.
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Range Above the playback functions you can select the range between the in and out
points using the mouse.

Playback markers This marker indicates the position of the image currently displayed by the
program monitor.

Set in/out points Defines the start and end of the playback range.

To range start This button sets the playback marker to the start of the current range for control
purposes.

Jump to movie
start

Sets the playback marker to the start of the movie.

Playback/stop
(pause)

The playback button in the middle starts playback. A second click stops playback.

Tip: In the menu »FILE > SETTINGS > PROGRAM > PLAYBACK«, you can
set whether the playback marker will go back to the start position (stop) after
the second click or following the appropriate shortcut (space bar), or if it
should stay at the current position (pause function).

Range playback This button plays the current range.

To range end This button sets the playback marker to the end of the current range.

Audio or video
recording

Quickly jumps to recording selection.

Jog wheel Using this wheel, you can move by single frames within the video and zoom in for
precise positioning of the playback marker.

Shuttle control The further the slider control is moved to the side, the quicker the arrangement is
played in the corresponding direction. This way a specific position can be
reached quickly.

Note: Jog wheel and shuttle control are hidden by default. Use the menu of
the program monitor to set them to display.
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Preview quality Activate smooth playback if playback becomes choppy.

Preview Quality

You can "activate" a smoother preview if playback performance begins to suffer. This setting does not
have any effect on the quality of video files when exporting or burning to DVD.

Poor playback performance can be caused by the following:

n Under-performing hardware
n High-resolution source material (4K)
n A very complex project

Right-click in the transport console on the symbol to open the context menu.

The following options are then available:

n Reduce resolution
n Reduce frame rate: Reduces the number of frames per second.
n Deactivate effects: All effects and plug-ins will be activated/deactivated.
n Using proxy objects (see Using proxy files, proxy editing (⇗201))

Note: "Reduce resolution" and "Reduce frame rate" are preset.

Media Pool
The Media Pool is used to import media files of all kinds – videos, photos, MP3 songs, audio CD tracks,
etc. It also lets you access effects and templates offered by the program as well as the MAGIX Store.

There are five tabs in the MOVIE STUDIOMedia Pool.

Import (⇗28) For importing your media files.

Effects (⇗31) All effects, from image optimization and special effects to chroma key mix effects,
are located here.
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Templates
(⇗31)

Templates in various categories (transitions, title templates etc.) for immediate use
are located here.

Audio (⇗32) All songs and audio effects that can be used for the audio track are located here.

Store (⇗32) Here you can buy additional songs, templates, and lots more.

View options

Next to the search box there are buttons to customize how the content is displayed.

Show or hide the category view.

Filter content and show your favorites only.

Change the display size of the content.

Expand and collapse categories

Only the categories are displayed.

All the content will be displayed simultaneously.

Switch between List and Icon view

Content is displayed as a list.

Content is displayed as icons.
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Save favorites

Choose your favorite effects, templates, audio, and Store content to find it more quickly in the future.

Click the heart symbol to mark a category or content as a favorite.

The favorites you've saved are displayed at the top of the list.

Import

The structure and operation of the Import function in the Media Pool is similar to Windows Explorer.
The only difference is that the Media Pool only displays files that can be used in the film. The Media
Pool is used to access and load multimedia files of all kinds: Photos and other image files, video files,
audio files, transitions, effects, and also complete projects.

Computer: All drives will be listed along with their drive letters and can be opened with a double click.

User folder: Displays the folder for the user currently signed in on the computer (their name is
displayed).

My media:

n Projects: Here you can switch to the folder where your projects and videos are usually stored.
You'll find the »SHOW PROJECT CONTENTS« function in the context menu of a project.
Using this function, you can display all objects of a project and copy them into the current
project, retaining the editing and effect state of the object. This means that you don't have to
edit the objects again to keep the status of the "old" project. But you can certainly continue
editing the transferred object. These changes will be then saved in the current project.

n My videos: Displays all files found in "My files\My videos" that can be used.
n My music: Displays the contents of the "My files\My music" folder.
n Slideshow music: This features the music that is included for dubbing audio.
n My pictures: Switches to the "My files\My pictures" folder. This folder is often used by digital

cameras and scanners by default to store transferred images.
n Takes: This special folder contains "takes" – small clippings of longer films that can be used

without long loading times. You can also create takes yourself by dragging and dropping an
object from your film into this folder.

n Recordings:MOVIE STUDIO stores all recordings here by default.
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Travel route: Click here if you would like to create a travel route. This opens the MAGIX Travel Maps
tool.

Cloud Import: The Cloud Import feature lets you import media files into MOVIE STUDIO from cloud
services such as Google Drive. Clicking on Cloud Import will open the MAGIX Update Notifier tool.

Downloads: Use this button to access the media files that you downloaded with MOVIE STUDIO. Also,
all data received via Send Anywhere is stored here.

Note: The Media Pool displays the data on your hard drive under "Import". If you delete data here,
you will not be able to find it again using Windows Explorer.

Tip: You can create a link to your personal media folder in order to access the media it contains with
just a single click. You can do this by right-clicking on one of the entries and selecting »CREATE
LINK« in the context menu. Select the media folder and click »OK« to confirm.

Note: All links are automatically deleted if the function »RESET STANDARD PROGRAM SETTINGS«
("Edit" menu > "Settings") is used.

If you hover the cursor over a media file, three icons for the options (Preview, Trim, Import) will appear.

n Preview : Click on the playback icon to play back the file. Video and image files are
displayed in the program monitor, and audio files through the sound card. You can also preview
the provided templates.

n Trim : Range import: You can define an import range on the source monitor using
buttons for the in and out-point and then import it.

n Import: Click on the Import icon to load the selected media to the project window
completely. When importing using the import button, the insert mode that is currently set will
be used.

You can also load files from the Media Pool by double-clicking them.

Selected entries (including entire folders) can be selected by holding down the left mouse button and
dragging and dropping them into the film.

n Select multiple files individually: Hold down the Ctrl key while clicking on the files you want to
use one by one.

n Load files in sequence: Hold the Shift key and click on the first entry and then on the last. All
entries in between are marked.

n Select multiple files using the mouse (object lasso): Click on an empty space and hold down
the mouse button and move the mouse over the multiple files. A visible frame is dragged by the
mouse. All entries bordering this frame will be selected.

n Select all files in the current folder: Press the keyboard shortcut Ctrl + A.

Navigation buttons

Forwards/Backwards: These buttons access the previously viewed folders.
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Folder tree: Here you can activate a folder tree to navigate through your computer system.

Search:

The search function allows you to find specific files quickly. You may specify your search according to
file type, date, or certain folders.

n File name: Enter any part of the name of the file you are looking for in the "File name" field.
Clicking on the X symbol will delete the entry again. A "?" may be used as a placeholder for a
single character, and "*" for any number of characters

n File type: Here you can enter a file name extension. Multiple entries are separated using a
semicolon. Below the entry field, various presets may be selected for often-used file name
extensions.

n Date: For restricting your search to a specific time period. Choose an entry from the list.
n Folder: If you want to search on certain drives or in a single folder rather than your entire

computer, you can define a certain search path.
n Search depth: Here you have various options that determine whether additional locations

should be searched.
"Indexed locations" are folders, which are searched and cataloged in Windows via the index list.
If the index list is activated, the files in the indicated folders will be indexed while the computer
is idling, so that the user's search query may be completed faster.
l Search indexed locations and the selected folder
l Search indexed locations, the selected folder and personal files
l Search indexed locations, the selected folder, personal files and the project file.

Browse history list and path details: In the top center you will see the path of the current folder. Use
the arrow button to open the menu to find the folders you previously visited.

Options: All functions of the context menu (switch views, rename, or delete files, etc.) can also be
accessed using the options button.

Up: This button brings you to the next highest folder level.

Zoom: A zoom slide can be used to set the number and size of visible icons in the "Large icon"
view.

Display options:

All supported multimedia files and subfolders of the currently selected folder are displayed in the file
list. You can define how detailed the entries should be listed here.

n List: Only file names are listed. This view mode displays the most files simultaneously.
n Details: In the details section the type, size and date of modification are shown for every media

file beside its name.

MOVIE STUDIO 2023 | MANUAL

Program interface overview "Edit" interface 30



n Large icons: These can be quite useful, since they show a preview frame for each video and
picture file in the file list. This allows you to sort through the material quicker. As soon as you
activate this view, the zoom function appears next to it. This allows you to further enlarge the
thumbnails.

Effects

MOVIE STUDIO offers numerous effects and effects settings options, as described in detail in the
section Effects.

n Title editing: You'll find the title editor for editing title objects here.
n Video effects: Customizable effects for video and photo objects are located here. The effects

can be set only after selecting an object in the respective effects dialog. For more details, see
Video effects.

n View/animation: These are movement effects you can use to animate the frame by using
zoom or camera movements.

n 360° video: This is where you'll find the 360° video editing effects. Learn more under 360°
videos.

n Stereo3D: This accesses the program's Stereo 3D functionality. See Stereo3D for more
information.

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

n Audio effects: You can find a wide range of audio effect presets for audio tracks here. For more
information, see Audio editing.

n Extra effects: Contains all available effect plug-ins. You can find out more under Additional
effects in the Media Pool.

Templates

Here you'll find additional content that can be used for your film. As well as the content installed
alongside MOVIE STUDIO you can purchase additional content in the Store from directly within the
program.

n Transitions: Opens the transitions section in the Media Pool. Click on a category to see all the
transitions in a list.
To load a transition, drag it with a held-down mouse key onto the selected object.
You can find additional information in the "Fades (transitions)" section of the "Objects"
chapter.

n Title templates: The title templates are sorted into various categories and can be loaded by
double-clicking or dragging and dropping them. The text and placement of the title template
can be positioned directly in the program monitor.
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n Film and editing templates: These templates enable you to create short movie trailers by
dragging sections out of your film material to pre-produced placeholders. More information
about this can be found in the chapter "Wizards and special functions".

n Film looks: You can modify the visual aesthetic of your material by using lookup tables. Find out
more about this in the "Movie looks and lookup tables" chapter.
You can import and apply collections of lookup tables (.cub) in MOVIE STUDIO by pressing the
"+" button.

n Design elements and image objects: The design elements enable images to be combined.
Each design element offers a preview: We recommend browsing through the selection and
viewing the content for each one.
l Collages animate or interlace the image from a photo or video (in some templates,

several objects are faded into one another). Depending on the collage, arrange the
selected objects one after the other and drag the collage onto the first object.

l Image border effects scale down the image and trim image border areas to display
pre-produced animations there.

Note: If you use border effects on video footage with audio, note that the edge effect
mutes the sound of that object.

l Picture-in-picture templates display several videos in a single image. To use this,
position the clips that are to be displayed simultaneously below one another on the
tracks and then apply a suitable picture-in-picture template.

Audio

Under "Audio", you'll find installed content and offers from the Store for background music and sounds.
The tab functions the same way as the "Templates" tab.

Store

Additional content for your projects can be purchased directly from the in-program Store.

In the upper left, you can filter by category; or you can also select an option to show new or free items
available in the Store only.
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Filter list to show special offers

Filter list to show new content

Buy new content

The price and size of the pack will be shown and you can preview the content by clicking the playback
button. You can purchase the specific content you need, rather than an entire pack, in the program's in-
app Store.

Click »PURCHASE« to open the Store window.

n When you make your first purchase, you will be asked to select a currency.
n Then, log in to your MAGIX account.
n In the next step, select the payment method and enter the required details.
n This step will be skipped for later purchases and you will go straight to the "Purchase" window.

You can also adjust the payment method afterwards by clicking on the pen icon next to "Pay
with".

n Click on "Buy now" to complete the purchase.
Your purchase will download immediately, as shown by the download progress on the tile. You can use
the content you have purchased in your projects right away.

Project Window
MOVIE STUDIO offers an editing interface for advanced editing: audio dubbing, professional editing,
plus precise transitions and effects editing.
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1 Toolbar (⇗34)

2 Film tab (⇗39)

3 Display modes (⇗40)

Toolbar

The toolbar contains the essential editing functions for objects in the project window. This is located
above the project window.

Commands

Undo

This command allows you to undo the last changes made. This way, you can try out
different methods for doing an important task. If you don't like the result, you can always
revert to the previous state using "Undo".
Right-clicking the button opens a list of changes made so far, allowing you to undo
several changes made in sequence.

Note: You can adjust the length of the list to your needs in program settings. A
general rule: The longer the list, the more RAM is used.

Restore

This function undoes the previous "Undo" function.
Right-clicking on the arrow next to the button opens a list of changes made so far,
allowing you to restore several undo actions made in sequence.
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Delete
objects

This command deletes the selected objects.

Title

editor

Opens the title editor for the selected title object.
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Paste
modes

MOVIE STUDIO offers various options for adding an object selected in the Media Pool to
the project.
There are multiple possibilities for using the modes, which are better described under .
Right-click on the icon to open the list.

Check the paste mode before inserting new files.
Automatic application
This inserts the currently selected object from the Media Pool, in the project window.
Video and image objects will always be placed behind the last object into the first track,
audio and text objects are separated into different tracks.
Single track ripple
This adds the selected object from the Media Pool, project temp folder, or selected area
of the to the position on the selected track where the playback marker is located while
moving the objects located behind it on the track.
n In contrast to automatic insertion, in a single-track ripple all objects are inserted

at the position of the playback marker. The objects on the target track are
automatically moved back on the track behind the inserted object. Bordering
tracks are unchanged.

n If another object is found at the playback marker position, then it will be cut and
continued at the end of the inserted object (so that the inserted object can start
exactly at the point of insertion).

Multitrack ripple
This adds the selected object from the Media Pool or the (or from the selected area in
the , respectively) to the selected track at the position of the playback marker. All objects
located on other tracks will be split at the playback marker position and media from that
point on will be moved down the length of the inserted object.
n Objects located further along on all tracks will also be moved further down.
n In contrast to automatic insertion, the object will be inserted at the position of

the playback marker.
Swap
This replaces the object selected in the project with the object selected in the Media
Pool, the , or from the selected area in the respectively. Should the new object have a
different length, all subsequent objects will be shifted accordingly.
Overwrite
This overwrites the project at the position of the playback marker on the selected track
with the currently selected object from the Media Pool or the or from the selected area in
the .

Note: Unlike in "Exchange" mode, this will not cause ripple and existing objects will be
overwritten.

Note on track selection for paste modes: Pasting to a destination track (by clicking
on the track header) is possible in single track ripple, multitrack ripple and
overwritemodes. If no track has been selected, the destination track will be selected
automatically.
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Cut

button

MOVIE STUDIO offers various editing functions. A right-click opens the list.

Note: If the commands "Split" and "Remove beginning/end" are applied without a
selection, all objects at the position of the playback marker are cut.

Split
This command cuts a selected object at the point where the play cursor is positioned.
Two independent objects are created.
Remove start
This command cuts a selected scene in two at the point where the playback marker is
positioned and removes the first part.
Remove end
This command cuts a selected scene in two at the point where the playback marker is
positioned and removes the second part.

Note: If the commands "Split" and "Remove beginning/end" are applied without a
selection, all objects at the position of the playback marker are cut.

Remove scene
This command allows you to completely remove selected objects. The parts that follow
will be automatically moved to the end of the object in front of the object to be removed.
Split movie
Splits movie at the playback marker position into two sections within one project. These
can be individually controlled using the "Window" menu or the button "Select movie for
editing" (see above).

Audio
playback

This buttonmutes the sound output. Clicking the triangle provides access to settings for
scrubbing and selection of the audio track for multiple audio tracks.

Mixer

This option can be used to open and close the mixer. Further information can be found in
the "Mixer" chapter.

Only available in Timeline mode

Set

chapter
markers

Places a chapter marker at the position of the playback marker. This creates a chapter
entry in the disc menu in case the movie is being burned to disc. You can rename the
chapter markers by right clicking and selecting "Rename" in the context menu. The new
name will also appear in the chapter menu.
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Set

snap
markers

1. To set a snap marker, select an object and place the playback marker at the
position where you want to place the snap marker.

2. Now click on the button "Set snap marker".
You can move a snap marker with the mouse using drag & drop.
Find more information about the topic of snap markers in the "Snap markers and
transients" chapter.

Object

grid

Use this button to switch the object grid on and off. When the object grid is switched
on, the objects snap into place beside one another so that everything fits in seamlessly.

Group

objects

All selected objects are assigned to a group which may then be selected and edited
jointly by clicking the mouse.

Ungroup
objects

This command splits an object group into separate objects.

Mouse
mode for
individual
objects

The mouse mode for single objects is the preset mouse mode that is used the most
often. Left clicking selects an object. Holding down the mouse button moves the
selected object. Right clicking opens the context menu.

Mouse
mode for
single track

This mouse mode behaves similar to the mouse mode "All tracks". When moving
objects, only those objects will be moved that are located on the same track after the
selected object.

Mouse
modes for
all tracks

This mouse mode behaves similar to "Object" mouse mode. However, when objects
are moved, all of the objects behind the selected object are also moved.
The complete background component of the project, i.e. all objects and gaps on all
tracks, will therefore be maintained during any movement.
This is useful for moving a complete project, e.g. to insert new opening credits or to
close gaps.
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Additional
mouse
modes

MOVIE STUDIO offers additional mouse modes for different kinds of editing. A right-
click opens the list.
Stretch:
This special mode enables the length of objects to be adjusted. The object is played
back completely and the playback speed is adjusted to the stretched object length.
Video objects are therefore accelerated or decelerated accordingly. Audio objects are
stretched or pinched via timestretching, but without creating any changes to the pitch
itself.

Note: If you want to animate the object with effects curves, then the option
"Connect curve length with object length" should also be set.

Curve:
This mouse mode is used especially for drawing effects curves.
Effects curves control the level of the effect: The higher the curve point is, the more
intense the respective effect parameter will be at this position. These may be used for
the video and image objects of the image tracks as well as for the audio objects of the
sound tracks.
More information about this can be found in the chapter "Animating objects".
Preview:
This mode allows you to preview audio objects (as long as the mouse button is held
down) In this mode, objects cannot be moved or changed.
Move object contents:
The content of a selected object can be moved in this mode.
Objects are references to media files. As long as an object is only a clip and not the
entire footage of a file, the selected clip can be adjusted afterwards without changing
the object or its position in the track. This is helpful for advanced arrangements, for
example, when using a set framework of objects.
Split and trim:
Enable this mode to cut and trim objects at the cursor position.
Here's how:
If the mode is active, position the mouse over the object that should be edited. The
current frame, over which the mouse pointer is located in the object, is shown in the
program monitor to aid in editing.
Left click the mouse to cut the object at the mouse pointer's position.
If you also would like to trim the object, simply hold the mouse button. Move the
mouse to the left or right to trim the object on the left or right.

Film tab

The project window contains a tab for each movie you edit in a project. The tab can be used for creating
films and also for managing your projects, i.e. here you can sort the order of the movies, add new
movies, remove existing movies from the project or rename the movies.

Each film in a current project can be controlled through its own tab above the tracks.
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Click the button next to a movie tab to open a menu for managing the project. Alternatively, you
can right-click on a movie tab.

This menu offers the following options:

n Sort films
n New movie
n Rename movie
n Remove movie from project
n Merge movies
n Import movie
n Export movie
n Import VEGAS Movie Studio project

Basic movie settings can be found in the main menu under »FILE > SETTINGS > MOVIE«.

Movie settings (⇗74)

Display modes

There are various views in the project window that you can switch between using the buttons on the
right side.

Storyboard mode is the preset view. This view offers an easy, streamlined interface to
simplify the editing process. All scenes from your film are listed sequentially in the
"Storyboard" mode. Every scene is displayed with a preview picture in the storyboard.

The scene overview provides a scaleable overview of the scenes. You can use this to
comfortably view, sort, and delete unnecessary scenes.

In Timeline mode, your movies are displayed as "objects" on the "timeline". This means the
longer the object, the longer the corresponding film.
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Multicam mode enables easy cutting of various recordings of the same scene from different
camera perspectives.

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Use this button to maximize the project window to fullscreen.

Storyboard Mode

Pictures and video footage (including the audio track) are displayed as scenes in the Storyboard. Scenes
are displayed the same way regardless of their actual length in the movie, and you can drag and drop
scene to rearrange them. With this kind of display, the playback marker moves in the movie at different
speeds during playback. Correspondingly, it moves slower in longer scenes. A loaded file is made up of a
single long "scene", which can be split into several smaller scenes. You can do so manually using the
Cut button in the toolbar or via Automatic scene detection (Shortcut Shift + Z).

Further information:

Split and trim (⇗189)
Automatic scene detection (⇗198)

1 Video/Photo track
All photos and videos are displayed with thumbnails in order in this track. By looking at the
pictogram next to playback duration and the differently colored bar, you can tell at a glance
whether an object is a video or photo and which photos are in portrait or landscape format.

2 Audio track
This displays the fourth track (audio track by default) of your project.

In certain cases, other objects, such as titles or overlay effects may display instead of the
audio. This may occur when you either have older projects open where the sound effects
are on a different track, or you have manually placed the sound effects on a different
track in timeline mode.

Each scene offers the following editing options:
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Select object Tick to select an object to work with.

Add
captions and
texts

Titles and text can be added to any film. Click on the »T« button, enter your text
directly in the program monitor and select from different animations (try movement
from bottom to top for a classic end credits effect).

Set
volume

The volume in the soundtrack of each scene can be set with the loudspeaker button.

Rotate
image (only
for image
files)

If an image or photo is on its side or upside down, click on this button. The photo will
rotate 90 degrees.

Addiitonal
settings
options

You gives you access to a menu with various editing functions.

Transitions

Click on the large button between the scenes and select a scene transition.

Display time Next to the pictogram, the display duration for the scene is shown in [minutes]:
[seconds].

With image files, you can click the time display and adjust the display duration in the
dialog that appears. This duration can be applied to all photos in the movie.

Scene overview

The Scene overview allows you to manage and categorize scenes. All scenes are listed one after the
other (in multiple lines, like in a text program) and can be copied, cut, moved, deleted and inserted.

"Overview" mode does not indicate start, playback, or end markers. The scene that is currently playing
can be identified by a colored progress bar.
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The zoom slider enables the view to be enlarged or reduced.
This controller also specifies how many scenes are displayed.

Timeline Mode

All advanced editing should be done using Timelinemode. Your movies and scenes are shown here:
The longer the object in the track, the longer the corresponding movie.

Playback range:

Timeline with range marker

Clicking in the range bar above the first track lets you define start markers, i.e. the starting point of the
playback range. If you right-click, the end marker will appear to indicate the end point of the playback
range. The length of the playback area is shown in the center of the section display.

n When the end marker has been reached, the playback cursor jumps back to the start marker
and begins playing everything again as a loop.

n The entire playback range can be moved using the mouse by clicking on the bar in the middle
while holding down the Ctrl key and dragging it. The in and out-points can be moved with the
mouse. Left-clicking positions the in-point, and the right mouse button sets the out-point.
The project window playback range above the first track is linked to the playback range of the
program monitor. They cannot be changed independent of each other.

n To move the start and end markers to the beginning or the end of the film again, click
»OPTIMIZE MOVIE VIEW« in the »WINDOW«menu.

Handles:

All objects can be shortened by moving the mouse to one of the lower corners of the object until the
mouse pointer turns into a double arrow. You can now shorten the object as much as you like. At the
top corners of every object you will find two fade handles that can be adjusted to fade an object in or
out. The handle at the top center can be used to adjust the volume of audio objects and the
transparency of video objects. The image and audio tracks of videos will be cut together in the same
object. The handles in the center can be used to adjust the transparency of the video object (up) and the
volume of the audio track (down). Image and audio can also be displayed independently of each other
on different tracks. You can read more about this under "Objects".
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Object selection:

For advanced effects editing, the objects must be selected first. Individual objects can be selected with
the mouse. Objects will change color to show that they have been selected. Multiple objects can be
selected by holding down the Shift key. If you click next to an object, you can drag out a rectangle with
the mouse button pressed down. All objects contained in this rectangle will be selected.

Tracks

The project window is divided into tracks where the multimedia material can be positioned and edited.
The number of tracks that are displayed can be specified in the file menu under "Movie settings".

In principle, any object type can be placed on any of the tracks. Video and image objects can also be
combined with audio objects within a track. The maximum length of a movie is restricted to 6 hours.

1 Solo: This switches the track to "solo" mode. During playback, only this track will be seen or
heard.

2 Mute:Mutes all audio objects on the track. Video, image and title objects are still played back.

3 Lock icon: Clicking on this icon locks the entire track and all of its objects against editing.

4 Maximize/minimize track:Makes the track larger/smaller. This creates more space on the
screen, making it easier to edit details.

5 Track number: All tracks have a number to help differentiate them in the project.

6 Track name: This is the track name. To change the name, enlarge the track first. Double-click in
the name field and enter a name. Press Enter to confirm the name.
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7 Track options
n Add: Adds a new track above the current track. Clicking on the plus symbol also

performs this action.
n Delete/Cut/Copy/Paste: These commands let you delete, copy or cut an object into

the clipboard, or paste a track including all of the objects within it. The track is inserted
from the clipboard above the selected track when pasting.

n Multicam > Source track: Here you can activate/deactivate a track as a source track.
n Multicam > Master audio track: Here you can designate the master audio track for

multicam editing.
n Track height: Set whether the selected track or all tracks should be displayed as small,

large or in standard size. You can also adjust the size using your mouse. To do so, use
the mouse to drag the lower border of a track box downward.

n Track color: Here, you can assign the track a color to highlight specific tracks.

8 Add/delete tracks: Click the plus icon to add a new track above the current track. Click on x to
delete the corresponding track.

Note: You can define a destination track for importing the objects. Click on the track header to select
a track. All objects you import will now be inserted into the selected track. Clicking again on the
selected destination track disables this function.

Grid

The project window features a frame-exact grid. This ensures that video and image objects snap exactly
to the borders of a frame.

The step size depends on the frame rate specified in the movie settings (»FILE > SETTINGS >
MOVIE«). Choose between Europe's conventional frame rate for PAL (25 frames per second) and
America's and Japan's conventional frame rate NTSC (29.97 frames per second) or any other manually
set frame rate.

When moving an object, the position display indicates at which frame the first image of the object is
shown.
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The position is displayed in the form of a tooltip when moving the object. This information is displayed in the
form "Hours:Minutes:Seconds:Frame".

In addition to the constantly active frame grid, an object grid can also be activated. This ensures that
two consecutive objects will seamlessly snap together even if they are on different tracks. This avoids
undesired gaps or overlaps.

The object grid can be activated/deactivated using the magnet icon in the lower toolbar.

Zooming

The vertical zoom function sets the number of visible tracks. On many tracks zooming is useful for
selectively editing a track or an object in full view.

Use the horizontal zoom functions to set up the visible section of the project on the timeline. Clicking
and dragging on the bottom border of a track header allows you to adjust the height of the display.

Object zoom: Vertical and horizontal zoom stages are enlarged so that all of the selected objects
are displayed at maximum size.

Optimize view: Displays the full project. Zoom will be set to 100%.

When the function is turned off, the zoom level reverts to its previous value.

Locking and preview rendering

You can use the lock button to prevent markers from being moved accidentally.
You can reach the preview rendering features by pressing the lightning bolt button next to the
timeline.

Preview rendering (⇗199)

Multicam mode

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

The Multicam mode is an expanded timeline mode, where you can edit together scenes shot with
different camera perspectives, a process called Multicam editing. The top two tracks serve as target
tracks for copying sound and video from two different source tracks.

Multicam Editing (⇗201)
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The "Burn" interface

Click here to switch to the "Burn" interface.

The Burn area enables you to create a selection menu to burn the entire project including all movies and
the selection menu to disc later on.

All movies loaded into the project will be included. If you want to remove some of the films you've
loaded, switch to the "Edit" screen again and delete the unwanted movies from the project there. To do
this, switch to the movie, open the "File" menu and select »MANAGE PROJECT > REMOVE MOVIE
FROM PROJECT«.

Note

When you try to burn your first Blu-ray Disc a notice will appear to inform you that a free audio
expansion package must first be downloaded and installed. Click on »OK« to proceed and wait until
the audio encoder for Blu-ray Discs is installed.

If the current project contains data in the BDMV/MVC (Stereo 3D) format, the burn process cannot
proceed. Due to licensing stipulations of the Blu-ray Disc Association, files in BDMV/MVC (Stereo
3D) format cannot be burned to blank optical media.

Overview

1 Menu preview: Here you can see a selection menu preview.

2 Change view:Here you can swap between the preview and edit view.

3 Remote control: Check how your disc will react later when you press a button on your player's
remote control.

4 Output:Before burning the project, select the desired format. The Burning wizard (⇗54) will
open.
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5 Play preview: Play the preview menu and test how it works with the remote control.

6 Template category: Select the desired section from various categories with different menus.

7 Menu templates: Switch between different templates for designing your menus.

8 Apply templates: Choose whether you want to use a template for the page, the menu or all
menus on the disc.

Preview
MOVIE STUDIO provides two different modes for designing and previewing the disc menu.

Previewmode simulates the behavior of a playback device, e.g. DVD player or Blu-ray player. You can
select a template for the menu and burn the disc.

In Editingmode, you may adjust many features of the disc menu. You can choose from a range of
templates and customize them to suit your needs.

Remote control

The virtual remote control is an important helper when it comes to checking how the disc will perform
later. When the disc featuring the project is inserted into the player, this remote control will control the
preview picture just like a "real" remote control controls the picture on a monitor or TV. The menu
navigation may be activated via the arrow keys or the "OK" button. Activated buttons are highlighted.

The number keys select the corresponding entry on the menu page. All menu entries are marked with a
corresponding number. Within a chapter menu, playback is started from the particular chapter. In the
movie menu, the corresponding chapter menu (if available) is changed or movie playback is started.

Navigation buttons: These buttons can be used to navigate through the menu of the disc to be burned.
The entries can be changed and confirmed by clicking "OK". The remote control works just like the
remote control for your home DVD/Blu-ray player.

Skip/move forward/back: This allows you to skip to the next or previous scene while playing back
your movie. In the menu, you can skip forward or back from one menu page to another.

Play: Starts the first entry in the menu. In case chapter menus are available, the chapter menu will be
displayed first. Pressing the play button again starts playback with the first scene of the movie.

Stop: Pressing stop halts playback.

Disc: Switches to the first page of the film menu.

Sub: Switches to the chapter menu (if available) for the currently selected film.

Menu

The menu is also burned to disc and appears when inserted into the player. Just like with a store-bought
DVD or Blu-ray Disc, you may easily select your movies with the help of preview pictures, or access
particular chapters within a movie.
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Templates

You will find the menu templates below.

To the left you will see a tree structure for selecting various menu templates. At the top, you should first
select whether you would like to use templates in ratio "16"9" or "4:3".

n Animated (DVD): These templates contain background and introductory videos as well as
music. The control elements are displayed in various modes. The templates can be used only
for mini DVDs, DVDs and AVCHD discs.

n Static (4:3 only, DVD): Here you will find templates made up of regular background pictures
and control elements.

n Custom: These templates adjust to your disc project; the movies and scenes you use are
integrated directly into the menu.

n HD static (16:9 only, DVD, Blu-ray, AVCHD, WMV HD): These templates contain super-
sharp, high-res background images that are particularly noticeable on HD TV devices.

n Movie templates (only 16:9): Here you will find menu templates that are specially made for
movie templates found in the Media Pool.

Note: These menus require "Film menu" and "Chapter menu" to be activated in the "Edit" screen
under "Disc options".

If you've selected one of the menu templates, you can use the horizontal scroll bar to view all the others
available. There are lots of options when using the templates:

n To apply a template to all menu pages, double-click the template. The complete template will
then be applied.

n You can also combine various elements from different templates with each other. To do so, you
must first switch into Editing mode. If, for example, you wish to combine the text format of a
template with the background of another one, double-click on the template containing the
background first. Then click on the "Font" tab and select a template for the font.

n You can load the layout (or individual layout elements) for the current menu (movie or scenes)
as well as for all menus.

Editor screen
To edit individual menu elements and the menu structure, activate the "Edit" button.
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Hold down the left mouse button and drag text boxes or graphical elements to the desired position. You
can adjust the size by dragging out the corners and edges of the frame.

Undo: This command allows you to undo the last changes made.

Redo: This function undoes the previous "Undo" function.

Set aspect ratio: To avoid distortion, use this button to set the aspect ratio for the menu
elements.

Group:Menu elements are moved or resized simultaneously as a group, including the
description text and number.

Fade in TV display area in the program monitor: This option displays the image borders
of the television as lines in the program monitor.

Grid: This button activates a grid to help position frames exactly next to each other as
required. Using the small arrow next to the button you can open a dialog to fine tune the
grid settings.

Navigation

Using the navigation links above you can reach the menu structure.

n All movies are listed as first entries. The corresponding menu level is the film menu.
n All scenes are listed as second entries next to it to the right The corresponding menu level is

the chapter menu.
Removing the red check deactivates the corresponding entry in the chapter menu. The scenes are still
displayed of course, but you can no longer select them directly from the menu.

n You can open the movie menu for further editing by clicking on the movie above it.
n If you click on one of the chapters, the chapter menu in the preview will be opened for editing.

Disc options

Here you can activate or deactivate certain elements or even complete menus.
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Note: To create varied templates, not all templates include all elements that can be deactivated

Intro video: Press this button to load videos to be used as introductions to your discs. The following
formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is played immediately after the DVD
has been inserted into the player. The DVD menu will then appear. A check mark "Do not skip" ensures
that the intro video must be played completely each time the disc is inserted and that it may not be
skipped with the remote control or otherwise.

The disc menu essentially consists of two layers:

Film menu: The upper layer includes the film menu, which is only used if a project contains multiple
movies.

Chapter menu: This is the lower layer of the disc menu, which utilizes the chapter markers in a movie as
menu entries. More information about this is available in Chapter markers.

Note: A chapter menu cannot contain more than 99 entries. If your movie should have more chapters,
either burn it without a chapter menu or split your movie into multiple parts.

Audio menu: If your project features multiple DVD audio tracks, then a menu will be added to the disc
for the user to select an audio track. This allows you, for example, to burn audio tracks in both English
and German onto the disc and later select one of the tracks for playback.

Note: Audio tracks can be defined in the editing interface. Open the context menu of a track header of
the audio track and select "DVD audio track". Choose a unique name for the audio track. Repeat this
process with every other audio track that you would like to have as a DVD audio track.

Preview pictures: Shows/hides the preview pictures in the disc menu.

Numbering: The numbers beside the menu entries can be selected directly using the remote control.
Use this option to fade them in and out.

Frame: A frame borders the preview pictures. If you don't want a frame, it can be easily removed using
this option.

You can edit the existing menu background or create a new one from scratch.

A click on this button switches to the "Edit" interface and loads the selected menu
background as video.

Here you can change and design the background as you please. The background movie will be set as the
menu background automatically after pressing "Save".

Tip: If you would like to design a new menu background, simply delete all existing objects from the
menu project and load new ones.

Designing a page

Edit: You have three options to edit the background of a menu page. You can either
set a certain "color value" for the background or select an image file from your hard drive. You may also
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select a certain frame from a video in your project.

In external editor: A PSD file is sent directly to the program that has been selected in
the program settings as the menu editor.

New menu pages may also be added or unnecessary pages may be removed.

Adds a new menu page.

Removes the selected menu page.

Animated selection menus

You can also add audiovisual animations to the disc menus. As required, background videos are played
as endless loops while the menu is shown on the screen. You can also set up background music in
various formats or any background picture for each menu.

Sound/music: Load an audio file and use it as an animation in the menu background.

Video: Load a video or graphics file and use it as an animation in the menu background. In addition to
the options for the background graphic (see above), you can also use a sequence from a loaded
slideshow or from a different video file.

Background video options:

n Create animated menu buttons: The preview images for individual movies in the movie menu
are shown as small movie samples. Set the start point and length of the animation using the
sequence options faders.

n Use the audio track of the video: The audio track of the background video is used with the
menu.

n Play menu animation as a loop: The background video (audio and/or video) is played back as
a loop.

n Length of the menu view is set by: Audio/video or whichever medium is longer. You can
specify how long the background video should be here. The other medium will be played as a
loop.

Designing buttons

MOVIE STUDIO enables easy editing of all buttons together with their menu entries.

Pressing this button or double-clicking the menu entries allows menu entries you
have created to be edited. The dialog with the properties of the menu entries will open.

Edit in MAGIX  Foto Designer: These buttons open MAGIX Foto Designer for further
editing of your background pictures or the selected menu elements.

Apply to all objects: Applies the properties of the selected button to all remaining buttons.

New menu entries may also be added or undesired entries may be removed.

Adds a new menu entry.
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Removes the selected menu entry.

Tip: If you would simply like to deactivate unused menu entries, this may be done via the navigation.

Jump to linked page: To test the targets of menu entries, select the desired menu entry and
click the button.

Menu entry properties

Double-clicking the preview picture or a menu entry opens an editor for you to adjust the preview
picture or menu entry.

Menu text

In the text input field, you can enter any text to match the chosen menu entry.

Set the vertical direction of the text (upwards, centered or downward).

Set the horizontal direction of the text (left, centered or right).

Font size: Set the height of the text in points.

Font color: Define the foreground color of the text.

Font: Here you can set which font and which style (bold, italic, etc.) should be used.

Border: Here you can set a colored border for your text. You can choose the color from the color field.
The size of the border is set in pixels.

Shadow: Here you can set the color and size of the shadow that will appear underneath the text.

3D effect: If you would like to make your text appear three-dimensional, you can set the width, height
and color of the 3D effect.

Apply to all: Except for the text, all settings are applied to all entries in the current menu.

Menu image

Use frame from movie: Use the fader to set which frame should be used in the video as a preview
picture. The numerical input fields are sorted as follows: Hours:Minutes:Seconds:Frames.
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Use different graphic: Here you can also load your own bitmaps to be used as menu pictures.

Hint: It may be the case that there are no menu pictures in some menu templates. That means
changing the menu picture won't have any noticeable effect.

Action at the end of the film

Here, you can enter which action should be carried out once the film has finished playing. The following
options are available:

n Stop playback: This option depends on the DVD player being used. Most DVD players show
the DVD player's own menu (or background picture) after playback.

n Jump to movie menu/chapter menu: Jumps back to the previously shown menu.

Tip: If one of these two options is not available, please check which menu mode is set.

n Jump to next movie: The next movie will be played without any additional action.
n Play movie as endless loop: Any movie may be burned onto a disc as a loop. This means that

the movie will be played as a endless loop until the next menu entry is accessed using the
remote control or playback is stopped. This way, you can transform your TV into an aquarium, a
train journey, a fireplace, or anything you want, ready to watch over and over again.

Note: This option only functions for DVDs, Mini DVDs, or Blu-ray Discs.

Edit your own menu entries

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

There is another view in this dialog to edit menu entries you have created. Menu links can be edited
here. This makes it possible to link a menu entry with a certain action, menu page, or a certain position
in the movie.

No link: The menu item cannot be selected and has no other function than showing the menu text.

Link to page in current menu: Jumps to a menu page in the current movie or chapter menu in the current
film.

Link to another menu: Opens another movie or chapter menu.

Link to chapter in a movie: If this option is selected, enter the movie and chapter marker where
playback should start.

Note: For DVDs, only chapters within the current movie may be jumped to.

Link to movie start: The selected movie is played from the beginning.

Burning wizard
Click "Burn" to open the dialog for creating DVDs, Blu-ray Discs, AVCHD and other video media
including a menu.
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Select what kind of disc you would like to create.

Note: If you intend to watch your movie project on an HD TV, but only a DVD player is connected,
you will need to burn a DVD.

Burn dialog for DVD player

Here you can select your burner, the type of disc, the encoder settings. MPEG-2 is used for DVDs. Blu-
ray Discs also use MPEG-2, and higher bit rates are employed in order to reach the higher HD
resolutions. AVCHD discs use a much more complex MPEG-4/H.264 codec, which is documented in
detail in the "MPEG-4 encoder settings section of the PDF manual and in Help (F1 key).

Proceed as follows to burn a disc:

n Set up burner and burn speed: If you have multiple burners installed, you can select which
device you wish to use in this menu.

n Encoder settings: Use the "Encoder settings" button to access the selection dialog to specify
settings for the MPEG encoder (memory requirements, quality, and duration of the MPEG
conversion). "Advanced settings" accesses a dialog featuring additional options. Here you can
adjust all the fine settings of the MPEG encoder.

n Burning disc/starting video encoding: The button "Burn disc" starts the disc burning process.
Every time you burn and every time a simulation is carried out, the disc project is encoded.
Please note that the MPEG file is not deleted from the hard disk after the burn process has
finished. Depending on the length of the project, encoding and burning may take some time.
The time remaining can be seen in the dialog.

The simplest way to create an ISO image is to select "Image Recorder" under "Burner". When starting
the "Burning process", you have to specify a name for the image file you wish to create.

Options

Simulate first: If you are not sure about the write speed or memory requirements of the selected disc,
you can simulate the write process before burning.
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Activate buffer underrun protection:Many disc drives support technology that prevents the dreaded
"buffer underrun". Use this option to activate this protective feature and burn your files at higher speeds
without risking making a coaster out of your blank disc.

Completely format DVD/CD-RW media: This option reformats the RWmedia and deletes all existing
file material.

Shutdown computer after burning: Activate this option to automatically turn off the computer after
encoding and burning has been completed. You could, for instance, start the encoding and burning
process in the evening, and then you don't have to wait for the process to finish to switch off your
computer.

Burn standard video DVD onto same disc: You can use this option with a WMV HD disc to burn an
additional normal DVD video. This ensures that your discs can also be played back on standalone DVD
players. See Multi disc.

Activate the burner's defect management option: If a certain section of the disc is defective, this will
be recognized by the burner and labeled. No content will be saved there as a result.

Check data after burning disc: The finished disc will be checked for any mistakes after burning.

CD/DVD title: This is the title of the DVD which is displayed as the disc name on the PC. The disc
project name is displayed here by default.

Memory

Disc type Storage medium Menu Quality Length (optimal quality)

DVD DVD Yes *** 98 minutes

Blu-ray Disc Blu-ray Disc Yes ***** 110 minutes

AVCHD DVD/Blu-ray Disc Yes ***** 30 min./DVD
160 min./Blu-ray Disc

Note: The display time for some DVD players can be determined in this menu. The amount of image
material that can be put onto a CD or DVD depends on the sizes of the files.

It is hard to make necessary space for reliable data, especially with the MPEG 2 encoder. If the “variable
bit rate” of the MPEG-2 encoder is activated, encoding will occur according to the movements in the
picture. The required memory depends on the film material; an action film would need more memory
than a drama, for instance.

The MOVIE STUDIO burn dialog contains a capacity indicator, which estimates directly how much
space remains on the selected disc type with current settings. As soon as you change Encoder settings,
the capacity display will be updated.

MOVIE STUDIO 2023 | MANUAL

Program interface overview The "Burn" interface 56



Tip: The capacity display is only an estimate. For this reason, always make sure that you never
completely fill the disc space. Instead, leave a buffer in case the files end up being larger than
estimated.

If you can't save your disc project on a single blank CD, you will have to divide it up into various parts.

Separate project onto multiple discs

Automatic: If the disc project requires more memory than is available on the disc, a dialog will appear
before burning asking whether the disc project should be automatically segmented for multiple discs.
Confirm this by clicking “Yes”. The disc project will then be automatically divided into individual disc
projects and burned sequentially onto multiple discs. This is the easiest method as everything is
automatic and all you have to do is insert a new blank CD when required.

Manual:

Case 1: If several movies do not fit on a single disc:

In this case, switch back to the “Edit” interface and delete as many movies as necessary until the
remaining movies fit onto the disc. You can create a new disc project and load and burn the other
movies afterwards.

Case 2: If a long movie doesn’t fit on a disc:

In this case, the movie has to be split into two or more parts that will be burned separately to disc.

n Switch back to the "Edit" view and place the playback marker to the position where you want to
divide the movie. In the "Edit" menu, select "Cut > Separate movie".

n All passages behind the playback marker will be removed from the overly long movie and made
into a separate movie. Both movies can be controlled in the movie tab in the project window.
Save both of them separately to your hard disk (“File > Manage project > Export movie file”
menu option, for example, as “Part 1” and “Part 2”).

n Remove one of the two movies (for example, "Part 2") from the disc project ("File" > "Manage
project" > "Remove movie from project" menu option).

n Switch to the "Burn" interface and burn the first film ("Part 1") to CD or DVD.
n Create a new disc project (“New” button), switch to the “Edit” view and load it into the second

film (“Part 2”).
n Switch to the "Burn" interface and burn the second movie to ("Part 2") CD or DVD.

Encoder settings

Use the “Encoder settings...” button to access the selection dialog to specify the properties of the MPEG
encoder (memory requirements, quality, and duration of the MPEG conversion).

Preset: This features useful presets for the selected disc type. Here are several sample DVD presets:
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Long play DVD
video

DVD with extra-long playing time. The bit rate is reduced, which compromises
image quality.

Long play
music DVD

DVD with extra-long playing time for music. The bit rate for the soundtrack
remains at the highest quality level.

Standard DVD Normal DVD

Widescreen
DVD

Normal DVD in 16:9 widescreen format

Note: For all settings, you can choose NTSC (USA and Japan) or PAL (Europe).

Bit rate: The bit rate determines the memory requirement of the completed video. The greater the bit
rate, the larger the file, and the shorter the maximum playing time of the movie that fits on a disc.

Adjust bit rate: The expected file size of the finished video is estimated, depending on the set bit rate. If
the movie does not fit onto the disc, the bit rate is corrected accordingly.

Quality: Specifies the quality of the encoding process. The higher the quality, the better the finished
video will look; however, encoding will take considerably longer.

Smart rendering: Smart rendering considerably reduces encoding processing strain for MPEG files.
During the production of MPEG files, only those parts of the movie that were changed in the program
are re-encoded. Please note: The MPEG files contained in the movie must have the same format, i.e. the
bit rates (variable or constant), audio formats, image resolutions and video formats must match.

Anti-interlace filter: This option should only be activated for playback on a TV screen, since it is
intended to reduce line flickering.

Calculate effects on your GPU: To accelerate the export, video effects can be calculated on the
graphics card. Effects for brightness, gamma, contrast, color, saturation, image size, cropping and
position effects as well as various fades and mixes can currently be calculated. Please note that if using
external effect plug-ins and elaborate artistic effects, these must be processed on the CPU and for this
reason, using the function will not yield any advantage in terms of speed.

Note: This function is specifically optimized for NVIDIA graphics cards. You can, however, experience
acceleration with other types of graphics cards, too.

3D mode: In case your project features 3D material that has been edited with Stereo 3D, a mode may
be selected here for burning the material to disc. 3D is switched off by default.

To return to the standard settings, press the Reset button.

The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine settings
of the MPEG encoder. Read more about the "MPEG-1/2 encoder settings" and "MPEG-4 encoder
settings".

Create label and CD cover

MOVIE STUDIO contains an easy-to-use printing tool.
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Here, you can design and print track listings, CD covers, CD booklets, and circular CD labels. For
additional information, open the internal program help via F1.
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QUICK START
This chapter explains the basic functions of MOVIE STUDIO with a step-by-step introduction. A
systematic description of all program functions can be found in the following chapters.

Tip: Use the online tutorial videos that can be accessed in the "Help" menu. This feature requires an
Internet connection.

The program keyboard shortcuts for commonly used processes and functions are also very helpful.

Projects, Movies and Objects

In MOVIE STUDIO you will be working with projects,movies and objects. To work quickly and
intuitively, it's important to know the differences between these three terms, which are hierarchically
ordered.

1 A project includes everything that you want to include on a disc.
Normally this means one or more movies and a menu structure for
selecting movies for playback. Projects can be saved as project files
on your hard drive and can be loaded later for further movie editing.
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2 Amovie can be one single video clip or a combination of clips and
photos. It can also include music, titles, transitions, and much more.
Each movie can be exported individually as a video. A "project" can
be considered a type of drawer into which you can put multiple
movies that will be edited together and burned to the same disc.

3 Objects are the individual units of the movie. There are different
types of objects: Videos, photos, titles, transitions, decorative
elements, audio (sound).

Program start

Once you have installed MOVIE STUDIO, start the program from theWindows start menu. The
following start dialog opens:

Note: These settings have no effect on the internal processing quality and can be changed at any time
by going to "File > Settings > Movie".

New Project Wizard

Project name: Choose a name for the new project.

Project folder: Select a location for saving the project.

Film settings: Standard film settings are included here in a range of categories. Recommended presets
appear for whatever category you choose. However, you can set whatever frame rate you want
regardless of the presets. The film settings now also include presets for social media. This makes
importing and editing square or portrait videos easy.

Open movie settings: Check the box here if you want to view the movie settings and adjust them.
When you click on "Create project", the "Project/movie settings" opens.

Copy media to project folder: Activate this option to save a copy of all files imported to the project in
the project folder so that they can be opened here in future for editing.
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This option is meant to keep things centralized when files from various media devices (e.g. hard drives,
USB flash drives, SD cards) are being used in the same project. The internal hard drive is the best option
for working on projects in MAGIX Video Pro X because it allows faster access to files compared to
external storage devices. If files stored on external devices are used, this can lead to slow performance
and lag while editing. Storing on the internal drive also ensures that you can access all project files for
editing.

Load project

Here you can select and load a previously saved project.

Importing videos
In the following we assume that you want to import an AVCHD recording into the program.

Tip: Pay close attention to which folders you use to save your files and footage so you can find them
again easily to import and edit them in MOVIE STUDIO. Do not save files under C:\Windows\ or in
any of the program folders! Give your files and folders short, concise names.

Add AVCHD material

1. Connect your AVCHD storage devices (camera, USB stick, SD card and others) to your PC. You
may first have to turn your camera on.

2. Click on the red button underneath the program monitor.
The recording selection dialog will open:

3. Select »AVCHD« from the recording dialog. The AVCHD import wizard will open.
4. Select your connected storage devices as »VIDEO SOURCE«. A file list will appear.
5. In the file list, select all the recordings that you have imported from the device.
6. You can preview all your recordings using the program monitor in the middle of the dialog in

order to decide if they are suitable for your movie.
7. After selecting all videos, select in »IMPORT OPTIONS« whether the recordings should be

directly placed into your movie project or simply copied to your computer's hard drive (select the
location under »SAVE IN FOLDER«). You can also automatically delete your recordings after
import.

If you don't have such a recording at hand now, do the following:
You can load material form the hard disk in order to try out the MOVIE STUDIO workflow. We
recommend using the included demo project for this:
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1. In the Media Pool, click the button »MY MEDIA > PROJECTS«.
2. Next, open the »_DEMO« folder by double-clicking and then load one of the MVP movie files

listed there (e.g. »_DEMO.MVP«).

Important! If you import media to a project, MOVIE STUDIO must always have access to these files.
This means that you cannot rename these files, e.g. in Windows Explorer or Media Pool, if they have
already been imported because MOVIE STUDIO won't be able to find them. Renaming or relocating
files can lead to error messages and you will have to specify the files and folders again. For larger
projects this can become very time-consuming.

Play movie

To play the recording (or the demo project), click on the play button on the »TRANSPORT
CONTROL« below the program monitor.

During playback a vertical line will move across the project window. This is the playback marker that
displays the current position. It can be set directly with a mouse click in order to jump to certain
positions.

Tip: An even easier way to control playback is by pressing the space bar on your keyboard.

The Media Pool, a short overview

The Media Pool can be used to access and load media files of all kinds: Videos, photos, MP3 files, audio
CD tracks, templates, effects and Internet media, etc.

Browse the drive folder to find media you would like to use. The navigation buttons for the various
drives and folders are located in »IMPORT« above the main display area.

Note: The Media Pool displays the data on your hard drive under "Import". If you delete data here,
you will not be able to find it again using Windows Explorer.

Tip: You can create a link to your personal media folder in order to access the media it contains with
just a single click. You can do this by right-clicking on one of the entries and selecting »CREATE
LINK« in the context menu. Select the media folder and click »OK« to confirm.
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Note: All links are automatically deleted if the function »RESET STANDARD PROGRAM SETTINGS«
("Edit" menu > "Settings") is used.

If you hover the cursor over a media file, three icons for the options (Preview, Trim, Import) will appear.

n Preview : Click on the playback icon to play back the file. Video and image files are
displayed in the program monitor, and audio files through the sound card. You can also preview
the provided templates.

n Trim : Range import: You can define an import range on the source monitor using
buttons for the in and out-point and then import it.

n Import: Click on the Import icon to load the selected media to the project window
completely. When importing using the import button, the insert mode that is currently set will
be used.

More information

Media Pool (⇗26)

Video editing

Video editing in Timeline mode

All advanced editing should be done using Timelinemode. Your movies and scenes are shown here:
The longer the object in the track, the longer the corresponding movie.

Playback range:

Timeline with range marker

Clicking in the range bar above the first track lets you define start markers, i.e. the starting point of the
playback range. If you right-click, the end marker will appear to indicate the end point of the playback
range. The length of the playback area is shown in the center of the section display.

n When the end marker has been reached, the playback cursor jumps back to the start marker
and begins playing everything again as a loop.

n The entire playback range can be moved using the mouse by clicking on the bar in the middle
while holding down the Ctrl key and dragging it. The in and out-points can be moved with the
mouse. Left-clicking positions the in-point, and the right mouse button sets the out-point.
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The project window playback range above the first track is linked to the playback range of the
program monitor. They cannot be changed independent of each other.

n To move the start and end markers to the beginning or the end of the film again, click
»OPTIMIZE MOVIE VIEW« in the »WINDOW«menu.

Handles:

All objects can be shortened by moving the mouse to one of the lower corners of the object until the
mouse pointer turns into a double arrow. You can now shorten the object as much as you like. At the
top corners of every object you will find two fade handles that can be adjusted to fade an object in or
out. The handle at the top center can be used to adjust the volume of audio objects and the
transparency of video objects. The image and audio tracks of videos will be cut together in the same
object. The handles in the center can be used to adjust the transparency of the video object (up) and the
volume of the audio track (down). Image and audio can also be displayed independently of each other
on different tracks. You can read more about this under "Objects".

Object selection:

For advanced effects editing, the objects must be selected first. Individual objects can be selected with
the mouse. Objects will change color to show that they have been selected. Multiple objects can be
selected by holding down the Shift key. If you click next to an object, you can drag out a rectangle with
the mouse button pressed down. All objects contained in this rectangle will be selected.

Effects editing:

Selected objects can be edited with the effects in the Media Pool.

The settings for each effect can be adjusted in the Media Pool.

You can see what the current effect setting looks like in the program monitor.

Most effects can be controlled using keyframe animation and effect curves. The intensity of the effect is
controlled either dynamically with single points (keyframes) or drawn as a curve (effect curve). All the
buttons for keyframe and effect curve animation corresponding to the selected effect can be found in
the lower area of the Media Pool.

Note: A keyframe must first be selected before an effect curve can be activated.

Context menu:

The context menu also offers a series of editing options for objects. This dialog can be opened by right-
clicking on an object. Different trim editors can be opened which enable an exact cut with different
transition parameters (for example). For video objects there is a different context menu than the one for
audio and title objects.
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Remove unusable scenes
There are two ways to cut out unusable scenes from footage:

n Option 1: First, the complete material is loaded into your project and the unusable scenes are
cut out.

n Option 2: You can cut the material in the Media Pool before you import it, and then proceed to
import only the scenes you need. This process is recommended for long movies where a lot of
editing is needed.

Cut videos in the project window

Let's assume that you have already imported your film material into a project and would now like to edit
it.

n Play back your video by clicking the play button on the program monitor's transport control (or
simply press the space bar on the keyboard).

n If during playback you have reached a scene that you would like to cut out, click the playback
button in the transport control a second time. The playback marker stays near the start of the
scene to be removed.

Tip: In the case of long films or to speed up searching, you can also fast forward the video and follow
the action on the program monitor. To do this, pull the playback marker across the timeline (but not
too fast!) while holding down the mouse key.

n Set the playback marker exactly at the start of the unusable material. The zoom function is
recommended to get a better view of longer videos (the »+/-« buttons in the bottom right
corner of the project window).

n Press »"T"« on the keyboard. This will split the current scene into two sections at the position of
the playback marker.

n Repeat these steps for the end of the unusable scene. Find the end of the unusable scene, place
the play marker as close as possible to the end point, and then press the "T" key on the
keyboard again.

Now you have "isolated" the unusable scene and can delete it from the video by pressing "Del" on the
keyboard. Before this, the scene must be selected by clicking it with the mouse.
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If you didn't work accurately during cutting, then don't worry; you can use the object handles to stretch
or shorten the remaining objects to recover or exclude material from the deleted section.

After deletion, a gap will appear in the film sequence where the removed material was. How do you
remove gaps from the movie? It's easy: Simply drag the later scenes up to the earlier scenes until they
"dock" with each other. Remember to drag all objects that are further behind, otherwise the gap will just
be passed on down the line. To drag later objects, use the "All Tracks" mouse mode. This automatically
takes the objects on all tracks found later on the timeline along with the object being moved.

Note: If your project has an audio track in addition to the image track, it is usually necessary to cut
audio and video tracks synchronously. After import from the camera, video and audio tracks are
automatically combined in one object, i.e. all cutting and moving actions have an effect on video and
sound tracks simultaneously. If you have added a separate soundtrack which has not yet been grouped
with the image sequence, you should group them before starting to edit. To do this, select the video
object and the audio object with "Ctrl" + click, and in the "Edit" menu select the "Group" option (or
click the Group Tool).

All of the cutting functions are non-destructive (as are all of the editing functions in MOVIE STUDIO).
This means that all original material will remain unchanged on your hard drive.

Importing individual scenes from longer movies

If you have saved a longer video as a file on your hard disk and only want to use a section of it for your
project, you can proceed as follows:

n Double-click on the file you want to use in the Media Pool. The file will load to the program
monitor and can be played back there using the transport controls.

n Find the area you want to import. Position the play marker above the transport control at the
start position of the range and click the "Set in point" button.

n Next, position the playback marker at the end of the section and click the "Set out point" button.
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n The currently selected range appears as a blue bar in the range display. You can play back this
range separately with the "Range playback" button.

n All range limits can be moved by holding down the mouse button and dragging. Once the range
matches the section that you want to import, click on the preview image in the monitor and
drag it onto the track. An object will appear, corresponding to the selected area.

Regroup scenes
You will often want to move specific scenes or even groups of scenes to a different place within a
movie.

This can be done easily:

n Single scenes can be selected in any view ("Timeline", "Storyboard" or "Overview" modes) with
a click, and then moved to the desired spot with the mouse button held down.

n In the Timeline and Overview modes you can also create scene groups which can be moved
together: "Ctrl + mouse click" lets you select more than one scene, "Shift + mouse click" selects
the scenes that lie in between.

Finally, here are three tips for more extensive arranger work:

n The mouse modes »ALL TRACKS« or »ONE TRACK« don't just move the selected scene, but
all objects that are located behind the object in the same track ("one track") or all tracks ("all
tracks").

n The commands »GROUP« and »UNGROUP« let you join any scenes into groups which can
then be moved together as a block.

n If editing and moving around objects leaves your project looking messy, you can also work the
other way around by selecting the scenes you want to use and saving them to the
»RECORDINGS« folder in the Media Pool. Collect scenes that you want to use and place them
in the »RECORDINGS« folder, then start a new project and drag and drop scenes from the
folder into the new project in the order you want. The »RECORDINGS« folder can be accessed
in the Media Pool under »IMPORT > MYMEDIA«.

Burn DVDs with interactive menus

Once you are satisfied with your video, move to the »BURN« screen to burn it with an interactive DVD
menu onto a disc.
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For multiple films that are subdivided into individual scenes or chapters, the DVD selection menu
becomes even more important. This is because you require manageable navigation to be able to jump
between each film and each scene.

The Burn screen has two views: Preview and Edit. Use the buttons located in the upper left to switch
between them

In both views, you will see a preview of the DVD menu in the middle of the screen. All movies appear as
uppermost entries, and all scenes appear as sub-entries.

You can use the remote control to the left to test the functions of the menu just like in a real DVD
player.

In the Edit view you can access the structure of the selection menu in »NAVIGATION«. You can switch
off unnecessary chapters by unchecking the corresponding box. The entry will be removed from the
menu, but the scene will not be removed from the movie.

To make sensible chapter divisions in your movies, each movie must feature corresponding chapter
markers in the editing window. If you want to change the current scene splits, it is best to switch back
to the Edit screen and then choose the movie which you would like to split.

n Place the playback marker at the location in the track where you want a new chapter to start
and choose the option »CHAPTER MARKER« from the Edit menu (keyboard shortcut: Shift +
Enter).

n The option »SET AUTOMATIC CHAPTER MARKERS« automatically sets a chapter marker at
every cut scene in the film. Superfluous chapter markers may simply be clicked and deleted.

If you are satisfied with the subdivision of the movies and chapters, you can devote yourself to the
layout of the selection menu.

In the lower section of the program area you can find a whole row of pre-made menu layouts. Use the
scroll bar to view each template. There are plenty to choose from:

n If you wish to fully apply a template, double-click on the template of your choice. The complete
template will then be applied.

n In the Edit view you can also combine various elements of individual templates with one
another. For example, if you want to combine the text format of a template with the
arrangement of another one, then select »FONT« first and double-click the template with the
text of your choice. Then select »ORDER« and double click the order you like. The preview in
the middle shows you the results immediately.
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n Double-clicking the preview picture or a menu entry opens an editor for you to change the film
or chapter name and select a different preview picture.

When all videos and chapters are logically arranged and you are satisfied with the selection menu, you
can go ahead and burn.
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MAGIX CONTENT
Access the MAGIX content library from directly within MOVIE STUDIO and discover royalty-free
content for adding to your projects:

n Video content (stock footage, animations, and visual effects)
n Audio content (song archives and audio effects)

Note: A subscription is needed to download content.

For more information on subscriptions, please visit our website:
https://www.magix.com/de/support/abo-service/

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

How to access MAGIC Content

1. In the main menu, click »FILE «»MAGIX CONTENT«.
2. Log in to your MAGIX account (when opening MAGIX Content for the first time).
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Search for content

There are several options for searching for specific content and filtering the results.

1. Select the type of media for which you want to search.
2. Enter a search term in the field and click Enter to start the search.

Tip: Click the magnifying glass in the empty search field to filter all content.

Tip: You can enter BPM values for audio files and pixel size for video files so that only files with
a specific tempo or resolution appear in the search results.

3. You can narrow your search results further according to:
n Content type
n Details
n Duration (minimum and maximum length)
n Frame rate (video only)
n Categories (audio only)

4. Click on the house icon to return to the start page.
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Displaying and using content

1. Show preview:
1. To preview an audio file, click on its waveform.

The file will then start playing.
2. To preview a video file, double-click the video thumbnail »PLAY«.

2. Download content:
a Click the »DOWNLOAD« button and from the list that appears, select the file format and

the resolution in the case of videos.
For more information on changing the download folder, see the Program settings
(⇗77).

b Close the window once downloading is complete.
All downloaded content can be found under »MEDIA POOL«»IMPORT«»MAGIX CONTENT«.

As part of your subscription, every 31 days you'll receive 10 files that you can download for
unlimited use.

MOVIE STUDIO 2023 | MANUAL

MAGIX Content Burn DVDs with interactive menus 73



SETTINGS AND MANAGING VIDEO PROJECTS

Film and project settings

When you create a new video project, you can make settings for the new project already in the start
dialog. You can change these later at any time. All settings dialogs may be accessed via "File >
Settings".

Open themovie settings via "File > Settings > Movie..."

Movie settings
Play movie in loop mode: The movie will be played back endlessly. Playback starts at the playback
marker and after reaching the end of the project will restart at its beginning.

Use current settings as presets for new movies: If this option is activated, all new movies will receive
the settings that you have chosen in this dialog.

Crop new images to fit the screen automatically: Fits all images and videos inserted into the project
automatically so that they fit the screen.

Automatically create proxy files (Plus/Premium version): Using proxy/preview rendering, you can
render complicated sections of your project in advance in order to produce a smooth preview. You can
start this feature in the context menu of the marker bar. More about this is available in the "Proxy
editing" section.

Number of tracks: Here you can change the number of tracks.

Audio sample rate: The preset sample rate is 48 kHz. This sample rate is used for all recordings and is
also the standard setting for DVD audio tracks. With this setting, optimum sound quality is guaranteed.
Audio material at different sample rates (e.g. CD audio with 44 kHz) is automatically converted when
loaded (resampling). Only change this value if you want to use audio with a different sample rate or if
your sound card does not support this sample rate.

Note: The audio sample rate can only be changed in empty projects. When an object is added to the
project, this setting is locked.

Video settings: You can select the standard settings for the picture format and frame rate for PAL or
NTSC images or for your own format. Make sure that the entries for aspect ratio and frame rate
correspond to your target format so that your finished movie will play smoothly on the intended screen,
no undesired black strips are seen, and all video/image objects are in their correct positions.

Note: MPEG encoding requires a width/height ratio that is divisible by 8.

Movie information
This option opens an information window:

Name: Here you can enter the name of the current movie.
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Date of creation: Displays the time the movie was created.

Last changed: Displays the time of the last save.

Number of used objects: Displays the number of all objects in the movie.

Used files: All files used in the movie are listed here.

Project settings
You can change project settings here. A project can consist of multiple movies and is saved as an MVP
file.

Name and path: Displays the name of the movie and the location where it is stored on the computer.

Description: Here you can give your project a description – perhaps a few statements about the state of
the editing progress, etc. This is something like a notepad function.

Date: Here you can assign your project a specific date. You can choose between a date – e.g.
"December 25, 2020" – or a written description – e.g. "Christmas 2020".

Preview: This is the preview in a file manager such as Windows Explorer. You can use the automatic
selection for the preview image or choose an image from your hard drive. You can also use a preview
image from movie project.

Select preview image automatically:MOVIE STUDIO uses an automatically selected preview image.

Use image file:With a mouse click on the folder button you can open a dialog for loading image files. In
this dialog you can navigate to the folder where the image file is found and select it with a double click.

Use preview image from film: Select a frame from a film using the slider.

Cleaning Wizard

The CleaningWizard helps delete disc images and entire projects from the hard drive, including all of
the media files used.

Use this function to free up disk space for future projects.

Caution: If the files you used in the film (such as trailers, opening music, etc.) are ones you have used
in other films, you should make copies of these files beforehand.

Delete certain files: Choose this option if you would like to select certain files for deletion. In the file
selection dialog, you can select the desired files. In the next step, the CleaningWizard searches for
other files which belong to your selection. Using this method you can delete an entire movie with all of
its accompanying media, help, project, and backup files. Before deleting the files, you will receive
relevant information in a dialog and be asked to confirm deletion.

Find and delete unnecessary files: Choose this option if you want to find unnecessary files or free up
some space on your hard drive. The CleaningWizard then automatically looks for extraneous files
created while using MOVIE STUDIO that are no longer needed. Before deleting the files, you will receive
relevant information in a dialog and be asked to confirm deletion.
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Under Advanced you can define which files and folders should be included in the cleaning process.

Start dialog

Presets for the project can be defined in the start dialog.

Note: These settings have no effect on the internal processing quality and can be changed at any time
by going to "File > Settings > Movie".

New Project Wizard

Project name: Choose a name for the new project.

Project folder: Select a location for saving the project.

Film settings: Standard film settings are included here in a range of categories. Recommended presets
appear for whatever category you choose. However, you can set whatever frame rate you want
regardless of the presets. The film settings now also include presets for social media. This makes
importing and editing square or portrait videos easy.

Open movie settings: Check the box here if you want to view the movie settings and adjust them.
When you click on »CREATE PROJECT«, the "Project/movie settings" opens.

Copy media to project folder: Activate this option to save a copy of all files imported to the project in
the project folder so that they can be opened here in future for editing.

This option is meant to keep things centralized when files from various media devices (e.g. hard drives,
USB flash drives, SD cards) are being used in the same project. The internal hard drive is the best option
for working on projects in MOVIE STUDIO because it allows faster access to files compared to external
storage devices. If files stored on external devices are used, this can lead to slow performance and lag
while editing. Storing on the internal drive also ensures that you can access all project files for editing.

Load project

Here you can select and load a previously saved project.
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Program settings

All basic settings for MOVIE STUDIO are made in program settings. Open the program settings by
going to "File" > "Settings" > "Program...".

Playback

Audio playback

Driver selectionHere you can specify whether the WindowsWave driver or the DirectSound driver will
be used for audio playback.

n WAV drivers are recommended if the CPU load is higher, as the larger buffers allow better
handling of the load peaks (otherwise this would cause crackling).

n DirectSound is a component of DirectX and, if necessary, is installed together with MOVIE
STUDIO. DirectSound has the advantage that the sound output (for all modern sound cards or
onboard soundchips) can also be used by other programs open simultaneously.

Output device: Use this option to specify which sound card plays the wave audio objects. This is
especially important if you have multiple sound cards installed on your computer, e.g. "onboard sound"
as well as an additional sound card.

Audio buffer: In order to allow smooth playback of a complex project, MOVIE STUDIO creates a RAM
data buffer into which the current data is loaded. This allows for step-by-step preprocessing instead of
preprocessing for the entire project.

n Number of buffers: Here you can specify how many buffers should be used. More buffers
increase reliability and improve playback performance, but they also increase the memory
requirements. When playback goes through DirectSound, only one buffer is used automatically.

Note: As a rule, if response and loading times are too slow, reduce the number and size of the buffers.
Otherwise, increase the buffer size if you are still having problems with playback performance. Since
error-free playback is usually more important than fast reaction times, the buffer size should be raised
to 16384 or 32768 to avoid drop-outs. The possible number of used buffer updates is between 2 and
10.

n Multitrack size/Preview size: Specify the buffer size used to play the entire project or for
previewing waves in the file manager.

Video playback

Overload prevention for realtime playback: Here you can activate or deactivate overload prevention
during realtime playback of the project. This feature is particularly suitable for lower performance PCs.

Instant cache refresh in Multicam Mode: Activate this mode to empty the cache in short intervals
which will make the preview for multicam editing immediately visible in the preview monitor. This may
result in juddering during playback.

Number of tracks for parallel track optimization: It makes sense to limit the number of tracks when
the program is running low on disk space and the project has multiple videos in parallel.
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Arranger

Autoscroll during playback: If autoscroll is activated, the screen view automatically shifts when the
playback marker reaches the right edge of the screen, which is useful for longer arrangements. You can
select the size of the scrolling steps from either "Fast" (whole pages) or "Slow" (half pages).

Note: Scrolling requires constant recalculation of the screen view which may lead to interrupted
playback if system RAM is too low. If this happens, simply deactivate the autoscroll feature.

Update in background: The update of the object display after move and zoom operations in the project
window is performed in the background in order to let you work smoothly.

Spacebar function: You can set whether the playback marker returns to its original position or stays at
its current place when playback is stopped with the spacebar.

Folders
Here you can set the path where...

n you can save your projects (Projects),
n you want to store the exported or imported files and recordings,
n your downloads are saved,
n disc images are saved,
n where editors for audio and image editing are found, which should be opened by default

(Plus/Premium version only),
n and where the VST plug-ins are installed.

Video/Audio
This tab contains all setting options for video and audio files.

Video standard

Normally, the right video standard is set up automatically. PAL is used in Europe; the United States and
Japan use NTSC.

Timeline

Simple display of video objects (first and last image): Activate this function if you are having
performance problems. The preview images of a video in the project window will only be displayed at
the beginning and end of the video.

Half waveform display: Half of the waveform display (upper part) is enough for audio editing. This is
the default setting. For more detailed, professional audio editing, you can display the complete
waveform.

Video/Audio on one track: Activate this option if you want imported video footage to be displayed as
one object with video and audio on one track. You can always use the options in the object menu to put
the video and audio on separate tracks later to edit them individually.
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Display guidelines: If needed, you can display guidelines in the project window. The spacing between
guidelines is adjusted to the zoom factor set in the project window.

Audio -6 dB on import:When you load a file containing audio material (sound), the loudness of the
generated object will be set to -6 dB. This is particularly useful when playing back several objects that
contain audio material at the same time. This reduces the risk of undesirable clipping. Object loudness
can be edited at any time.

Import

Automatically create frame table during import: Sometimes, rebuilding a frame table can get rid of
problems in certain MPEG files. For example, problems can arise if the navigation (positioning of the
playback marker, transport) is bumpy or doesn't function at all. Normally, when loading MPEG video, a
frame table is not created in order to speed up the loading process. If you do create one anyway, MPEG
files are normally noticeably faster and easier to edit.

Automatically create waveform when importing: Select this option to automatically create a
waveform display for the audio track. This can also be created at any time via the context menu.

Import videos with audio: If a video file contains video and audio data, the audio track of the video will
also be imported if this option is activated. It will be displayed as a combination object in the project
together with the video. If you want to edit or replace the audio track later, you must first display the
video and audio object on separate tracks (context menu "Audio functions" > "Video/Audio on
separate tracks". Audio and video objects are grouped to synchronize sound and image, if you want to
edit the audio or video separately, you have to first remove this grouping ("Ungroup" button in the
toolbar or via the "Edit" menu).

Standard display time: Specify how long an image in the project should be displayed before moving to
the next object.

Note: Adding transitions between the objects will reduce the actual display time. If you plan on using
transitions, it is best not to set the display time too short.

Trim videos: Sometimes video clips have damaged frames at the beginning or end. Most often these
are green, black or incomplete. Here you have the option of automatically trimming your videos during
import if your footage constantly has damaged frames. Specify how many images (frames) should be
trimmed at the beginning and the end of the video.

Note: The frames are not lost due to the shortening. By adjusting the object length in the project
window you can make the trimmed frames reappear.

System

Program interface

Dialogs:When newly installed, MOVIE STUDIO displays a number of messages in various parts of the
program. Each of them can be switched off by clicking the small box at the bottom that says "Don't
show this message again". To display these warning messages, select the "Reactivate dialogs" option.
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"Hide news" enables current messages concerning MOVIE STUDIO to be deactivated, and the screen
can also be set to darken when dialogs are displayed.

Undo/Redo

Here you can set the maximum number of steps the "Undo" function can have. Please note that
memory requirement increases with the number of steps the program must save.

Other

Automatic preview when changing transitions:When this option is activated, a short preview of the
transition effect will be quickly played between the two objects you selected.

Move playback marker when selecting objects: This option automatically moves the playback marker
to the beginning of the selected object.

Send usage data to MAGIX: Anonymous data is sent to MAGIX for improving product quality. This
option can be deactivated here.

Save automatically

Here you can set up an automatic backup function, which saves the project as a backup file with an
"MV_" (instead of the normal project file "MVD") in the project folder. You can choose whether or not
your project should be backed up and at what intervals this will take place.

Device options

Video output to external device

Activate video playback:With this option, you can display the project window view on an additionally
connected monitor. Without additional hardware, you can play a preview in any mode in order to see
how the final material looks.

Hardware Acceleration

»IMPORT/PROCESSING/EXPORT:« Set whether hardware acceleration should be used for individual
processing steps separately, and if so, which graphics card should be used. By selecting »CPU« the
corresponding processing step is performed by the main processor, by selecting another option it is
performed by the respective graphics card. Import involves decoding the source media, processing
handles the application of effects and playback and export refers to encoding into the desired format
upon export. The advantage of setting these parameters separately is that if there are problems with
one of the processing operations, you do not have to deactivate hardware acceleration entirely, but only
for the corresponding step.

Comparison image during effects editing in the Media Pool: If this option is activated, the "Selected
objects without effects" comparison mode will be automatically activated when switching into the
Media Pool effects, and will be automatically deactivated when the mode is exited. This serves to
compare the original and edited image. This automation will be suppressed if the option is deactivated.
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Output on monitors in with higher bit depth: If this option is activated, you can display video material
with higher bit depth on an appropriate monitor in higher bit depths. Because most monitors don't yet
support output in higher bit depth, this option is off by default.

Use dithering for output: Dithering improves display for color gradients and avoids typical output
errors (color lines), that appear as a result of bit depth reduction. To put it differently: Dithering
preserves the advantages of recording in higher bit depth when displaying in normal 8-bit depth. You
should therefore deactivate this option only in case of problems.

Preview and playback in analog capture

The preview and playback modes for analog capture can be set up here.

Video mode:

As a general rule, the default setting should not be changed, since it delivers the best results. If you
notice problems, such as the image turning black, you can try to see if picking an alternative mode helps.

Note: Only change the video mode when there are problems with the presets, e.g. choppiness or
lengthy screen distortion.

Deinterlacing: In the alternative mode "Video Mixing Renderer 9", you can activate hardware
deinterlacing with your graphics card.

Import/Export

Other

Automatically preview exported clips: This option starts the clip immediately after exporting for
verification.

Import Formats

File formats that you never use can be de-selected here. Once de-selected they will no longer be
imported. Please keep in mind that several import modules exist for some file types (AVI, WMA);
MOVIE STUDIO uses the fastest one in each case. If you experience problems when importing certain
files, you can experiment with deactivation of certain import modules and therefore force MOVIE
STUDIO to use the slower but more compatible import module.

Backup copies

MOVIE STUDIO lets you quickly and easily create backup copies of your entire project (including all
video objects, all effects, etc.). We recommend making regular backups, especially when working with
very large projects. Doing this will allow you to return to "old" versions of your project if, for example,
your hard drive crashes or there's a problem with your project. This function can be found in the "File"
menu.
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Copying movies or project and media into folder
With this feature, you can put a complete MOVIE STUDIO arrangement, including all applied
multimedia files, into one folder. This is especially useful when you wish to reuse or archive such a
project later on or when the files can be found on multiple CDs so that on loading you continually have
to change CDs. Furthermore, the effect files used are saved in one folder with the other files.

If you select the option, "Copy disc project, movies, and media in folder", all movies in the current disc
project, including all of the related media, are put together, and then copied into the selected folder.

Hint: <Programmname> also features DV logging. You no longer need (under the circumstances) to
save large DV-AVI and audio files, since MOVIE STUDIO saves the position of this material on the
DV tape and imports missing files automatically when reloading the DV tape.

A dialog opens where you can specify the path and name of the video.

Keyboard shortcut

Restore project from video disc
This command restores a project backup that has been saved on a disc.

To do this, in the "Burn"interface, go to »"BURN DVD" > "ADD FILES..." AND SELECT AND ADD
THE BACK UP PROJECT«. > Burn to disc.

You can choose which of the movies contained on the disc should be restored by selecting it in the list.
You also need to indicate the folder where the project should be saved. A subfolder "Backupxx" will be
created in this folder where all project files from the disc will be saved. All of the restored movies will be
loaded into MOVIE STUDIO for editing.

If you select the option »RESTORE IMAGE FILES ONLY« only the original image files contained on the
disc are restored.

Load backup project

All backups saved by MOVIE STUDIO are listed in a dialog and can be restored. This type of automatic
backup gets the file extension MV_ (underscore).

This option is useful in emergencies, e.g. if the program crashes or you unintentionally saved your
changes during editing and wish to return to the previous version of the movie.

Tip: Under "File > Settings> Program... you can determine how often an automatic backup will be
created in the "System" tab under "Automatic backup".

Batch conversion

With batch conversion it is possible to bring multiple video files, movies, objects or whole projects in
just one step into another format.
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Batch conversion can be opened using different presets. A pre-selection appears only if you have loaded
a film or a project.

The following scenarios exist:

n Batch conversion has been opened from the context menu in the Media Pool: The file
selected in the Media Pool before will be transferred to the task list and can be converted to the
available formats.

n Only one empty movie is open: In this case use batch converting via "File" from the menu. A
dialog opens additionally for batch conversion, in which video files that have to be converted to
other formats can be selected and loaded.

n Multiple movies with video material are open: The opened movie will be exported as a whole
video. This is especially useful for large projects with lots of individual movies, eliminating the
need to export each one individually.

n A movie with video material and more than one object in the first track is opened: Open
batch conversion from the "File" menu or using the keyboard shortcut "s". A dialog opens, in
which you can select which tasks should be created for batch conversion.

l Multiple movies: The opened movie will be exported as a whole video. Additional
movies can be added to the list in the dialog.

l Objects in movie: All of the objects in the first track will be exported in individual
video files.

l Chapters: All chapters of the current movie will be converted into individual video
files.
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Presets: Here you can save and load your settings. These include the list of files to be exported and the
export settings and names of all entries.

Note: Batch conversion references the projects and the objects contained directly therein. Keep in
mind that for converting of entire movies, the source material must also be available. During
conversion of individual objects, make sure that the movie file has not been changed between loading
and saving.

This is the list of all objects that have to be converted into the indicated format. Each task can have its
own export settings.

Add files (not during conversion of individual objects from movies):Manually add files, including
video files and projects.

Remove selected: The marked tasks will be removed from the list.

Duplicate selected: If you would like to export tasks in multiple formats, you can mark and duplicate
them and assign individual export settings to them.

Format settings: Here, you can make settings for the currently selected tasks, whereby multiple tasks
can be given a setting simultaneously. Select one or more tasks from the task list.

Note on format setting for multiple tasks: If one of the marked tasks already an individual setting,
its will be lost after another format is selected. To prevent this, remove the selection for each task
using Ctrl + mouse click.

Set the target format in the flip menu. The default is "Windows Media Video" (WMV).

Advanced settings: Here, you can open the dialog for the advanced format settings. This corresponds
to the dialog for normal video export of a movie.

Tip: If you give several tasks the same file name, the created files will be intelligently documented. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically.
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Shut down PC automatically after successful export: This option is useful especially when you export
long movies and are using an especially high-quality and resource-demanding export format. You can
leave the computer to work on the individual tasks and after finishing them it will turn itself off.

Start batch conversion: Click on "Start conversion" to start the process. After ending conversion
processes, a list of all export processes with a message informing of its success will appear.

Hint: During batch conversion, non-critical messages that appear during normal file import will be
suppressed. This is to enable the smoothest conversion of all tasks.
Nevertheless, there are some important messages that may require action. Therefore, please make
sure that all files to be converted or the project can be easily loaded before starting a batch conversion.
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RECORDING
Select the recording method

To start recording, click on the red "Record" button located below the program monitor. The
following selections are possible in the dialog window:

AVCHD For importing from AVCHD cameras, removable storage devices and MTP
devices.

Audio For microphones, cassette recorders, MiniDisc players, turntables, etc.

Screen Records directly from the computer monitor.

Single frame For single and series images from analog video cameras, analog TV,
VHS recorders, webcams, etc.

HDV camera For HDV cameras

DV cameras For mini DV cameras and DV video recorders

Analog For analog video cameras, analog TV, VHS recorders, webcams, etc.

Recording AVCHD

When importing from AVCHD/SD card/USB, files created by the camera will be copied to the
computer. In addition to normal removable storage devices, "MTP" devices are also supported. MTP is
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short for "Media Transfer Protocol" and refers to the transfer protocol of media devices such as photo
cameras, video cameras and MP3 players.

If a less powerful computer is used, it may be helpful to transform AVCHD files upon import to a
MPEG-2 format. A corresponding query appears during importing of these files.

Note: When importing AVCHD videos it is necessary to activate the MPEG-4 codec and download an
audio package upgrade if necessary. MOVIE STUDIO offers this option as soon as a codec is required.

Note: Refer to the camera's instruction manual for the proper procedure.

After selecting the import, the following dialogue will open:

1 Video source: Here you specify the hard drive that will be used to access the storage medium or
connected camera.

2 Save in following folder: Create a target folder for the files to be imported.

3 Advanced settings: Adjust various settings for the name and date of the files to be created.

4 Select: This offers self-explanatory options for file display ("all", "only new", or "none").

5 Preview monitor and transport control: Here you can play back, rewind or fast forward clips in
the file list.

6 Medium/General: An info area for the files is provided to the right next to the preview monitor.

7 Options for displaying files, here you can also specify the criteria which will be used to sort the
files.

8 File list: The contents of the selected drive are shown here. Use the display filters (10) to reduce
the types of files shown. You can select every file separately using the little check boxes in order
to import them later.

Note: The files are color-coded. The same colors indicate roughly the same recording times, so
that you can quickly recognize which recordings were made at the same time. Color
assignments come with a certain "intelligence", which means they take into account how far
apart the displayed recordings are chronologically.
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9 Import: Imports the selected file to the target folder.
Cancel: Closes the dialogue without importing.

10 Display filter: The display filter can be used to define whether certain files should be hidden.
When you uncheck a box, the corresponding files will be hidden.
n Videos: Hides all video files.
n Photos: Hide all photo files.
n Selected files: All files selected for import will be hidden. Only the files which have not

been selected will be displayed.
n Not selected files: All files which have not been selected will be hidden. This is useful if

you want to check your selection before importing.
n Imported files: All files which have already been imported by MOVIE STUDIO from the

specified device will be hidden.

11 Import options: Here you can define what happens after importing.
n Insert into movie: The media will be directly inserted as an object into the open movie.

When inactive, they will be simply copied into the target folder and can be selected from
the Media Pool at any time.

n Delete all media after camera import: This option deletes the selected media after
importing from the camera.

n Close dialog after import: The dialog closes as soon as the import has finished.

DV camera / HDV camera

Connect a DV or HDV camera

1. Connect the digital output of the switched-off camera with the computer's DV interface (also
called FireWire or iLink).

2. Insert a DV cassette or the storage device into the camera.
3. Switch your camera’s operating mode to "Video recorder" or "Playback".

The camera is now ready to transfer video to the computer.

Note: You may also use a HDV camera in DV mode to, for example, transfer recordings in the old DV
format.Note: You may also use a HDV camera in DV mode to, for example, transfer recordings in the
old DV format. Problems have been noted with this mode in many cameras, therefore it is
recommended that the Record mode of the camera is also switched to DV, switching the camera off
and then on again.

Capturing from DV video recorders or cameras

If you want record using the more space-saving MPEG format, record the "Record DV as MPEG"
option in the recording dialog. Uncompressed DV capture requires approx. 220 MB per minute of
video.
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1. Check to see if a DV camera driver has been selected.
2. Name the recording and set a storage location.
3. You can access the appropriate place on the camcorder tape by using the remote control

buttons: shuttle forwards, backwards, and start/stop playback.

4. Click on the "Record" button to start recording . Take note of your remaining hard drive
space.

5. Stop recording with the "Stop" button and exit the record dialog.
You can see the recording in the project window in the lower third of the screen.

Tip: In the DV recording dialog, you can set clips from the DV video which will then be recorded one
after the other (batch capturing). Find out more under "Batch recording".

Dialog elements

Select DV device driver: This is where the driver for your DV device is displayed. When "Audio
Recording" is deactivated, only video without sound is recorded. "Audio
preview" activates the audio output of the recording.

Note: The audio preview is deactivated at first, since DV cameras
usually include built-in speakers.

Save video file as/Save in
the following file

You can enter the name of the movie to be recorded here. You may also
select the folder where you wish to store your video file. The default
recording directory is set by default, but you can change the Path settings
settings in "File > Settings > Program > Folder".

Edit after recording Here you can access the automatic editing options.

Start the device
automatically

Starts the DV recorder or DV camera automatically when the "Record"
button is pressed. This does not function with all digital cards/video
devices.
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Video preview You can see a preview of your movie on the program monitor.

Original size This option allows you to preview the video in the original size, and where
applicable fullscreen mode. To return to the dialog use the "Esc" key.

Record list: Here the start and end points can be set for the
capture. This allows you to search the entire video for
all captures to be used and list them for planned
capture. This is processed in sequence when the
recording starts (via the red button). That way you do
not need to record each scene individually. You simply
determine recording time points, and the computer
takes care of the rest. To set the start and end points
precisely, click »"ENTER START/END POINT"«

Use this button to view the available list of already recorded videos and
scheduled recordings. All entries from the list can be selected and
deleted. All entries can be selected and deleted.
Every batch recording is automatically logged. Conversely, every
"manual" DV and HDV recording is transferred into the recording list in
order to restore lost recordings without much effort.

Batch recording Here the start and end points can be set for the capture. This allows you
to search the entire video for all captures to be used and list them for
planned capture. This is processed in sequence when the recording starts
(via the red button). That way you do not need to record each scene
individually. You simply determine recording time points, and the
computer takes care of the rest. To set the start and end points precisely,
click "Enter start/end point"

Record Starts the capturing process. Also contains the list of scheduled
recordings. These are processed step-by-step (batch capturing).

Stop The recording process is stopped.

Snapshot This will create a frozen image directly from the program monitor. Start
the camcorder and watch the preview window. When the image you want
appears click "Snapshot". Or you can navigate using the remote control to
the position you want, and stop there in Pause mode. Stopped playback
on the DV camera will not deliver an image. The images are saved in the
record directory as graphics files in the set resolution.

Remote control
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Digital camcorders can be controlled remotely by MOVIE STUDIO. This does not function with all
digital cards/video devices. If your hardware does not support the remote control function, the buttons
will not be usable.

The necessary transport buttons can be found in the DV or HDV recording dialog.

Tape ID: Enter a name for your tape here. MOVIE STUDIO requires this name for the DV
logging feature.

Recording
information

Displays various data regarding your captured video.

Enter
start/end
point:

Enter the exact start and end point or the recording length for a scene. Both values can
be entered as ATN (absolute track number) or as a timecode in
hours:minutes:seconds:frames.

Analog video recording

This option allows a video recording to be made from analog sources.

Connect analog video source
Connect the video out of your video camera, DVD player or VCR to the video in (TV, video, or video-in
graphics card) of your computer, and the audio out to the line in of your sound card.

Due to the variety of device configurations, it is difficult to say which cable will function best with your
setup. If you’re not sure, check the manual of your VCR or your TV, video or graphics cards.

Example:Many VCRs have a SCART output and most DVD players have three RCA outputs (two for
the stereo track, one for the image). In such cases, you will need a SCART to RCA adapter, a cable with
3 RCA plugs at each end.
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SCART/RCA
adapter

SCART/RCA
adapter with 3
RCA jacks

Stereo
RCA/mini
phone jack
adapter

Most sound card inputs are mini stereo jacks. To connect the audio out of your VHS recorder to the
sound card audio in, you will need a stereo RCA to 3.5 mmmini jack adapter.

You will have to purchase a cable with three RCA plugs and a stereo RCA/mini phone plug adapter.

Recording dialog

Video/audio drivers: Set the video card or sound card for recording here. In practically every case the
driver software supplied with the hardware must be installed.

Input/tuner settings: If your video capture card supports multiple sources, i.e. your card also has a TV
tuner or multiple inputs (SVHS, composite, etc.), then you can select the proper recording source and
the TV channel to be recorded here.

Save video file as/save in following folder: Enter the name of the movie to be recorded. You may also
select the folder where you wish to store your video file. The standard recording folder is set as default.
The location of this folder may be changed via "Path settings" under "File > Program settings > Folders".

Edit after recording: Use this to access the automatic editing options.

Recording quality: The list box enables you to select various predefined levels of recording quality, e.g.
depending on the purpose of the image material and computer performance. These are sorted
according to picture quality. Use the configuration tool to fine-tune the quality for the preset. Presets
you have created yourself appear in this list as long as you use the default folder provided as the save
location.

n Presets displayed with MPEG record directly in MPEG format.
n The preset "AVI: user-defined" enables AVI videos to be recorded via the codecs included with

MOVIE STUDIO. There are several codecs for various applications, e.g. "MSU Screencapture
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Lossless Codec", which is used for screen capturing. Please also see the general information
provided on AVI video.

Tip: Use the presets marked MPEG if you want to burn your recordings straight away, since smart
encoding helps omit laborious encoding after recording.

Advanced...: Opens the video driver settings dialog.

Capture controls: This provides access to the "Red" record and "Stop" buttons. These start and stop
recording.

Timer recordings active/time limit: Specify the recording start time and length to turn your PC into a
fully functioning VCR.

Snapshot!: This will create a still shot directly from the program monitor. The images are saved in the
recordings folder as graphics files in the resolution you have set.

Recording information: This shows statistical information such as the recording time, available space
on the hard drive, the recorded frames, and the "dropped" frames. Dropped frames are frames that have
been left out because the computer is too slow for the selected image format and recording quality and
cannot accept all incoming frames.

Preview: Some graphics adapters allow you to reduce the system load by deactivating the video
preview. If you hear an "echo", deactivate the audio preview.

Advanced configurations in the video capturing dialog

These dialog boxes, so-called "property sheets", come with the video card drivers. These driver-specific
performance properties may deviate depending on the cards. We also have a very limited influence on
the behavior of these drivers. If you encounter any difficulties, please contact the video card
manufacturer and ask for the latest driver updates.

Input: Sets up the video card's so-called "crossbar".

The crossbar determines which video and audio input signal will be recorded. The crossbars are
connected in series to the video recording chip itself. In the output field, the video output (for the
crossbars) is the input for the recording chip (video or audio decoder-in) of the video card. In the
"Input" field, select the signal source that will be used by the video card to capture for this input. Many
video cards have separate crossbars for audio and video. If you have a problem, try out the different
configurations until the right sound matches the right image.
n Composite in = the regular video input (i.e. RCA jack)
n S-video = S-video input (mini-din jack)
n SVHS-in = SVHS input (special cable)
n Tuner-in = TV signal of the integrated tuner

Image settings

Video decoder: If the picture only appears in black & white or it flickers, the video standard may be set
incorrectly. In mainland Europe, PAL_B is used.

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend against changing
any of the manufacturer’s settings.
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Format: Please do not change anything here. The recording format is set in the "Recording quality"
option in the video recording dialog.

Station selection

This option is only available if a TV tuner is integrated into your video card.

Audio

Songs, noises or instruments can be easily recorded in MOVIE STUDIO using the audio recording
function. A hooked-up microphone or various audio devices (especially a stereo system) can be used as
recording sources.

Connecting the recording sources

First, the recording source must be connected to the computer. There are several possibilities
depending on the equipment you are using:

n If you would like to import music from a stereo system, use your sound card's line-in input. If
the stereo system amplifier comes with separate line-out or AUX out connectors, they should
be used. In this case, they have to be connected to the computer's line-in. Hi-fi amplifiers
usually have RCA (composite) connectors and the computer has mini stereo connectors. You
need to then get a suitable cable with two small RCA (composite) connectors and a mini stereo
jack.

n If the amplifier comes without separate outputs (other than the speaker connectors), you can
also use the headphone jack for recording. Normally, you will require a cable with stereo or mini
stereo jacks. This type of connection has the advantage of a separate volume control to set the
headphone input signal level. However, headphone jacks are often not very high-quality. For
this reason, you should use line-out outputs whenever possible.

n To record cassettes from a tape deck, connect the tape deck’s line-outs directly to the
computer's line-in.

n When recording LPs, the record player's outputs should not be connected directly to the
computer because the phono signal has to be pre-amplified. In this case, connecting through
the headphone jack or an external preamp is recommended. Some record players also have
normal line-out connections.

n If you would like to make recordings with a microphone, connect it to the computer using the
microphone input (usually a red jack).

Adjusting the signal level

Adjusting the signal level to the sound card is also recommend to get the best sound quality when
recording digitally.

Once a recording source is connected to the sound card, the Record button opens the recording dialog
and starts the recording source.
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You can now adjust the recording level with the help of the LED display in the recording dialog. For this,
you must first check off "Show levels".

If the adjustment is set too high, distortion occurs and the incoming signal must be reduced. If you have
connected the source through either an amplifier or tape deck output to the sound card, you can only
reduce the signal level in your sound card’s software mixer interface. You can access the mixer directly
from within the recording dialog via the "Recording level" button.

If you reduce input sensitivity by using the input fader, the resolution at which the analog signal is
digitized is also reduced. Try to set these automatic controllers to the loudest sound level possible!

The loudest part of the material is the yardstick for an optimal level. The loudest part should be adjusted
to the maximum. The actual recording begins when you press the "Record" button. At the end of the
recording you will be asked if you want to use the recording. Upon confirmation, the newly-recorded
material will be placed in the next free track at the position of the start maker in the project.

Normalize after recording: This option raises your material to the correct volume level after recording
is completed. In order to achieve good audio results, you should try to record the source as loud as
possible without overmodulating it. The Peak Meter display here helps in the recording dialog.

Audio driver: Selects the sound card for the recording.

Save audio file as.../Save in the following folder: Here you can enter the title of the audio file you wish
to record. You can also select the folder where you wish to store your file.

Recording quality: Sets the sound quality of the recording. In the preset menu you can choose between
AM Tuner, FM Radio, CD Audio, and DAT (Digital Audio Tape).

Display volume control (Monitor): The volume control (peak meter) to monitor the strength of the
input signal. Please read more on this in the section "Adjusting levels".

Record: This button starts the actual recording.

Stop: Click this button to stop recording
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Play while recording: This option is particularly important for spoken commentary and the like. If
activated, the selected movie (or selected scene if recorded in Edit screen) is played while recording.
This acts as orientation for the film.

Advanced: Use this button to open a window containing a selection of three special functions.

Included in the Plus/Premium version of MOVIE STUDIO:

Mono recording: This can be activated to record in mono. This reduces the required memory space in
half. Mono recordings are recommended for voice recordings made using only one standard mono
microphone.

Real-time sample rate adjustment: Automatically matches the sample rate of a new file to be recorded
with the sample rate of the current movie's sound track (set in the video recording).

Ducking (reducing the sound volume): To add narration or other sound material to a video that already
has sound volume levels set, activate the option "Automatic reduction of sound volume of remaining
audio tracks". This automatically reduces the volume of audio objects in the project during the recording
session ("ducking"). This is achieved using an automatically configured volume curve: Before and after
the recording other tracks will be faded in or out, resulting in a homogeneous total volume level.
(Lowering of volume level during spoken comments is also called "Ducking".)

Single frame

Single frame recording may be used to record snapshots from the connected video source. This requires
a DirectShow compatible video recording or TV card or a corresponding USB device (e.g. a webcam).

The time control function allows you to automatically take snapshots. Here are just a few examples of
where it might used:

n Create photo stories from videos
n for animation films (stop-motion recording),
n for video surveillance,
n or in time-lapse photography.

The recorded images are added to the opened project.

Video source: You may set the video card used to take pictures here.

Save image as: Enter the title of the snapshot to be recorded here. Snapshots are saved under this
name and numbered consecutively. You can also select the file path for storage.
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Recording quality: Set the resolution for the recording here. This corresponds with the resolution
options offered on the camera. Use the slider to set the image quality. Using higher resolutions results in
larger file sizes for each recording. Simply press "Reset" to return to the preset image quality.

Advanced...: Opens the video driver settings dialog.

Camera noise during recording: This causes the program to play a clicking sound each time a snapshot
is taken for monitoring purposes.

Recording controls: The red record button triggers a snapshot or alternatively a series of recordings
when using the time control function.

Time Control

Recording interval: When active, starting recording produces a sequence of images. Snapshots are
saved according to the selected time interval and numbered sequentially. For example, if snapshots are
taken every two seconds and then inserted every five frames into the slideshow, then a ten-times time
lapse recording will result.

Photo Length in Frames: Specifies how long the photos appear in the slideshow.

Advanced settings in the single-frame recording dialog

Here you can adjust certain settings for the video recording driver. These dialog boxes, so-called
"Property Sheets", come with the video card drivers. The driver-specific features may slightly vary from
driver to driver. The MAGIX team has little direct influence on the performance of the various drivers. If
you encounter any difficulties, please also contact the video card manufacturer for the latest driver
updates.

Input: Sets the crossbar of the video card. This lets you define which video and audio input signal is
used in the recording. The crossbars are connected in series to the video recording chip itself, in the
output field, the video output (for the crossbars) is the input for the recording chip (Video or Audio
Decoder In) of the video card. In the "Input" field, select the signal source that will be used by the video
card to capture for this input.
n Composite in = the regular video input (i.e. RCA jack)
n SVHS-in = SVHS input (special cable)
n Tuner In = the TV signal of the built-in tuner

Video Decoder: If the picture only appears in black & white or it flickers, the video standard may be set
to the wrong standard. In mainland Europe, PAL_B is used.

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend against changing
any of the manufacturer’s settings.

Format: Do not change anything here! The recording format settings can be changed under Resolution
in the Recording dialog box.

Screen

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.
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Use screen capturing to record everything that moves on your monitor. This process is called "screen
capturing".

Under Recording quality, you will find various presets for different applications. You can either record
the entire monitor ("fullscreen"), a frame of variable size (e.g. to film theWindows Media Player
display), or a different video player. Click "Configuration" to make custom size adjustments.

Note: Because many video players work with overlay, it is recommended to open each player before
starting the capture. This way switching into "Overlay" mode can be prevented.

Tip: Use the fullscreen presets under "Recording quality". This will use MXV format, a codec which is
particularly suitable for screen capture.

n Click the "Record" button in the recording dialog. An additional dialog with a red record button,
a black stop button as well as a frame with dashed bordering appears.

n Activate "Record mouse pointer" to record the movements of the mouse pointer.
n If desired, deactivate "Animate mouse click" if this should not be visually recorded.

n Now select the screen area you wish to record, i.e. the screen of the video player in which the
video is playing. Drag the frame over the area you wish to record and adjust its size as required
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by dragging the edges and corners.

Note: If you selected "fullscreen", the frame will appear outside the visible area.

n The actual recording process can be started by pressing the red record button. The recording
starts; the record symbol appears in the task bar (tray).

n Once the video you wanted to record has come to an end, click on the "Record/Stop" button to
stop the recording. Recording ends and the recording dialog is visible once again.

Edit after recording

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

The "Edit after recording" dialog can be opened from the "HDV Camera", "DV Camera" and "Video"
recording dialogs:

n Automatic scene recognition: This divides the footage into scenes. Please also read the section
"Automatic scene recognition".

n Automatically set chapter markers: Please also read the section "Set chapter marker
automatically".

Burn project immediately after recording: You can use this option to record and burn to a disc in a
single step. Simply select the format you would like to burn, insert a suitable blank disc into the drive,
and press record.

Note: Make sure that the selected recording quality corresponds with the disc type (for DVDs the
preset "MPEG DVD").

If you use your own settings for MPEG encoding (e.g. half image resolution for long-play DVDs) make
sure that settings for recording and later for burning are the same so that no new encoding is necessary
(Smart encoding).
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After recording, the program automatically switches to the "Burn" screen, the burn window opens and
the disc is burned. The last set layout is used for the menu layout for the DVD.

Tip: This function is particularly suitable for handling lengthy projects in one go. You can start
recording in the evening and have the finished DVD by morning.

Export for mobile device: The recorded movie is immediately converted into the format of the selected
mobile device and transferred. The preset in the list field is the device which has been selected in the
Export video/audio dialog.

Settings: Opens the Export settings for the selected target device.
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OBJECTS
In the MOVIE STUDIO timeline project window you are dealing with objects. The general term "object"
includes all media types that can be positioned on the arranger tracks. The following are all object types:

Combined objects:

Combined objects are video objects with an image track and an audio track. In the context menu, you
can add the waveform display of the audio track or set the audio track as an independent audio object.

Video objects:

Video objects include a file extension typical for videos (e.g. *.mpg, *.avi, *.mxv). Depending on the
length of the video object, you will see several frames representing various positions in your video.

Image objects:

Image objects are photos or other static images. They have a file extension typical for an image (e.g.
*.jpg, *.png, *.bmp). In contrast to video objects, you will always see only one frame.

Audio objects:

All objects that contain only sound are considered audio objects. They have an extension typical for
audio (e.g. *.ogg, *.mp3, *.wav). With a right-click you can add a waveform display to any audio object.

Title objects:

Title objects are created using the title editor and contain the text that appears in your projects. They
have no file extensions.

In the following chapter you can read about working with objects. The workflow for all object types is
the same.

Tip: You will find many functions in the object context menu, which can be opened by right clicking on
the corresponding object. There, you will also find the "Object properties" dialog, where in addition to
current settings you can also change interlace settings for the object.

Insert objects into the project

File selection in the program monitor

You can view and cut your footage in the program monitor before importing. There are various buttons
on the transport console for this. There is a preview function for most of the files in the Media Pool.
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n Use the playback button to start the preview of video or image objects in Media Pool. A preview
is also provided for special objects like titles or fades.

n Audio files from the Media Pool can also be previewed via the playback button.
Fullscreen view

n The "fullscreen" option in the context menu of the monitor enables the monitor to be
maximized. Alternatively, you can double click on the monitor or press "Alt + Enter" to
maximize it. Fullscreen view is recommended in particular for working with two screens, where
one screen displays the film preview, the other the project window and the Media Pool.

n You can also switch the monitors to full-screen mode and access the context menu (using the
right mouse button). Here, in addition to regular entries, you can also hide and display the
transport control.

n Press "Esc" to return back to normal playback.
Movie overview:

The option "Film overview" in the "Window" menu enables an overview of the entire arranger. All
objects in the project window are displayed in the program monitor. The overview display is especially
recommended for working on long movies because the reduced overview in the program monitor can
be combined well with the zoomed detailed view in the project window.

The movie overview can be used for moving around in the movie and editing specific parts:

n When you click on a particular object in the program monitor, the project window will zoom
into the object.

n When you drag on a border in the program monitor, the project window will zoom into the
corresponding area.

n When you move the playback marker in the program monitor, the playback marker in the
project window will also move correspondingly.

Importing files

Media files can be loaded to the project from the Media Pool in several different ways:

n The fastest way: Drag the file you need from the Media Pool into the desired track. If an object
is already present at this position, the file is inserted at the desired time position on the next
empty track below.

n Load several files: If you want to load several files from the folder, hold down the Ctrl key while
clicking on the entries you want to use. If you want to load a sequence of files, hold the Shift key
and click on the first entry and then on the last. All entries in between are marked. Then you can
drag all of the selected files into the project window with the mouse button held down.

n Insert by command:You can also use the commands of the "Insert modes".

n Pop-up symbol: For each entry in the Media Pool there is a two to three-part
pop-up symbol. It appears when the mouse pointer is positioned over an entry.
l Trim: If you only want to import a certain part of a video clip into your project, click

on the Trim icon with the curved brackets. The video clip will then appear in the
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program monitor. Now use the brackets to mark the area you want to import on the
timeline. Finally drag & drop the video from the program monitor into the project by
clicking on it and holding down the mouse button. Only the area previously marked
by the brackets will be imported as a video object.

l Import: Click on the Import icon to load the selected media to the project window.

Note: You can define a destination track for importing the objects. Click on the track header to select a
track. All objects you import will now be inserted into the selected track. Clicking again on the selected
destination track disables this function.

MOVIE STUDIO also loads VOB files that containmultiple audio tracks. After the VOB file loads,
simply click the audio object created and select the audio track you want.

Note: To view and select audio objects in the project, Timeline mode must be active.

Load sections from longer video files

Videos can be trimmed before being imported. To trim a video, follow these steps:

1. Select a file:
n double-click it in the Media Pool
n drag and drop files from the Media Pool into the program monitor
n click the middle icon in the Media Pool

(the icon appear as soon as the mouse pointer points to a file in the Media
Pool).

2. If you want to have an overview of the video material, first locate the edges of the range. Play
back the selected file in the program monitor and determine the range you want to use in the
project.

3. Set the range edges (in point and out point):
n Move the range edges by holding down the mouse button,
n set the range edges with the buttons

or
n set the range edges with the keyboard shortcuts I(= in point) and O(= out point).

Tip: You can also set the range edges with the keyboard during playback. This keyboard
shortcut is especially useful when setting precise positions with the shuttle and jog wheel.

4. Apply the range as follows:
n Click on the image in the program monitor and drag it into the project window by holding

down the mouse button.
n Use the Insert modes to apply the selection to the project window.

Result: An object corresponding to the selected area will appear on the track.

Tip: You can also use the insert modes keyboard shortcuts!
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If you want to load several ranges from the same video file, repeat steps 3 and 4 until all desired ranges
have been applied.

Select and group objects

To edit or delete objects using the menus, you must first select them. Click on the object. Objects will
change color to show that they have been selected.

Press the Shift key to select multiple objects. An even faster way of working is to click in an empty range
and drag out a rectangle while holding down the mouse button: this selects all objects within the
rectangle.

Any object can be combined with others to make up a group,to avoid the objects being unintentionally
moved out of relation to each other. Once they are combined, clicking on one object of a group will
select the entire group. To group or ungroup objects, use the buttons in the tool bar or the
corresponding commands in the "Edit" menu.

Tip: You can modify the color of a selected object in its context menu in order to mark it and make it
easier to locate. Right-click on an object to open the context menu, then select a color for the object.

Move objects

Hold down the mouse button to move selected objects to any tracks and positions per drag and drop. It
is recommended to place objects that belong together on neighboring tracks and create separate tracks
for audio and video objects. For this reason, videos that should overlay each other should usually be
placed on the same track.

If the Shift key is pressed, objects can be moved from one track to another, without the time position
being changed.

Cut or trim objects

see the Split and trim section.

Duplicate objects

Objects can be duplicated easily. Click on the object you want to copy while holding down the Ctrl key.
This generates a copy that you can immediately drag to the desired position or cut separately.
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Object handles

All objects can be resized using their bottom “object handles”. Move the mouse over one of the lower
corners of the object until the mouse pointer becomes a double arrow. You can now can shorten the
object until it is the length you want.

n An object can be faded in or out with the handles to the left and right upper corners of the
object. Cross-fades between different objects can be created by overlapped positioning of
objects that are fading in and out. The length of the cross-fade can be adjusted with the
handles.

n Using the transparency handle located centrally at the top of the object adjusts the
transparency of video and Bitmap objects, or the volume of audio objects. (If you move the
middle handle of a video object all the way down, the object will become transparent. If there is
no second object located on a track above it, its brightness will be reduced.)

Save objects and object groups separately

Individual objects or object groups from the arranger can be saved separately in the project folder as a
separate files. For example, cut out trailers, jingles, and so on that you need converted, and then save
them for other projects for reuse as a take.

A take file (*.TK2) contains a reference to a multimedia file or to a special object (videos, sound, visuals,
etc.) including all additional properties that an object may possess (start and end time, fades, and
effects including effects curves).

Save take

1. If you want to save several objects in one take, select the corresponding objects in the arranger
and group them.
Shortcut: G

2. Select the option "Save objects as take" in the "Edit" menu or in the context menu of the object or
group.
Shortcut: Shift + K

3. Rename the take (see below).
Save take using drag & drop

1. In the Media Pool, open the folder where the take will be saved (e.g. "My media > Recordings").
2. If you want to save several objects in one take, select the corresponding objects in the arranger

and group them.
Shortcut: G

3. Click on the selection and drag it to the Media Pool while holding down the mouse button.
MOVIE STUDIO creates a take file (*.TK2) which is named after the object in the arranger. The
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objects are removed from the arranger.
4. Rename the take.

Rename take

1. Select the take from the Media Pool.
2. Now open the context menu.
3. Select the option "Rename".

Keyboard shortcut: Alt + R
4. Enter the new name. When you do this, make sure that the file ending ".TK2" remains intact,

otherwise MOVIE STUDIO won't recognize the file as a take.
5. Press Enter to confirm the entry.

Load take

As with all objects, takes are loaded into the project.
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EFFECTS
MOVIE STUDIO offer a huge palette of diverse video effects. The video effects used most frequently
can be found directly in the Media Pool, while others can be accessed in the context menu for an object
or in the Effects menu.

Apply effects to objects

There are various methods for applying effects.

n Video and audio effect templates are loaded into the corresponding object from the Media Pool
using drag & drop.

n Effects that can be animated (in Media Pool under "Effects" > "Video effects/movement
effects") will be applied directly to the objects selected earlier, as soon as changes are made in
Media Pool.

This button resets all of the current effects settings.

Note: If you animated the effect using keyframes, resetting will affect the entire animation. Click on a
specific keyframe to select it and then delete it by pressing the Del key.

Transfer effects settings
The items video effects, movement effects, and Stereo 3D on all effects pages provide the option to
transfer the current effects settings to other objects or to load previously saved settings. Use the above
right arrow button to open the video effects menu.

Save/load video effects: The current effects settings may be saved for use later in other projects or
previously saved settings may be loaded. A dialog allows the effects to be selected.

Reset video effects: Resets the effects settings for the selected object.

Copy/paste video effects: Copies (likewise pastes) the current settings to a new object. Use the dialog
to select which settings should be copied.

Apply video effects to all: Copies the current effects settings to all objects in the project. Use the dialog
to specify which settings should be copied.
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Apply video effects to all following objects: Copies the current effects settings to all of the following
objects in the project. Use the dialog to specify which settings should be copied.

Load effects mask (additional in the Plus version): An effects mask may be loaded for a selected
object.

Customized templates in the Media Pool

Your custom effects configurations in the Media Pool can be saved and used again later. You can access
your custom configurations in the Media Pool effect dialogs by clicking on the arrow. This folder will be
empty at first because you still have to create your own configurations.

Title

Titles can be used for many applications: as a running text (ticker), subtitles, speech and thought
bubbles, to display date and time, and much more.

Create titles without a template
1. Select the object to which you want to add a title.
2. Place the playback marker at the position in the object where the title should appear.

Note: You can always change this position afterwards by dragging and dropping the title.

3. To do this, click the "Title" button in the toolbar.
4. Enter your text and click the check in the input field of the program monitor.
5. Click in the program monitor and movie the title to the position in the image where it should

appear.
6. Format the title via the title editor in the Media Pool.

Creating titles using a template
There are a wide range of title templates for fonts, opening and closing credits, captions etc. under "Title
Templates" in the Media Pool.

n Select any title template. Start a preview or add a title to a playback marker location using the
quick access feature.

Note: Templates may be applied to an existing title object. Only the text will remain when the
template is applied; all other formatting settings will be replaced by the template settings.

Dynamic titles

This category "Dynamic titles" contains standard text animations, such as flying letters which combine
to form text and wave animations which move through the individual letters of words.
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After selecting a template, you can enter text and then customize font type, font size, color and
emphasis (bold, italics, underlining).

1. From the Media Pool, select the desired title under "Title templates > Dynamic titles". Once
you've imported it to the film, you will automatically switch to the area "Effects > Title editing".

2. Adjust the text, as well as font, size, color and style in the title editor as desired.

Fade in date as title

MOVIE STUDIO is also able to insert the time and date into the image material. To do this, select the
option "Show date as title" in the video object's context menu.

If a DV-AVI file is involved (e.g. a digital recording from a camcorder), then the recording date for the
selected position will be used. If another type of file is involved, then the creation date of the file will be
used as the timecode. The title editor is then opened in order to customize the entry.

Positioning titles and adjusting frame size
n Click once on the title in the program monitor to access the positioning frame. Simply move the

positioning frame using drag & drop.

n The size of the positioning frame can be adjusted at the corners, and the size of the text will
also change accordingly. If "Adjust font size to title field" is activated, the text size will also
change.

Title Editor
You can determine the appearance of your titles in the title editor (in the Media Pool under "Effects >
Title editing").

You can customize the text properties for multiple selected text objects at once. The settings will only
be applied to the text objects you have selected. The individual properties of each text object remain
unchanged.
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The following editing options are available for selection:

Here you can enter text for your title instead of editing it directly in the
program monitor.

Title Object

The left button vertically centers the title object on the monitor; the right centers it
horizontally.

Delete: Deletes the selected title object

Use the arrow keys in the title editor to move from one title object to the other without having
to search in the project window. Captions are not included in this.

Font

Here you can determine the font type and size of the title. If you click on the small arrow next to the font
size, you can change the font size using a smooth slider.

You can set format properties in the toolbars below.

Bold/Italic/Underlined

Left-aligned/Centered/Right-aligned

Shadow

Transparency: Controls foreground transparency levels.

Soften:Makes the edge of the shadow harder or softer.

Outline

Width: Enter the width of the frame in points.

Filled in: The text will be filled with the color selected in the Title Editor. If the option is deactivated, only
the frame will be visible, and the background will appear instead of the color fill.
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3D

The text appears with a 3D-style outline. The width and thickness of the 3D contour (H) can be set in
points.

Font color

Line spacing: Cannot be applied to only one line. When applied to multiple lines, this alters the
spacing between the lines. Line spacing always applies to the entire line.

Tracking: Controls the spacing between characters. Negative values move the characters closer
together, positive values move them apart.

Animation

Here you can set four movement directions to move the title on the image. You can also set any course
of movement. See Working with Keyframes for more information.

Other text settings

Automatic text break: Separates text automatically when the end of the text field is reached.

Note: The result will be seen once you have confirmed the entered text by ticking next to the selection
box or by pressing the Enter key.

Adjust font size to title field: Changes the font size according to the text field size. You can activate or
deactivate this option temporarily by pressing the shift key while dragging the text field handles.

Only apply visible TV area: The text will be zoomed so that it will always be within the TV's screen
area, which is specified in the Movie effect settings.

Notes on background color

To add background color for text with no other video or image objects as background, click "Background
design" in the context menu for the text object.

Timecode
Under "Templates > Title templates" in the "Timecode Basic" section, you will find various presets that
you can use for displaying the timecode. This function adds a special timecode object to a free track
under the video object.

You can adjust the position of the timecode by moving the timecode object in the program monitor. The
handles on the borders can be used to adjust the length.

The following times will be displayed in the various templates:

n Movie time: The time position in the MOVIE STUDIO project window.
n Recording date/time: The date and time when the footage was recorded. This timecode

information must be saved in the video, otherwise the display will be empty.
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n Recording timecode: The timecode for the video that is created by the camera. This timecode
information must be saved in the video, otherwise the display will be empty.

Note: If the recording date/time and the timecode are not saved in the source material, only
placeholders in the form of "-" will be displayed.

Video effects

The video effect you require can be opened in the Media Pool regardless of the selected object. The
corresponding image is displayed at the position of the playback marker in the program monitor. To see
the impact of the effect settings, you must always set the playback marker to the position where the
selected object is located. The playback marker also enables you to jump to a specific position in the
video object in order to check the results of the effects by starting and stopping playback.

Brightness and Contrast

Auto-exposure

With this button you can automatically optimize brightness and contrast with a click. Use the fader in
the dialog for finer adjustments.

Brightness/contrast: Use the sliders to increase or reduce the brightness and the contrast of the
picture.

Gamma: Set the mean gray value that can be calculated from the various color ranges. In the preset list,
you can select different areas to edit only the dark, median, or brightest areas of the image.

Using the fader, you can also set the level of brightening or darkening.

HDR Gamma: Unlike "Gamma", very dark areas are selectively lightened.

HDR Blur: This changes the transition between light and dark areas together with "HDR Gamma".

Note: The functions HDR Gamma and HDR blur are only available in the Plus/Premium version of
MOVIE STUDIO.

Color
Saturation: Use the saturation slider to increase or reduce the hue proportions in the image. A newly
developed algorithm is applied which makes color changes related to other parameters (for example
contrast settings) in order to achieve the most natural coloration possible. With some experimenting,
you can achieve some amazing results – such as turning summer images into autumnal pictures, or
creating funky pop art...

White balance:A n incorrect white balance can lead to an unnatural blue or red hue. To use the white
balance, click on the "White point" button and then select a point which represents white or a neutral
gray to the "outside world". The color temperature is then corrected automatically.
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Tip: Interesting color effects can be achieved by setting a color other than white. There is definitely
room for experimentation!

Color: Select a color for coloring the image from the color chart.

Red/Green/Blue: Changes the color portion mix.

Red Eye removal: Using this photo function you can remove unnatural red eyes that are the result of
using a flash. Click on the eye symbol and then select the red pupils in the preview monitor using the
mouse.

Color correction

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Secondary color correction allows individual colors in video and image objects to be adjusted. The two
layers, the front and background, are separated from each other using a mask. Both can be edited
separately. The master layer may also be used to influence the overall image.

The foreground layer corresponds with the mask created, and the background layer with the rest of the
image. This is how you can create a mask for the background:

n Activate "Add".
n Place the mouse over the program monitor. The mouse pointer turns into a pipette tool.
n Click with the pipette tool on the color or color ranges in the program monitor that you would

like to assign to the mask. Unwanted colors can be removed from the selection again by
selecting "Remove" and clicking the corresponding color again.

MOVIE STUDIO displays the mask in black and white stripes to highlight the current selection.

n Adjust the color using the color selection slider until it is satisfactory.

Chroma key
This section contains the effects for chroma keying used to mix together two videos into a foreground
and background.

Note: The background video must be placed in the track above the foreground object. E.g.: Track 1:
Background, Track 2: Foreground

Mode

Stamp: The currently selected object is "stamped" onto the video on the track above the object. This is
only possible if the bottom video takes up only a part of the image. Otherwise only the bottom
(currently selected) video would be visible. Normally, the object should be reduced or moved first. This
is done with the help of "Position/size" effect or via the submenu "Section" in "Effects -> Video object
effects".
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Color: In the program monitor, drag the cursor over the color that should be transparent and select a
section. The video is made transparent in the sections with this color and the video on the top track will
show “through”. You can use the "Threshold value", "Transition area" and "Antispill" controls to fine-
tune your results, e.g. to remove reflections of hidden colors on surfaces or to sharpen the transitions to
objects.

Mix: This button mixes the two videos together based on their brightness. Brighter areas accumulate
and quickly appear white; darker areas have less of an effect on the result.

Colors to be hidden

Green/blue/black/white: All green/blue/black/white areas of the video below appear transparent.
This makes it possible to "place" a person who has been recorded in front of a blue background into any
type of landscape.

Water: Only the contours of the upper video are mixed, which results in something like a water effect..

Alpha: This video effect uses the brightness of a video to control a cross-fading effect between two
other videos on neighboring tracks. The additional videos should be situated directly above and below
the alpha-keying object.

In all black parts of the alpha-keying object, the top video is faded in, while in all white passages the
bottom video is shown. Gray passages are permeable for both videos and create a mixture of the two. In
the case of colored passages, the brightness of the color is used for control purposes.

Video level

Changes the brightness of the video before additional video effects are applied. This can have a serious
influence on the effects, in particular on Chroma keying. The level setting may be automated so that two
videos can be mixed dynamically with each other. Read more about this in the chapter "Animating
objects".

Anti-spill

Smoothes edges in order to minimize artifacts.

Artistic filter
Erosion: The image is broken-up by means of small rectangles and resembles a "patchwork".

Dilate: Similar like Erosion, but uses light surfaces instead of dark ones to form the rectangle.

Emboss: Creates a relief of the image edges, in which case strong contrast differences are interpreted as
edges.

Substitution: Parts are exchanged using the rainbow spectrum red, green and blue. Quickly create
surreal landscapes and green faces.

Shift: The color values are inverted increasingly. Blue colors turn red, green ones appear purple.

Quantize: Depending on the setting, colors are either rounded up or down so that the overall number of
colors is reduced. This creates grids and patterns.

Color fill: Using this slider, color in the video with red, green, and blue colors (the basic TV colors).
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Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is possible to select either
vertical or horizontal contours.

Distortion
Motion: Moving parts of the image are enhanced and warped.

Echo: The moving images create an optical "echo"; previous images stand still and gradually turn paler
until they completely disappear.

Whirlpool: The image is twisted into an "S" shape.

Fisheye: The perspective is distorted as if the image were viewed through a fisheye lens.

Mosaic: The video is depicted as a mosaic.

Lens: The image is dynamically distorted at the edges.

Sand: The image is depicted in a granulated manner.

Kaleidoscope: The left upper corner is mirrored horizontally and vertically.

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it appears on its
side or upside down.

Sharpness
Sharpen: This fader allows you to increase the sharpness of the image.

Blur: This fader allows you to reduce the sharpness of the image, making it blurry.

n Apply to: This allows you to set just how much the sharpness or blur should be applied to
surfaces or edges. This enables you to effectively reduce ongoing image distortions (noise).

Artificial blur: Here you can blur the image in an alternative manner. The achieved effects are much
stronger compared to simply sliding the "Blur" fader.

n Quality: Enhances the artificial blur.

Tip: Artificial blur is useful for creating transitions. To do so, you can animate the first video so that it
is strongly blurred and let the second video begin with blur and slowly return to normal focus.

Note: The higher the quality of the effects, the longer the calculation will take.

Speed
The playing speed can be adjusted with the slider control. The range between 0 and 1 plays the video
slowly; values above 1 accelerate playback. If the playing speed is increased, the object length in the
project window is automatically shortened.

Frame rate: Here you can set the video's frame rate directly. Changing it directly affects the speed
factor, while moving the slider conversely results in changing video frame rate.
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Algorithm: Here you can determine how to adjust the soundtrack. "Timestretching" changes the
playback speed, without influencing the pitch: "Resampling" changes the playback speed together with
the pitch (the faster the playback, the higher the pitch).

Reverse playback:With this button the playback direction will be reversed (with the same tempo).

Interpolate intermediate frames: Activate this option if your video lags as a result of being slowed
down. MOVIE STUDIO then automatically fills in missing frames so that your video can be played back
more smoothly.

Maintain length: If you shorten an object in the arranger, you can play a video faster without reducing
the object length. The shortened footage is used to maintain the object length.

VEGAS Video Stabilization
Video stabilization "VEGAS Video Stabilization" smoothes out undesired frame movements by negating
inadvertent movements in the image. This produces unusable edges in the footage that can be
automatically cropped off by zooming into the picture. The result: A more stable picture at a nearly
imperceptibly increased zoom level.

"VEGAS Video Stabilization" can be found in the Media Pool under "Effects > Video effects".

n Mark the object in the video, which should be stabilized, and click "Apply effect".
n Click "Analyze Motion" to start the analysis. This process requires some time. When the

analysis is complete, the stabilization is automatically applied to your media.

If you are unsatisfied with the overall result, click and the video will be played back in its original
form.

Shot match

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

This function lets you match the appearance of two video clips to each other. The colors and tonal
values of two separate photos are aligned fully automatically.

You can do this in the following way:

1. Open the "Shot match" effects area in the Media Pool under "Effects" > "Video effects".
2. Select the object where you want to match a shot ("target") and place the playback marker

within this object at the shot that you want to change.
3. Click "Select target frame". The selected position will be displayed.
4. Place the playback marker in the arrangement at the position with the look you want to use

("reference").

Note: Make sure you don't change the object that is selected! You need to keep the selection on the
target object.
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5. Click on "Select reference frame". The selected position will be displayed.
6. Click on "Match shot" to adjust the look of the object. The playback marker automatically jumps

back to the modified target object.
7. You can reduce the strength of the effect by moving the "Intensity" slider.

Shot match works best under the following conditions:

n The same scene has been filmed with multiple (different) cameras from various perspectives.
n The same scene has been filmed in different lighting conditions.

Different conditions can lead to suboptimal results.

A note on multiple selection: Selecting multiple objects will apply the effects of shot match to all
selected objects.

Stamp forms
Apply the "Stamp forms" effect to punch simple geometric shapes and create picture-in-picture effects
in a video.

n Click on »APPLY EFFECT« to activate the Open FX plug-in.
The selected object will be punched in circular form as default. You can also customize these
presets the way you want.

Color: Use the values r, g and b for red, green and blue to set the colors for the borders (only visible
when borders > 0).

Shape: Select a shape in the drop down list to define the cut form.

Methods: Specify whether part of the video image is visible/masked:

n Cut everything apart from section: The cutout shape forms a window which displays your
video.

n Cut section: The cutout shape covers your video and the area outside the shape is visible.
Feather: Drag the slider to determine how smoothly the cutout border fades into the background.

Borders: Drag the fader to determine the size of the frame around the cut shape.

Restore X/Y: Drag the slider to repeat the cutout shape along the horizontal axis by the number of
times specified.

Size: Drag the fader to determine the size of the cut shape selected.

Middle: Drag the slider to set the center of the cutout within your project's video frame: 0.00, 0.00
represents the lower-left corner of the frame, 0.50, 0.50 represents the center, and 1.00, 1.00
represents the upper-right corner.

Gaussian Blur
This alters the apparent focus of the video, blurring and softening the appearance. It can also be used to
smooth out some types of noise and can also be used as a corrective filter.

n Click on »APPLY EFFECT« to activate the Open FX plug-in.
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Horizontal range/Vertical range: Drag the slider or enter values in the editing fields to specify the
number of pixels in a block.

Color channels: Select individual color channels (Red, Green, Blue or Alpha) to which you want apply
blur. If the video or image has an alpha channel, basing the blur on that channel can sometimes improve
transparency and mask blending.

Glow
This effect produces a halo effect around bright image objects.

n Click on »APPLY EFFECT« to activate the Open FX plug-in.
Glow percent: Changes the quantity of light emitted (similar to Blur effect) Light intensity, Effect
intensity, and Suppression all work together. Adjust the settings to get the desired effect.

Intensity: Sets the intensity of the glow color.

Suppression: Drag this to reduce the glow so that it can only be used for highlights.

Color: Use the values r, g and b for red, green and blue to set the colors for the glow effect.

Lens reflection
Apply the "Lens reflection" effect to simulate the light reflected by a camera lens.

Light color: Set the color value to which you want to apply the effect.

Light position: Set the position of the light source that creates the Lens Flare effect.

Lens type: Click on a lens in the drop down list to select the number of light flares to be created.

Tint: Drag a fader or enter a value in the field to set the strength of the tint that will be applied to the
light source.

Intensity: Drag the slider or enter a value in the field to set the strength of the effect.

Blend: Drag the slider or enter a value in the field to set the transparency for the light flare effect. a
setting of 0 is completely transparent; a setting of 1 is opaque.

Size: Drag the slider or enter a value in the field to set the size of the light flare effect.

Perspective: Drag the slider or enter a value in the field to set the angle of the light flare effect.

Mask Generator
This effect lets you create a mask from any video or image. The video or image is converted to gray
scale and made partially transparent. Brightness (Luminance), one of the color channels red/green/blue
or an alpha channel (for image files in PNG or TGA format) can be set under Type as an information
source for transparency.

n Click on »APPLY EFFECT« to activate the Open FX plug-in.
Invert: Reverses transparent and opaque areas in the mask.
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Low in/High in: Lets you determine a range between the minimum and maximum brightness values for
the source (independent of type) for which the image/video will be opaque. If both values are the same,
the mask created will have hard borders (threshold value), whereas if the second value is higher, a
graduated fade will appear at the mask borders.

Low out/High out: Lets you set the minimum/maximum transparency value. If lows are increased in
value, the entire image will become brighter (less transparent)

Note: 1.0 corresponds to maximum white, therefore maximum opacity.

Standard
Pre-configured effect combinations for direct use can be found here.

Position and animation effects

Size/Position/Rotation

With this effect, you can edit the size, position and rotation of an object (e.g. video, image, title, etc.) in
space.

You can also adjust the resize and reposition the object using the handles in the program monitor
visually:

n the red handles control the width

n the yellow handles control the height

n the gray handles in the corners can be used to adjust both simultaneously

If you want to work using the anchor point, first move the anchor point before changing the position or
rotation.
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Size

Here you adjust the size of the selected object.

Movie size The object will be scaled to the size of the movie.

Original
size

The object will be displayed in the original size.

Width and
Height

Using the input button, enter an absolute size (px) or relative value (%) for the width
and height. The relative value refers to the footage size, the absolute size refers to the
size of the object.
Click the units to switch between pixels and percentage.

The object will be reset to the original size.

Combine
input fields

Enable this option to retain the aspect ratio of width and height.

Scaling in any direction is always performed with relation to the anchor point. If you compress or stretch
the element, the area on top of the anchor point will not move.

Location
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Horizontal/Vertical These values can be used to move the object in relation to its anchor point.
Enter an absolute size (px) or relative value (%) to specify the position of the
anchor point. The object moves in relation to the predefined anchor point.
Click the units to switch between pixels and percentage.

The object's position is moved so that the anchor point is reset to 0 and
centered horizontally or vertically in the center of the movie.

This button can be used to easily adjust the object per click.

The object is positioned in the respective corners of the
movie.

The object is positioned on the left or right edge of the movie,
but its height is fixed.

The object is positioned on the top or bottom edge of the
movie, but its width is not changed.

The object is positioned in the middle of the movie.

To visually adjust the position, click on the object and drag it with the mouse to the desired position.

When the object is moved, the anchor point is also moved.

Rotation
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The layer in which the element is situated may be rotated on three spatial axes (X, Y, Z). The anchor
point also serves as the center of rotation. The angle of rotation can be adjusted directly by the three
control elements or entered in the fields using degrees (°). The set rotations are applied one after the
other. The order used can be set in the selection field. This might be necessary in certain situations, e.g.
if you specify more than one rotation or want to rotate around more than one axis.

Anchor point

Using the anchor point, you can select and move the rotation point (center point) of an object freely.
The anchor point functions as the reference point for all three operations.

Horizontal/Vertical Enter an absolute size (px) or relative value (%) to move the object in relation
to the anchor point. The position of the anchor point will remain unchanged.
Click the units to switch between pixels and percentage.

The anchor point is reset to 0 horizontally or vertically. The position of the
anchor point remains unchanged. The object will move so that it is centered
horizontally or vertically at the anchor point.
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This button allows you to easily align the anchor point on the object with one
click. In contrast to entering values, the anchor point moves and the position
values will change. The position of the object remains unchanged.

The anchor point is positioned in the respective corners of the
object.

The anchor point is positioned on the left or right edge of the
object, but its height will not be shifted.

The anchor point is positioned on the top or bottom edge of
the object, but its width will not be shifted.

The anchor point is positioned in the center of the object.

The values in the number fields can also be changed by dragging them vertically with the mouse.

Section

Sections may be used to display only a part of the photo or video.
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Specifying sections

1. Select the object in the project window.
2. Set the aspect ratio (see the Drop-down menu (⇗124)).
3. In the program monitor, drag out a frame and adjust it using the eight handles. The frame can be

changed depending on the set aspect ratio.
4. Move the frame to the location you want.
5. You can adjust the size and position of the section using the input buttons if necessary.

Preview With this button you can preview how segment will look like in the movie. Click on this
button a second time in order to keep editing this segment.

Movie size The section will be adjusted to the size of the movie. This way if your raw material is, for
example, in 4K quality, you will get a section in top HD resolution.

Drop-down
menu

In this menu, you can select the aspect ratio for the section. By default, the aspect ratio
of the original object is used as default (»LIKE SOURCE«).
n Like movie

The aspect ratio of the movie is used to crop a section.
n Same as source

The aspect ratio of the selected object is used to crop a section. If the object's
aspect ratio differs from that of the movie, a black border is displayed in width
or height.

n Free proportions
You can freely choose the width and height of the section.

Fullscreen If this check box is selected, the section will be zoomed to fullscreen. If this option is
deactivated, only the section of the object within the frame will be displayed and the
edge will remain black or filled with the object behind it.

Opens a menu with additional options
Apply effects to objects (⇗107)
Create effects masks (⇗143)

Resets the current settings.

Camera/Zoom Shot
With this effect, you can move a previously selected frame inside the image, creating an impression of
camera movement or zoom.

Direction of movement

Determine the direction in which the selected section or image will move during the time selected under
"time period". In addition to horizontal and vertical movements, diagonal movements are also possible.
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Preview: Displays a preview of the section at the playback marker location.

From section: The selected picture section is displayed and is then zoomed out to display the
entire picture according to the time set in "Duration". If no section has been previously cropped, a
central section of 50% of the picture is enlarged for cropping.

To section: The entire picture is displayed and then zoomed in to show only a smaller picture
section according to the time set in "Duration". If no section has been previously cropped, a central
section of 50% of the picture is enlarged for cropping.

Direction and time

The option selected here sets the position where the keyframes of each movement effect are set by
default. You determine the positions for the start and end of movement.

Note: The automatically set keyframes can be edited, then the option will be set to "User defined".
Read the section "Change the keyframes of an effect after the fact" in the chapter "Animate
objects".

Reset: This button resets all of the current settings.

Orientation/Horizon

Straighten horizons

The image can be rotated around the axis using the slider. The image is automatically zoomed to avoid
black edges.

Show guidelines: Activating this check box displays a grid in the program monitor for orientation during
horizontal straightening.

Zoom automatically: This function is preset to active. Unwanted black borders that result from horizon
straightening are eliminated by zooming in on the image.

Note: If the image format does not completely conform to the current movie format and already has
black borders, these cannot be eliminated with the horizon straightening function.

Rotate/Flip

Mirrors the image on the vertical axis.

Mirrors the image on the horizontal axis.
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Rotates the image 90° clockwise.

Rotates the image 90° counterclockwise.

Rotate image on monitor

In addition to the settings options in the Media Pool, you can also rotate a video object directly on the
monitor.

To do this, move the upper middle handles that are located within the monitor image.

Lens Correction
With the lens correction you can remove image distortions caused by certain lenses. Even "converging
lines" can be easily straightened. Here is an example:

Original and picture after lens correction

Setup

Lens: Affects the curvature of the image

Section/zoom: Corrects the black edges that appear around the image when changes are made to the
"lens" parameter.

Automatic: Automatically sets the "Section/zoom" parameter to remove black edges caused by
changes to the "lens" parameter.

Note: Manually changing the "Section/zoom" parameter will automatically deactivate this.
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Perspective: Strongly upward or downward facing image material often contains distortions which are
unnatural for the human eye and causes so called "converging lines". This parameter balances out these
distortions, allowing images with "converging lines" to appear more natural.

Tip: The lens correction parameter can be animated. This is particularly useful in videos where the
perspective changes, causing, for example, converging lines to also change over time.

3D Distortion
This enables the perspective of images to be distorted and moved. This produces a 3D impression by
causing several components of the image to appear further in front of others.

Enter the individual corner points numerically or move them in the program monitor using the mouse
here.

Note: Unlike Stereo3D, this does not involve genuine 3D positioning. The image is only distorted so
that it appears three-dimensional on a normal two-dimensional monitor.

Movement Templates
This is where you can find finished templates for movement effects that can be applied to objects.

360° videos

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

In a 360° video, the action is recorded in all directions simultaneously. 360° video can be shot with
special cameras that contain two 180° lenses, or by creating an array of several normal cameras to
record in different directions. In the simplest array, there are two cameras with super wide angle lenses
that record in two directions; better setups use six or more cameras.

The result is that the viewer can view "around" him or herself by determining the view direction. To do
so on a PC, drag the mouse during playback. On mobile devices, the built-in orientation sensor can be
used: The view direction follows the device's rotation. In combination with VR glasses or a smartphone
attachment such as Samsung Gear VR or Google Cardboard, it is possible to be completely submerged
in a virtual environment with a 360° video.

360° videos are supported by the most important video platforms like YouTube, Vimeo, and Facebook.
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Technically, 360° videos are regular, two-dimensional videos. The images of the sphere surface around
the camera are displayed distorted, similarly to how the earth's surface is projected onto flat maps of
the world. This results in relatively large videos in order to provide enough resolution along the strongly
distorted edges after rectification.

Preprocessing/Stitching
Stitching describes the process of combining images from individual cameras to create one, large image
and projecting the spherical image onto the rectangular surface of the video. While more advanced
cameras can perform their own stitching, most simple cameras with only two lenses create a video
which needs to be stitched together to create a true 360° video.

Unstitched video image from two 180° fisheye lenses on a 360° camera

These cameras often also include stitching software, but the more elegant solution is to perform
stitching directly in MOVIE STUDIO. The stitching feature is located under the Effects tab in the 360°
video section of the Media Pool.

Select the video object and effect, then click "Apply effect". The video should look like this in the video
monitor:

For standard 360° cameras with two lenses, there are presets located in the list field above. For other
camera models, you can change the parameters below.

Note: MOVIE STUDIO normally recognizes 360° video material in need of stitching and
automatically applies the effect.

360° editing
There are two ways to work with 360° in MOVIE STUDIO:
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1. Creating a 360° video from your 360° output material and adding content (videos, images and
titles) and effects to it, or

2. adding your 360° content to a normal video and specifying the display section and direction of
view.

The editing features for both scenarios are available under 360° video under the "Effects" tab in the
Media Pool. The editing mode which makes the most sense for the application scenario in question is
automatically displayed under 360° editing.

Creating a 360° video

MOVIE STUDIO automatically switches to 360° mode when you load 360° material (a prompt will
appear). The program will also automatically perform any necessary stitching (see below).

For these types of videos, the video monitor is switched to a special 360° mode which straightens the
image and allows you to move the direction of view using your mouse. (You can get to 360° mode by
going to the menu located in the upper left-hand corner of the program monitor.)

If MOVIE STUDIO does not automatically recognize your 360° video material as such, you can
manually switch to 360° mode by going to the movie settings and selecting a corresponding video
preset (360°...) at the bottom of the list.

You can cut this video and apply effects as you would a normal video in MOVIE STUDIO. But bear in
mind that most effects in the View/Animation section will remove the 360° effect.

Note: Automatic recognition currently only works for Ricoh (Theta m15, S and SC) and Samsung Gear
360 models and for 360° projects you have exported yourself.

Adding content to 360° Videos

Position object in 360° space editing mode

To add content to a 360° video (e.g. floating titles), proceed as follows:
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1. Place the play cursor where you want the title object to appear.
2. First create the title object.
3. Select the object and switch to the 360° editing effect in the Media Pool.
4. Activate 360° editing (1)
5. In the video monitor in 360° mode, use the mouse to set the view to the position where you want

the title to appear.
6. Click "Orient to perspective" (3) to place the title precisely in the direction of view. Use

perspective (4) to specify the distance between the title object and the viewer.
7. To make the title fly in and out, you can apply a keyframe animation to the perspective and

orientation parameter (2).

Video monitor in 360° mode, with a 3D title object added to a 360° video

Adding 360° content to other videos

"Select section from panorama" editing mode

To add 360° videos or photos to a normal video, proceed as follows:

1. Load the 360° video or photo. If a message appears asking if you want to switch to 360° mode,
select "No" — we do not want to create a 360° video, we simply want to add 360° footage to a
normal video.

2. Select the object and activate 360° editing (1).
3. Use "Orientation" (2) to define the direction of view. It's also possible to simulate a camera pan

through three-dimensional space by animating these parameters and the viewing angle (4) using
keyframes.

4. The "Camera angle" (3) is preset to 360° for 360° videos; for panorama photos with a lower
camera angle, you can check the box and set the camera angle to a different value. You can try to
get close to the "exact" value by eyeballing the effect and adjusting the angle correspondingly.
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5. "Perspective" (4) specifies how much you want to zoom in or out.
6. The remaining parameters can be used to correct distortion: "Super wide angle" (5) widens the

perspective beyond the maximum permitted angle of 180° all the way up to 360°. This lets you
turn panoramas into eye-catching mini-planets. The fisheye lens ("fisheye"6) distorts the
perspective. If an image already contains distortion as a result of a wide-angle shot, the fisheye
effect can be used to correct this. For instance, a curved horizon can be "straightened".

360° scene rotation
This effect rotates the entire 360° scene along all three spatial axes. This allows you to make
corrections if the 360° camera was upside down or crooked during filming.

Stereo3D

MOVIE STUDIO enables the editing and creation of "genuine" 3D videos and photos. First, let's create
an overview of this complex topic by familiarizing ourselves with the most important principles and the
golden rules that are involved. Next, we'll look at the individual steps of the workflow in more detail.

Note on using 3D content: Some people experience unpleasant symptoms (e.g. headaches,
overexertion, eye strain or nausea) when they are exposed to 3D video. We recommend taking regular
breaks for this reason. In case of problems, the user should immediately stop use and refer to a doctor
or optometrist. Incorrect production of 3D content may also produce these symptoms.

Warning for small children: The eyesight of small children (especially those younger than six years
old) is still developing. We recommend referring to a doctor or optometrist prior to allowing your child
to view 3D videos.

The basics
Human eyes perceive objects from two different angles, and our brain calculates an image using this
information. This enables us to recognize the distance and position of an object. That's any 3D material
that we want to process should be recorded according to this scheme.

Viewing 3D

A conventional canvas or a simple television is only able to display images in two dimensions, which is
why different techniques have been developed to project images in 3D. All of these techniques have one
thing in common: special glasses are required in order to display the left and right eyes different
information. We will examine these technologies in detail later.

The three golden rules

n Maintain limits during recording: In order to retain a 3D recording with natural depth
information certain limits need to be maintained. The most important rule is not to go below
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the so-called "point of minimum distance". The minimum point is the point in the picture at
which the camera may be closest.

n Frame around minimum point: To create a 3D effect behind the dead window, both title
images must be moved exactly over each other at the location of the minimum point.
Simultaneously, the same objects must be visible at the edges of both spatial images; if needed,
you may use the cropping function in the Media Pool to do this.

Note: The dead window it a theoretically perceived sort of screen, behind which the 3D film is played
back to the audience. This marks the closest point, i.e. the foremost point. If this rule is not adhered to,
the object seems to "jump out" of the imaginary window, and this may cause headaches if it is
excessive.

n Observe natural viewing direction of eyes: Objects featuring 3D depth effects as a red/cyan
image (anaglyph) that are viewed without glasses may be perceived as offset. This
displacement should, if possible, take up less than 1/30 of the entire image. Otherwise, it will
appear that the eyes are looking in different directions.

Note: This offset may only take place on the horizontal access. Displacements on the vertical axis and
rotated portions must be adjusted to each other!

Record 3D
The distance between eyes in humans is ca. 65 mm, which forms the so-called "stereo base width". But
because our eyes are dynamic and we can even "cross" our eyes, it is possible to focus on objects that
are closer.

Various techniques exist for 3D recording. Each method has its advantages and disadvantages:

n 3D cameras with two lenses: The advantages are easy to see – these cameras deliver 3D
material without much effort. The disadvantage is that the stereo base width (lens distance)
cannot be changed.

n Two cameras on a special mount: This involves a little more work. Two cameras are mounted
on a special support to record material for the left and the right side of the 3D image
simultaneously; microphone booms for stereo recordings may also be used for this purpose.
The disadvantage in this case is that the shutter releases have to be pressed at exactly the
same time if there are moving objects in the picture. In case of video, both movies must be
synchronized before being edited. Advantages: Stereo base width may be changed by adjusting
the distance between the cameras; larger selection of camera models.

n Two photos via the same camera: This technique only allows still images. The camera is
simply used to record two images from different perspectives, and these are used as the right
and left images. For best results, use a tripod.

n Consistently fast camera movement, e.g. along a street: Only a single conventional camera is
required in this case, but the range of applications is very limited. This is the most cost-effective
method for creating 3D videos. Material is filmed at a speed of circa 6 to 15 km/h. During
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editing, the edited video object is duplicated and one of the videos is played back with a time
lapse. The movement direction determines which is the right and left image. 3D still shots may
also be created using this method.

Warning, minimum distance!

The position of the object closest to the lens or lenses is designated as the minimum point. This
minimum point may not exceed a specific minimum point; this is easy to calculate via the following
formula:

Note: Lens focal point (e.g. 25 mm) x stereo base width (e.g. 65 mm) x 1.5* /1 mm** = minimum
point (2437.5 mm ~ 2.44 m)
*1.5 is a factor derived from the cut-off appearing when filming through a lens.
**1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough value in this
case.

Examples for 3D cameras:

Panasonic HDC-SDT750 (base width 12 mm): Minimum point is approx. 1.5 m.

Fuji REAL 3DW3 (base width 75 mm): minimum point at approx. 3 m; for long-distance recordings as
much as 8 m.

This so-called minimum point has an important role in other aspects of 3D editing.

Prepare for 3D editing
3D videos are recorded and saved differently by the various cameras, which means that depending on
the camera model or recording method, videos and images will be present in different forms.

In one file

Many cameras, especially for photos recordings, create one single file containing the left and the right
image next to one another.

n Drag these files from the Media Pool directly into your arrangement.
n Select the created objects.
n In the Media Pool under "Effects -> Stereo3D -> Properties -> Create stereo", select the entry

"Side-by-side (left image left/right)" for material at half-width.

Note: If you have created side-by-side material yourself (e.g. two photos arranged next to each other
in a single image file), then continue as described, but select the entry "Side-by-side (left image
left/right)" finally for material at full width.

In multiple files

Some 3D cameras create one file for each the left and the right side. In case you just take two photos
from different perspectives with a conventional camera, the process functions the same way.
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n In the Media Pool, open the folder that features the desired files.
n Sort the files in increasing order according to the date. This way, all files will lie in pairs one

below the other.
n Now, select the files and drag them from the Media Pool directly into your arrangement.
n Now select all newly created objects in the arrangement.
n In the Media Pool under "Effects -> Stereo 3D -> Properties -> Create stereo" create "Stereo 3D

pair left/right image first".

3D mode Technology Requirement

View partially interlaced Polarizing filter

Shutter output Shutter mode

Side-by-side display Side-by-side

Anaglyph display Color anaglyphs

Turn camera movements into 3D videos
Camera movements may be transformed into 3D videos by being duplicated and converted via time
displacement. To do so, you can simply record on the right or the left side while, for example, driving
along a street.

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the frame rate, the
focal point, and the distance of the objects being filmed (among other things). At increased speeds, it
may occur that the spatial impression is too strong and the filmed material seems unnatural and
unpleasant.

n If the video is in the arrangement, the stereo depth for the 2D object may be set in the Media
Pool via "Effects -> Stereo 3D -> Properties".

n Depending on the direction of the recordings, you will have to move the control either to the
right or the left.

n Check the results in the anaglyph display with red/cyan glasses
n Correct any unrealistic effects by adjusting the controller in the opposite direction.
n If the spatial depth is exaggerated, reduce the changed parameters.

Note: Not only camera movements, but also other 2D materials may be arranged spatially.
3D material may be edited with the same functions as 2D material.

Export and burn 3D videos
There are no special requirements for export and burning. Only the desired 3D technique is specified.
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Anaglyph: This technique is recommended for uncomplicated playback of finished videos or playback
with conventional TV sets or projectors. Viewers must simply put on a pair of red/cyan glasses to be
able to enjoy a 3D movie.

Side-by-side: Create 3D movies for a 3D-capable playback device without having to compromise the
quality. It doesn't matter initially whether your video is viewed in "Shutter" mode or in "Polarized filter".

n Depending on your playback device, you should set double resolution in order to produce full
resolution for both the right and the left image.

n Not all playback devices are capable of double resolution. If this is the case for your device,
50% pinched images will be displayed. The quality is nevertheless higher than output using the
anaglyph technique.

Only left/right side: This settings exports only one side of your 3D video instead of the entire video.

Lenticular image: This allows you to view 3D footage without 3D glasses. The footage is displayed
interchangeably to give the impression that it is wiggling or shaking.

Superimposed: This export option is similar to „Side-by-Side“. The images are superimposed during
output.

n Depending on your playback device, you should set double resolution in order to produce full
resolution for both the upper and the lower image.

n Not all playback devices are capable of double resolution. If this is the case for your device,
50% pinched images will be displayed. The quality is nevertheless higher than output using the
anaglyph technique.

Exporting files

The standard path for all file exports is "File > Export". Depending on the export format and destination,
the export dialog also allows the 3D technique to be used to be selected.

Burning

When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the burn dialog and
set the desired 3D technology. Next, you may proceed to burn the disc as usual.

Audio effects

Audio effects in the Media Pool
The Media Pool offers various creative options for adding effects to audio objects. Another advantage of
these "object-oriented" effects is that the effect settings, including automations are moved
automatically with objects when they are moved, since they are attached to the object and not to the
track itself.
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Under "Effects" > "Audio Effects" > "General" you'll find other audio effects besides volume and
panorama, including DeClipper, DeNoiser, DeHisser, equalizer, compressor and StereoFX (these are all
contained in the Audio Cleaning Editor), echo/reverb, timestretch/resample, a sharp filter, a soft filter
and distortion.

The faders AUX 1 and AUX 2 control the volume at which the object's signal is sent to the
corresponding FX tracks in the mixer.

Note: Volume and balance curves are also present in the track. The set values of the curves add up
respectively.

Audio effect presets

In the Media Pool you'll find a broad palette of effect settings which you can apply to audio objects via
drag & drop.

Using audio effects

Object effects

Individual, customizable effects or preset effect templates are also available for audio objects. These are
only applied to the corresponding, selected object. These effects can be found in the Media Pool under
"Effects" > "Audio effects" or in the menu under "Effects" > "Audio object effects".

Track effects

Track effects always apply to all audio objects of a track. They are set in the mixer. Open the Mixer
using the »M« key.

Audio effect plug-ins

MOVIE STUDIO (only Plus/Premium version) supports VST effect plug-ins. These are usually effect
modules such as reverb, equalizer, dynamic compression, etc.

Installation:

The relative plug-ins must be installed before before using the audio effect plug ins. The installation of
the plug-ins is carried out depending on the type of plug-in that is used. VST plug-ins are usually stored
in a certain folder.

In MOVIE STUDIO, you need to enter the folder for the VST plug-ins in their path settings. After the
path has been indicated, MOVIE STUDIO scans it for working plug-ins and makes them available for
use.

Using plug-ins:

Plug-in effects can be used in an audio effects rack at the track, object, and master level.

MOVIE STUDIO 2023 | MANUAL

Effects Audio effects 136



Clicking this button lets you insert plug-in effects. The effects user interface will then be opened
and active. After having closed the user interface, you can reopen it by double-clicking the plug-in
name.

This button removes effects from the rack. Since deactivated effects don't use up any computing
power, this option is used mostly for maintaining an overview.

Master effects

Master effects influence the mixed sum of all audio tracks. To this end a Master Audio Effects Rack and
additional plug-ins are installed in the Mixer window. Plus/Premium version, there is additionally the
special MAGIX Mastering Suite for the perfect sound.

The Audio effects dialog
Some of the following effects can be opened individually (context menu) or occasionally as part of the
track or master effects rack. However, the functionality remains the same.

Effect devices controls

Some effect options (e.g. options from the "Echo/Reverb" or "Time stretching" effects menu) open a
graphic interface that recreates an audio studio effect.

These virtual effects are controlled in the conventional way by using slider controls, turning knobs, or
buttons, or alternatively using the graphic sensor fields.

Sensor fields: You can control sensor fields intuitively with mouse movements. The graphics and the
respective effect setting change in response to each other.

Power switch: Every effect device in the rack may be switched on or off separately. This button
allows you to directly compare the neutral, unedited sound of the audio object with the effect setting
you have chosen.

Reset: Every effect has a reset button that restores the effect device’s initial default state. In this starting
point, no computing power is required and no effect is added to the sound

Each effect device features a selection of presets that can be selected via the drop-down menu.

A/B: The A/B button compares two settings with each other. If you have selected a preset for the effect
and make manual changes to it later, you can compare the original preset sound with the new settings
by using the A/B button.
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Timestretch/Resample

This effect device changes the object’s speed and/or pitch.

Tempo: This control changes the tempo independent of the pitch ("time stretching"). The object acts as
if it were compressed or stretched on the track.

Pitch: This control changes the pitch independent of the speed of the object ("pitch shifting").

+/- buttons: Use this feature to change the pitch in semitones.

Setup: This button opens a setup dialog where you can select various pitch shifting and time stretching
procedures.

n Standard: Time stretching and pitch shifting in standard quality. The method is suitable for
audio material without a pronounced beat. Existing beat markers are evaluated to improve
audio quality.

n Smoothed: Time stretching and pitch shifting for audio material without abrupt elements. The
method is suitable for several voice orchestra instruments, surfaces, speech and singing. Beat
markers will not be evaluated. A significantly more demanding algorithm is used for this, which
requires more processing time. The material may also be used with very large factors (0.2... 50)
without causing severe artifacts. To do this, the material is "smoothed" to give it a softer sound
and a different phase length. This smoothing is hardly audible, e.g. with speech, singing, or solo
instrumentation. More complicated spectra — such as a sound mixture containing different
instruments or a finished mix — can cause problems.

n Beat marker slicing: Beat-synchronized time stretching and pitch shifting via splitting and
temporal repositioning. Exactly set beat markers are required at the beats or transients.
Markers can be generated in real time (automatically) or read out from the source file, as long
as they are available (patched). The MAGIX Music Editor contains a patch tool which allows
the user to set markers manually. The algorithm is suitable for rhythmic material that can be
divided into individual beats or notes. This requires that the material contains low levels before
and after the individual beats or notes.

n Beat marker stretching: Beat-synchronized time stretching and pitch shifting in high audio
quality. The material is stretched between beat markers positions so that the impacts or attacks
at the beat markers positions are not impaired by stretching. The markers can be generated in
real time from the audio material (automatically), provided they are present (patched). This
method is suitable for rhythmic material that cannot be divided into individual beats or notes
because the beats or notes overlap each other.
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n Beat Marker Stretching (smoothed): Beat-synchronized time stretching and pitch shifting in
high audio quality, even with more intense time stretches. Beat markers are used at the beats or
transients. The markers can be generated in real time from the audio material (automatically),
or read out from the wave file, provided they are present (patched). This method is suitable for
rhythmic material that cannot be divided into individual beats or notes because the beats or
notes overlap each other. This method requires a relatively high amount of processing time. If
you have a slow system, you should only use it if needed.

n Universal HQ: A universal time stretching and pitch shifting method for very high audio quality.
Suitable for all types of audio material. Existing beat markers are evaluated to improve audio
quality. This method requires so much processing time, that a real-time application is
recommended only in exceptional situations.

n Monophonic voice: Time stretching and pitch shifting for vocal solos, speech or solo
instruments. Your material should be free of any background noises; strong reverb can also
make it difficult to apply this method. With suitable material the audio quality is very high. In
addition, the formants remain when pitch shifting. Beat markers will not be evaluated.

n Resampling: Pitch shift and tempo can not be changed individually. This method requires
comparably little CPU time.

Reverb

You can control the sound of the reverb effect using the following parameters:

Room Size: Defines the size of the room (or the system for the plate and spring). The larger a room, the
longer the sound travels between walls or objects. With some low "size" settings you can also reduce
the distance between the individual reflections. This allows resonance to develop (accentuated
frequency ranges), which can sound oppressive if the reverb sustain is too long.

Tone Quality: You can manipulate the sound characteristics of the effect to an extent. The effect of this
controller depends on the preset used. In rooms, "Color" controls the dampening of the highs in the
reverb (from dark to bright) as well as pre-filtering of the signal. With plate and spring presets, this
fader determines the dampening of the basses as well.

Reverberation Time:With this knob you can adjust the reverberation time and determine how much of
it will be absorbed and, simultaneously, the reverb's decay.

Pre-Delay: The reverb portion ("Mix") and the early reflections play a big role in the spatial perception
of the sound. Here the time required for the perception of the early reflection is know as "pre-delay". For
sound sources that are close, the reverb portion is usually low, and the early reflections reach the ear
noticeably later than the direct sound. By contrast, sound sources that are far away usually have a high
reverb portion, and the early reflections reach the ear almost simultaneously with the direct sound. The
length of the pre-delay can be used to influence the perceived "distance" between the sound source and
the listener.

Mix: This controller sets the mix ratio between the original and the edited signal. For rooms, you can
move a signal further into the room by increasing the effect share. The last four presets are intended for
use in an AUX channel of the mixer and are set to 100%.
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Presets:

The presets represent the basic settings for the various room algorithms, which can be varied along with
the other parameters. In this respect, they are more than just parameter sets.

Echo

This effect is like an echo which delays the signal and repeats it.

Delay: This sets the period of time between the individual echoes. The more the control is turned to the
left, the faster the echoes will follow each other.

Feedback: This adjusts the amount of echo. If you turn the dial completely to the left, there is no echo at
all; if you turn it completely to the right, there are seemingly endless repetitions.

Mix: This fader determines how much of the unprocessed original sound (dry signal) is subjected to the
echo (wet signal).

Audio effects in the Mixer

The Audio effects rack is opened in the mixer via the "FX" button for each track or in the
master area on the right.

Mastering also features the MAGIX Mastering Suite.

Reset clears all effect settings.

10-band Equalizer

The 10-band equalizer subdivides the frequency spectrum into 10 areas (‘bands’) and equips them with
separate volume controls. This makes it possible to create many impressive effects, from a simple
boosting of the bass to complete distortion. Note: If low frequencies are boosted too much, the overall
sound level is heavily increased, which may cause distortion. In this event, adjust the overall volume
downward by using the "master volume" control situated at the bottom center of the effect rack.

Slider control: Each of the 10 frequency ranges can be separately boosted or turned down with the 10
volume controls.
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Link bands: Using this button randomly combines the frequency ranges with each other in to avoid
artificial-sounding overemphasis of an individual frequency range.

Touch screen (right EQ section): This is the "sensor field" of the EQ. Here you can draw any type of
curve with the mouse. This will be immediately translated into a corresponding control setting on the
left side of the EQ.

Compressor

The compressor is an automated, dynamic volume adjustment controller. Louder passages become
quieter and quiet passages become louder. A compressor is useful to make spoken passages more
audible against background noise or music in case simple increase of the overall volume is insufficient.
Several useful presets are included for this purpose, however compression may also be set manually.

Threshold: Set the volume threshold, below and above which compression is applied.

Ratio: This parameter controls the amount of compression.

Attack: Sets the algorithm's reaction speed to increasing sound levels.

Release: Sets the algorithm's reaction speed to falling sound levels.

Gain: The gain controller amplifies the compressed signal.

Create mono objects
Mono recordings can leave noise on the second track, e.g. a mono microphone recording. You can
deactivate the track with the noise by selecting the function »USE ONLY LEFT SIDE« or »USE ONLY
RIGHT SIDE« (but not with mono videos).

You can find this function in the audio and video object context menu under »AUDIO FUNCTIONS«.

Extra effects using plug-ins

Video effect plug-ins are additional programs from third-party manufacturers that can be used to apply
additional video effects to video objects. MOVIE STUDIO supports the plug-in format of the freeware
video editing software VirtualDub, as well as the "VitaScene" and "Adorage" programs by proDAD and
effects based on OpenFX standard.
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Install the OpenFX plug-ins and click on "Scan" under "Effects" > "Extra effects" in the Media Pool. Then
restart MOVIE STUDIO. OpenFX plug-ins appear directly below and are ready for use.

Important applications for plug-ins:

n Removal of broadcast logos
n Removal of interference
n Addition of special effects

Using video effect plug-ins
First select the video or image object. Then open the Plug-in manager in the Media Pool (under "Effects
> Additional effects > Plug-in manager"). This opens the manager dialog for video effect plugins, which
lists all available plugins on the right side of the dialog.

Note: In order to use plug-ins, you have to install them first. After you install the plug-ins, they will be
displayed.

Video plug-ins manager

Effect templates for plug-ins: MOVIE STUDIO does not include plug-ins due to licensing reasons.

You can save your settings by pressing the "Save" button and remove them by pressing
"Delete".

Available plug-ins: All available plug-ins are listed here.

Add plug-in: The selected plug-in is added to the editing chain (plug-ins on the current object list is on
the right). You can load as many plug-ins as you like simultaneously. They are then edited subsequently
according to the list sequence. You can load as many plug-ins as you like simultaneously. They are then
edited subsequently according to the list sequence. The plug-in order can be changed using drag & drop
in the list.

Plug-in settings: Here you can open the settings dialog for the selected plug-in. All plug-in settings on
the entire list can be saved as a preset (effect templates for plug-ins) .

Advanced...: Opens the Advanced settings dialog.
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Navigation buttons: Switch to the previous or next movie via the navigation buttons in the lower part of
the dialog of a movie.

Apply from previous: Uses the settings of the most recently set movie. This option is only active if you
are editing objects with the navigation buttons (see above).

OK: The adjustments made to the settings will be applied to the current object.

Apply to all: The effects will be applied to all objects in the movie.

Cancel: Closes the dialog, the settings will not be applied.

Advanced...

In the "Advanced" dialog, you can specify the search path for plug-ins. MOVIE STUDIO checks in these
folders for available plug-in files at program start and adds these to the list of available plug-ins. With
"Add path" you can add new search paths, Delete path removes them from the list again.

Check for file extension only: This accelerates the search for new plug-ins when a larger number of
plug-ins are available, as only the file extension is checked for validity, not the actual plug-in.

Search subfolders:The search will be extended to include the subfolders.

Local settings

Dynamically recalculate video effect plug-ins for bitmaps for every frame: If you have to apply a
plug-in to a bitmap (image) object, you have to activate this option if the plug-in creates moving effects.

Create effects masks

Effects masks help you to apply effects in different areas of one video image with varying intensity. A
specific image is used as a mask to determine the specific areas where the effect should be applied.

Typical application include:

n Image optimization: A typical example is a horizontal pan across a horizon, in which case the
upper or lower area of the image is brightened or colored in.

n Eye-catching color gradients, colorations, etc.
n Special effects such as pixelation of a car license plate.

Effects masks are regular image objects, and as such may be animated or attached to a certain image
position to use them as moving video images. Here's how to do it:

1. Select the object in the arrangement to apply the effects mask to.

2. Open the desired effects page in the Media Pool. These must be parameters from the "Video
effects" area (without "speed" and "Chroma Key").
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3. Set up the effect parameters in the Media Pool that should be applied using the effect mask.
4. Click on the down arrow button on the effects page and select the "Load effect mask" entry from

the menu.

5. Now, find the template for SD and HD material in the folder that opens. Double-click the mask
you want to apply. The brighter the area in the effects mask, the stronger the effect will be. Black
indicates no effect, and white indicates full effect. When using your own color images, the
brightness values are used.

6. In the effect overview, you can define if effects mask should also be used for other effects Click
on the masking button for every effect the mask will be applied to.

7. Click on the down arrow button again and select the "Delete effect mask" entry from the menu to
remove the effect mask.

Create an animated effects mask
You can also create animated effect masks in Flash format to adjust the effect regulation to the moving
video images. To do this you will need to have either Xara Photo & Graphics Designer 2013 (or newer)
or Xara Designer Pro X (or newer) installed on your computer.

To do this, proceed as follows:

1. Select the image or video object for which you would like to create an effect mask.
2. Open the effects page in the Media Pool that will be used as the effect. Click on the down arrow

button and select "Create effect mask" from the menu.
Here you will also see the option for deleting the effect mask if necessary.

MAGIX Foto Designer or Xara Designer Pro X will start with the animation document and the opened
frame gallery. The first frame will be added automatically and will display the selected image or video
object fromMOVIE STUDIO.

3. Create effect mask:

Note: Be aware that the lighter the effect mask, the stronger the effect will be later in MOVIE
STUDIO. Black indicates no effect, and white indicates full effect. The best option is to color the object
that will be used as the effect mask white and to adjust the intensity of the effect yourself in MOVIE
STUDIO.
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a. Use the tools in the editor to create the desired mask form. Add an object that marks the area
where the effect should later be applied. It will automatically be assigned to the first frame.

b. With the "Invert mask" function in MOVIE STUDIO you can use an object to indirectly select the
precise area where the effect should not be applied.

c. Color the object white.
d. Give the object a name by clicking on "Names..." in the layer. Enter the name under "Names" and

click on "Add" and then "Close".
e. Create additional frames by clicking on "Copy" in the Frame Animation Gallery. The object that

should move will automatically be added to the new frame.
f. With each new frame the video moves to the corresponding position making it easier for you to

adjust the objects directly on the video image by moving them to the right position.

Invert mask
You can also invert masks: Click on the arrow in the mask effect's object, which appears when you
position the mouse over this object. This makes all dark areas light, and all light areas dark. To revert the
masks, click the arrow again.

Layer masks

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

You'll find various layer masks in the Media Pool under "Templates > Image objects". These masks can
be imported directly into your project as an object. The mask automatically applies the chroma key
effect "Alpha" and can be used to crop objects in a particular form. This can be used to create
interesting collages with two overlapping objects that blend into one another with a layer mask.
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The black area of the mask contains the top object, the white area is the object underneath. If you apply
a gray scale mask, the two object will be mixed according to the desired transparency.

You can also invert masks: Click on the arrow in the mask's object, which appears when you position
the mouse over this object. To revert the masks, click the arrow again.

Animate objects using keyframes (effects curves)

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

The Media Pool's "Effects" tab under "Video effects" and "Movement effects" provide you with the
effects which can animated using keyframes.

The following objects can be animated:

n Combined objects
n Video objects
n Image objects (still images and panoramas)
n Title objects
n Audio objects (in the Media Pool under "Effects" > "Audio effects" > "General")
n MAGIX 3DMaker objects (3D texts)

Preparing animations
n First, select the object in the project window to animate. For complex animations, we

recommend placing a marker beforehand for orientation.

MOVIE STUDIO 2023 | MANUAL

Effects Animate objects using keyframes (effects curves) 146



n In the Media Pool, open the "Effects" tab and click on the effect you would like to animate under
"Video effects" or "Movement effects".

n If necessary, set up the effect however you would like it for the start of the animation.

n Using this button, at the bottom of the Media Pool, a timeline may be shown or hidden.
You can see here which animated effects are currently applied to the selected object.
Keyframes can be placed, selected, moved and deleted.

There are two stippled lines in the timeline to help you orientate yourself while you edit movement.
These lines will help you recognize the start or end of the transition.

Place keyframe
Click the timeline to set the playback marker at the locations where a keyframe should be added.

Tip: You can also use the timeline in the project window for exact positioning. Using project markers is
recommended in this case.

This button places keyframes for all parameters required in the animation.

n Additional keyframes may be added simply by placing the playback marker at the next
keyframe location and changing the effects parameters directly.

The positioned keyframes may also be retroactively moved via drag & drop.

Copy a keyframe

Select the keyframes to be copied by clicking them and then press the "Copy" button.

Next, set the playback marker at the location for insertion and click the "Insert" button.

Display keyframes of individual parameters
Multiple keyframes are added simultaneously to an effect if it includes multiple parameters.

n Click the small arrow beside the name of the animated effect to display all of its parameters.
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n All keyframes of the effects parameter can be individually moved, deleted, activated, and
deactivated.

Note: Only those parameters are listed which are used for the animation. As soon as another
parameter is required for editing the effect, it becomes visible to you here.

Retroactively editing an effect's keyframes
Previously set keyframes can be retroactively and temporally moved and their parameters can edited.

n Keyframes can bemoved using drag & drop. Simply click on the keyframe to be moved and
drag it to the desired position.

n To change an effects setting for an already positioned keyframe, click the keyframe and adjust
the effect in the Media Pool.

Delete Keyframe

Select the keyframe to be deleted by clicking it.

This button removes the selected keyframe.

Keyframe Interpolation
Keyframe interpolation refers to the process of how the transition is made from one keyframe to the
next. This can either be constant ("linear") or flattened ("Bezier"). The interpolation type for each
animated effect can be set using the interpolation buttons in front of the keyframe bar.

In addition to the standardized curve progressions you can also create any kind of curve progression
you like.
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Linear interpolation is the default setting. This transfers the values evenly as a straight line to the
following keyframe.

The automatic Bezier interpolation applies an approximation curve at the keyframe. This
makes the movement progression softer and more natural.

Editing an effects curve in the object

Activate effects curve: For each animated effects parameter, a curve is created and placed over
the object. Click this button to display the effects curve on the object.

Edit curve points: The curve point can either be edited with the individual curve points (in "Standard"
mouse mode) or by freely drawing the effect curve (in "Curve" mouse mode).

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically.

Note: The buttons for activating effects curves are first displayed once the first keyframe has been
placed.

Effects curves – additional functions

The context menu can also be opened via the small arrow beside the effects
indicator.

Delete effects: Removes the selected effect completely.

Delete effects curve: Removes the effects curve to be created again.

Copy effects curve: The effects curve is copied to the clipboard to be used at other positions.

Insert effects curve: A previously copied effects curve can be inserted elsewhere with this function at
any time. This may be in the same object or in another object.

Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying.

Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
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Load effects curve: A previously saved effects curve may be loaded via this menu item. This is useful,
for example, if you have added your own default animations.

Note: The current effects curve will be overwritten as another one is loaded.

Save effects curves: Effects curves can be saved as a separate file. This is useful if you want to add your
own default animations and load them again at other positions.

Tip: Be aware that during saving the setting "Connect curve length with object length" is saved as well
and applied during loading.

Edit effect curve

This dialog serves to stretch, compress and move effect curves within an object. The info bar of the
dialog will display the effect, whose automation curve is currently being edited.

Move position

Time axis:With each click on the arrow, you can move the effect curve forward or back by the
displayed time value.

Effect: Every click on the arrow up or down moves the effect curve by the entered value. Depending on
the effect, it is possible to enter exact or percent values.

Stretching & compressing

Time axis: The effect curve will be stretched or compressed by the entered time value. Invert reverses
the curve on the time axis and reinserts it in "reverse". The entire object duration will be considered.

Effect: The effect curve is stretched or compressed in its values, no time-related editing takes place.
The selected option (see table) is decisive in editing.

Mirror: The entire curve is mirrored along the X-axis, whose position is determined by the following
option (see table).

... around the object center: The X-axis lies exactly at the center of the
object.

... at the center of the curve: The X-axis lies between the upper and lower
automation point.

... at the curve minimum: The X-axis lies at the level of the lowest
automation point.

... at the curve maximum: The X-axis lies at the level of the highest
automation point.
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Making objects "fly" across the screen
The effect "Position/Size" can be used to animate objects or titles appear to "fly" across the screen. In
this case it is recommended that the start and end point of the animation are placed outside of the
image.

You will need a video object and a second object to be animated, for example a title that is to fly through
the video image. Here's how to do it:

1. Click on the program monitor and zoom out of the video image (Ctrl + mouse wheel). This
displays the workspace at the edges of the reduced preview image.

2. Select the effect "Position/size".
3. Move the object to be animated to the position on the workspace where the animation should

start. For example, to the left of the preview window.

4. Position the playback marker at the location where the animation should start.
5. Create a keyframe for the animation start.
6. Position the playback marker at the position where the object to be animated should disappear

from the image.
7. Move the object to the position on the workspace where the animation should end; for example,

to the right of the preview image. This will place a second keyframe for the end of the animation
automatically.

8. Play back the result. The object to be animated should now fly from left to right through the video
picture.

Effect settings for the entire movie

You can open the effects from the the settings via the "Effects" menu.

All of the settings made here influence the entire movie. Settings are made separately for each
individual movie in the project. On the right, you'll see a preview of the current setting. Use the position
slider to jump to different positions in the movie or to various scenes in order to see how the selected
setting affects the image material.
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Brightness/Contrast
Brightness: Use the sliders to reduce or increase the object's brightness.

Selective brightness (gamma): “Gamma” determines the mean gray scale that can be calculated from
the various color ranges. "Selective brightness" is the most important function for enhancing images. In
the preset list, select the various envelope curves to edit only the dark, median, or brightest areas of the
image.

Using the fader you can also set the power of the brightness/darkness adjustments.

Contrast: You can increase or lower the object's contrast.

Adjust color space: This option is effective for correcting extreme colors that violate TV standards and
can no longer be displayed properly on-screen. The color saturation of the affected material is thereby
reduced until the maximum permitted value is reached.

Paint

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Hue: Use the palette to select a hue for coloring-in the picture.

Saturation: Use the saturation slider to increase or reduce the hue proportions in the image. A newly
developed algorithm is applied which makes color changes related to other parameters (e.g. contrast
settings) in order to achieve the most natural coloration possible.

Red/Green/Blue: Changes the color portion mix.

Sharpness
Use the slider to adjust the sharpness or blurriness of the entire film.

Apply to: Set whether the sharpness should only affect edges or whether the blurriness should only
affect surfaces. This enables you to effectively reduce ongoing image distortions.

Presets: Try out the presets from the preset menu.

Temporarily switch off all effects:With this option, you can temporarily deactivate all effects. This
way, you can quickly compare the original with the edited version.

TV picture
This option ensures that the image size is adapted to fit the real television picture (anti cropping).
Without this adjustment, the screen could cut off edges of the image in some cases.

Fade in TV display area in the program monitor: This option displays the image borders of the
television as lines in the program monitor. The four image borders of the TV display area can be set by
means of the 4 input fields. Here, it is of course necessary to know the actual size of the TV picture. To
determine it, proceed as follows:
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The four input fields also enable the borders of the four sides to be adjusted freely in percent. It is
important to find the optimal balance between distortion, reduction, bar formation, and image cropping:

n If the same value is entered for every margin the image size is reduced proportionally. In this
case no distortions will occur, but there will be bars along the edges.

n If different values are entered for the 4 fields the image size will not be reduced proportionally.
This will distort the image.

Apply border range to:This option enables the input values for the four image borders to be applied to
the respective photos in reduced form. The result can immediately be viewed on the program monitor.

Determining the visible TV frame size

To determine the picture properties of your television as well as optimal image size editor settings, you
should perform a test run:

n Load the project "Visible TV image" from the folder "My Media > Projects > Visible TV image"
in the Media Pool.

n Play back the film and read the instructions on the program monitor.
n Burn the project to DVD
n Place the disc into your player and play back the movie. Compare the TV picture to the picture

displayed on your program monitor by MOVIE STUDIO.
n Determine the proportional value of the borders cropped by the television with the 4

measurement scales along the edges of the test picture.
n Enter the values in the “Full TV size” editor.

The image size is now optimized to your TV picture. Please note: Depending on device settings and disc
carrier type, the cropping values may vary slightly.
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TEMPLATES
The »TEMPLATES« tab contains a wide selection of decorative elements: templates for collages, color
fields for your own backgrounds or test images and image objects that can be freely positioned and
animated.

A simple example for use are the frames under the image objects. These are virtual picture frames that
can be modified by video mix effects. Simply drag them directly onto an object, which will then appear
as if inside a picture frame.

The design elements create own objects on a different track. You can use the lower handles to adjust
the size of the borders to fit any length of the video. You can also achieve interesting effects by fading in
and out.

Note: Some design elements require a free track 6. In the case of these elements, you will be informed
by a dialog before you can use them.

Movie and editing templates

Unlike effects, film and editing templates are not dragged on to the existing material in the project
window like effects, but opened just like a standalone film. Each holds a placeholder that can be filled
with its own material. For example, you can use it for the opening credits or a film teaser to introduce
material on a website or in an email.

The movie templates are located under "Templates" > "Movie templates & editing templates" in the
Media Pool. Select the movie template according to the desired length of the movie. Double clicking on
a movie template opens it for editing.

Insert your own material
In the lower section, you can see the vertically arranged structure of the template. It is arranged into
several scenes. You can find additional explanations in the information window to the right.

You can insert your own content anywhere you see a media placeholder. The specified length will be
displayed on the media placeholder. Their lengths cannot be changed.

The placeholder icons indicate which type of material should ideally be inserted here (e.g., group shot,
landscape, close up).

1. Drag the desired image or video from the Media Pool in front of the placeholder to be replaced.
If the video inserted is too short, it will be rejected by MOVIE STUDIO.

Images automatically become the length of the controlled media placeholder.
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2. If the video is too long for the media placeholder, move the position of the video in the editing
area.

Automatic filling
To add content quickly, use automatic filling.

Select multiple media items in the Media Pool and drag them over the movie template. A field will
appear where you collect your media. The movie template will now be automatically filled. The order of
the media items in the template determines the date of the files; the sections are selected at random.

Note: Depending on the template, either the entire template will be filled with the video footage or
individual placeholders will each be filled with a video from the selection.

If you do not like the compilation, click on »REAPPLY« and the program will select new video sections.

Design title
To customize the text, click on the corresponding placeholder and enter the desired text to the right of
the editing area in the text field.

Further use of movie templates
Burning and exporting a filled template works just like with any other project.

Manually editing a movie template

Click this button if you want to customize the movie template in detail. The movie template will be
transferred to the known edit screen and every object, every transition, every music title, etc. can be
customized.

Important! You cannot return to the movie template wizard.
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AUDIO
In principle, any track in MOVIE STUDIO can be used as an audio track. There are no specific track
types. But it's easier not to mix object types within one track.

Loading audio files

n All importable audio files may be accessed in the Media Pool and previewed via the transport
controls of the program monitor by clicking on the file name.

n The files can be moved to the project window using drag & drop. Tracks from audio CDs can
also be dragged & dropped into the project.

n Edits, fine positioning, volume settings, and fading in and out can all be adjusted directly in the
project window using the object handles.

n Various effect curves can be selected for audio tracks, dynamically controlling selectable
effects, volume or stereo panorama.

Adjust loudness of all selected objects

This function adjusts the loudness values of all selected objects according to the "reference object". The
object that has just been activated is used as the reference object.

Requirements

n Objects need to be at least 5 seconds long for a reasonable calculation. An object length of 10
seconds or longer will provide better results.

n Background music provides the best results. In the vast majority of cases, music provides a
homogeneous sound image and minimal volume changes (of course, very good results can also
be obtained with video material).

Open

1. Set the object loudness of the reference object to the desired value.
2. Select all objects (including the reference object) whose loudness you would like to adjust.
3. Right-click the reference object to open its context menu. Select "Adjust loudness of selected

objects" (for Combo objects in the submenu "Audio functions").
Or:
Press the Shift key and click on the reference object. Then go to "Effects > Audio object effects"
and select "Adjust loudness of selected objects".

Result:

n MOVIE STUDIO determines all loudness values for the selected objects und adjusts them to fit
the reference object. The object loudness of the remaining objects will also be adjusted
accordingly.
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n If the adjustment results in an object loudness which is so high that it could possibly cause
clipping, MOVIE STUDIO will provide an automatic correction. This will lower the volume of all
objects (including the reference object).

Problems & solutions

For objects containing large loudness differences or noises (e.g. in video camera recordings) the result
may not always be satisfactory. Prepare these objects as follows:

1. Split the object at the corresponding transitions before carrying out the function.Loud
2. Open the function (see Open).
3. Afterwards transition the objects with simple crossfades.

Edit volume curve

You can use volume curves to easily edit the audio track of an object as you wish.

1. In a project, select an object whose volume you would like to adjust.
2. Open the volume curve by going to "Effects" > "Audio object effects" > "Volume curve".

You will now see an additional line in the audio track; this is the volume curve.
3. When you touch this line with your mouse cursor, the cursor is transformed from a hand symbol

to an arrow. Now if you click on the line, you will create a point (keyframe), which you can grab
with the mouse cursor and drag to a lower position. This lowers the volume of the overall object.

4. Create another point. Move this point down too and make sure you don't lower the entire volume
curve, but simply a section of it.

You can create as many keyframes a you wish, adjusting the volume curve section by section, untill all
segments play at the appropriate volume. Check whether the keyframe are positioned right by playing
back the track (spacebar starts and stops playback) and listening to hear the effect of the keyframes.

If you would like to move a keyframe to the left or right, grab it with the mouse cursor and move it to the
right position.

If you would like to delete keyframes, use the effect overview in Media Pool under "Effects" > "Audio
effects" > "General" as described under "Animate objects, effect curves". Select the keyframe that you

wish to delete and click on the Delete button.

Audio mixdown

This option combines all audio objects in a single audio file (mixdown). The audio material in the project
then occupies a single track, so you have a clear overview of other objects and more space for them.

MOVIE STUDIO automatically normalizes the audio file, i.e. the loudest point of the wave audio object
is identical to the highest value of the 16-bit resolution ceiling. This guarantees the same sound quality,
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even if you repeat the mix down procedure in the project window or you combine the mix down file with
other wave audio objects again and again. The mixdown function is very helpful if you want to continue
using the mixdown object.

Volume reduction

The Volume reduction command from the audio object context menu automatically dampens the
volume for the length of the audio object on all other tracks. The volume on the track of the selected
object thus remains unchanged.

Only original sound: Here you can also specify whether you want to dampen only the original sound of
the video or all audio tracks.

Transition length: In the dialog you can set the dampening and the length of the fade in and out. You
can use this command while recording audio (Audio recording, advanced options).

Audio cleaning

In the context menu for an audio object, open the "audio cleaning" editor for correcting noise, distortion
or other audio discrepancies.

Select the cleaning function you desire from the upper part of the dialog:

n The equalizer allows you to manipulate the frequency spectrum – perfect for cleaning-up
muffled dialog.

n The compressor is a dynamic volume control that lends a deeper, richer quality to the overall
sound.

n The Stereo FX processor controls the position of the sound within the stereo panorama.
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n DeClipper, DeNoiser and DeHisser are professional noise reduction tools for removing noise
and hiss.

Preset: You can find the right presets for your project in the preset menu.

Temporarily switch off all effects:With this option, you can temporarily deactivate all effects.

Apply to all: Applies the selected cleaning settings of all effects to every scene of the movie.

DeClipper
If the input level of an audio recording is too high, distortion may result at the louder parts (the signal
peaks). This digital distortion is also called "clipping": At the overmodulated area, the values that are too
high are simply cut off, and typical, quite unpleasant-sounding crackling and distortion appear.

MOVIE STUDIO includes a special function for dealing with digital clipping and analog distortions. This
only works to a certain degree, of course. It's better to avoid clipping during recording in the first place.

Using the fader you can set at what level the DeClipper should register a signal as being overmodulated
and, if required, correct it (Clip level). This is important, as different sound cards show different clipping
methods. The more the fader is turned up, the lower the level recognized by the program as
overmodulated. If the clip level is set too high, unwanted sound modification may occur.

Get clip level: The clip level is gauged from the current position of the playback marker.

How to get clip level:

1. Set the playback position just before the loudest section.
2. Press "Get clip level".
3. For more precision, you can adjust the clip level control.

DeNoiser
The DeNoiser removes persistent background noise like computer humming, hissing, noises from sound
cards, disturbance from ground wires, interference from audio-equipment with high-impedance outputs
(e.g. turntables), footsteps or rumbling sounds from LPs.

The DeNoiser requires a noise sample. Some typical noise sounds are included in the "Preset" selection
menu.

Set the degree to which the noise should be reduced with the fader. It is often better to reduce
interference signals by 3 to 6 dB rather than as much as is possible so as to keep the sound "natural".

A different option consists of creating a noise sample yourself. A short section from the audio track in
which the distortion can be found is all that's needed. To get it, switch to the DeNoiser dialog by clicking
"Advanced".

Advanced settings

Step 1: Choose noise sample

First of all, a sample of the distortion you wish to remove must be selected, a so-called "Noise sample".

You have two options to choose from:
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n Pick out typical background noise: You can select and use a number of typical background
noises from the flip menu. Select one and listen to it by pressing the "Play" button. If it's similar
to the background noise in your audio track, go ahead and use it (see "Step 2: Removing
background noise").

n Extract a new noise sample from an audio track: You can also pick out a short passage (from
the existing sound track) in which you can hear the background noise.

Automatic search: Searches especially quiet passages in which background noise is most noticeable.

Previous/play/next: This button allows you to play all of the passages found for easy comparison.

Save as: Once found, you can save noise samples to the hard drive. They then appear as entries in the
"Typical background noises" flip menu to be used in other projects.

If you only wish to use the noise sample in the current project, you don't have to save. Instead just go to
the "Remove noise" category.

Step 2: Remove noise

Noise level: The level of the noise reduction function should be set as precisely as possible. Values that
are too low are expressed in too low a distortion dampening level and in artefacts, like noises or
"twittering" (see below). Values that are too high give rise to dull sounding results – the highs of the
sound signal are also filtered out. Take your time to find the best setting for an individual case.

Reducer: This sets the balance between the original signal and the signal with the applied noise
reduction. It's often better to reduce interference signals by 3 to 6 dB rather than as much as is possible
to keep the sound "natural". For buzzing, it’s best to apply complete removal.

DeHisser
The DeHisser eliminates regular "white" noise typically produced by analog tape recordings,
microphone preamplifiers, or AD transformers. Noise reduction can be adjusted in decibel increments
with the fader. It is often better to reduce interference signals by 3 to 6 dB rather than as much as is
possible so as to keep the sound "natural".

Noise level: You can choose from different noise levels. You should set the selection as precisely as
possible. Setting the value too low will result in only partial removal of the hissing. Settings that are too
high lead to dull results – noise-like signal components (such as the blow-off of wind instruments) are
also removed.

Equalizer FX rack
The 10-band equalizer subdivides the frequency spectrum into ten areas (‘bands’) and equips them with
separate volume controls. This makes it possible to create many impressive effects, from a simple
boosting of the bass to complete distortion. If low frequencies are boosted too much, the overall sound
level is heavily increased which may lead to distortion.

Slider control: Each of the ten frequency ranges can be separately boosted or turned down with the ten
volume controls.
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Link frequency bands: The frequency fields can be bundled together flexibly in order to avoid artificial-
sounding overemphasis in individual frequency fields.

Compressor
The compressor is an automated, dynamic volume controller. Loud passages become quieter and the
total value is raised. This makes the volume more consistent and speech easier to understand. A
compressor is mainly useful in case background noise or music interferes with speech and simply
increasing the volume of the individual objects or tracks does not result in any significant improvement.

Ratio: Regulates the amount of compression applied.

Function: Defines the way compressor operates according to the audio material.

Stereo FX
With the Stereo FX processor, you can determine the positioning of the audio material in the stereo
panorama. If stereo recordings sound unfocused and undifferentiated, an extension of the stereo base
width can often provide better transparency.

Bandwidth control: This adjusts bandwidth between mono (all the way to the left), unchanged base-
width (center) and maximum band-width (“wide”, all the way to the right).

Reducing the base width can produce an increase in the level. In extreme cases – when the left and right
channels include identical material and the base width control is pushed to the extreme left on ”mono” –
the result can be a level rise of 3 decibels.

Raising the base width (values over 100) diminishes the mono compatibility; this means that some
frequency ranges may cancel each other out if the stereo signal is played on a mono device.

MAGIX Mastering Suite

MAGIX Mastering Suite is a special effects rack for use with the mixer master channel. The effects in
the Mastering Suite are used as part of the mastering process, in which the mixed music piece is given a
final polishing.

The On/Off switches switch the effects on and off individually. Each effect has a range of presets
that can be selected from a list along the lower border of the effect.

Each effect can be reset by pressing the Reset button.

Note: 5.1 Surround mode only provides the compressor and parametric equalizer devices in this case.

Auto Mastering
The Auto Mastering feature enables you to automatically apply the sound of typical musical styles from
the past and present (e.g. 70s disco, 90s club, jazz etc.). The sound of the source material is analyzed
and appropriate equalizer and dynamic effects are applied.

MOVIE STUDIO 2023 | MANUAL

Audio MAGIX Mastering Suite 161



1. Activate the Auto Mastering Wizard.
2. Now choose the musical style. MOVIE STUDIO will analyze the audio material in the project. The

settings that are used to achieve the optimal sound for a particular musical style depend on the
audio properties of the source material.

Use the »ORIGINAL« interface in order to compare the original with the edited version.

Parametric 6-band equalizer
The parametric equalizer has six filter bands that you can use to shape the sound of the music track.
Each band is a filter with a typical "bell shape". You can increase or reduce the signal level gain within a
specific frequency range around an adjustable middle frequency . The width of this frequency range is
called bandwidth. The bandwidth is defined by the Q value. The higher the Q value, the narrower and
steeper the filter curve.

You can influence the basic sound of the mix by boosting or cutting specific frequency ranges (low Q
value) to give it more "depth" (lower mids 200-600 Hz) or more "air" (highs 10 kHz). You can also
decrease very specific frequencies (high Q-value) to remove unwanted noise.

Sensor field: The sensor field displays the resulting frequency response of the equalizer. The frequency
is displayed horizontally and the increase or decrease of the respective frequency is displayed vertically.

The blue bullets 1-6 symbolize the six frequency bands. You can move them around with the mouse
until you find the frequency response you want. The bandwidth (Q value) can be adjusted using the
mouse wheel.

The faders under the filter graphic display the parameters of the currently selected band.
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You can use the knobs to set the values for each band more precisely. There is also a numeric field for
each parameter where values can be entered.

Gain: This controller allows you to raise or lower the filter. Setting the controller to 0 deactivates the
filter so it does not use any processing time.

Freq: The center frequency of the individual filters can be set between 10 Hz and 24 kHz with the
frequency controller. The freedom to select frequency enables you to set multiple filters to the same
frequency in order to have a greater effect.

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 Hz and 10 kHz.

Bands 1 and 6 are special: Their Filter Curves can be edited in three different modes. The four editing
points in the graphic have different functions in each mode.

Peaking: Here the effect curve is brought closer to the working point (which represents the peak
of the curve) from both sides simultaneously.

Shelving (Basic setting): Here the working point displays the beginning of the filter curve. From
this point on there is a gentle increase or decrease in the frequency.

High-pass and low-pass:In Band 1 the working point displays the frequency which is filtered out of
particularly high or low frequencies.

You can control the output level of the equalizer with the Peak Meter. The output amplification beside it
lets you offset the level changes resulting from EQ adjustments.

Peak meter: You can control the output level of the equalizer with the Peak meter. The output
amplification beside it lets you offset the level changes resulting from EQ adjustments.

Multimax
Multimax is a compressor with three independent frequency bands. The dynamics are edited separately
for each band. The advantage of a multi-band compressor versus a "normal" compressor is that the
"pumping" tendency and other unwanted side effects are dramatically reduced while editing the
dynamics. For instance, it can prevent a peak in the bass range from suppressing the entire signal.
Multiband technology also lets you specifically edit individual frequency ranges.
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Setting the frequency bands: The settings of the frequency bands are changed directly in the graphic.
Simply click on the separator lines and move them.

Lows/mids/highs: These knobs control the level of compression for each frequency band.

Link:When this button is activated and a fader is adjusted, all other faders are changed proportionally.
However, the way the dynamics are edited is not affected.

Presets:In MultiMax, you can use Presets 2 to open further special features:

n Cassette NR-B decoder:MOVIE STUDIO simulates decoding of Dolby B + C noise suppression
if a Dolby player is not available. Cassettes recorded with Dolby B or C sound more muffled and
dull if played back without the corresponding Dolby.

n De-esser: These special presets help to remove overstressed hissing sounds from speech
recordings.

Stereo processor
With the stereo enhancer you can determine the positioning of the audio material in the stereo balance.
If the stereo recordings sound unfocused and undifferentiated, an extension of the stereo base-width
can often provide better transparency.

Use the maximize feature to move the echo (e.g. into the foreground) and improve the stereo picture.

Volume controller: Adjusts the volume of every single channel, thereby adjusting the entire panorama.
The reduction of left and right levels is displayed under the control buttons.

Pan direction: Use this controller to move the sound source from the middle into stereo panorama. The
signals at the outer edges of the sound picture remain unchanged.

Multiband: This can be used to switch Stereo FX to Multiband mode. Stereo editing only applies to the
middle frequency, the bass and highs remain unchanged.

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme left), unchanged
base width (normal stereo), and maximum base width (wide, extreme right). Raising the bandwidth
(values over 100) diminishes the mono compatibility. This means that recordings edited this way sound
hollow when listened to in mono.

Maximize strengthens the spatial component of the recording, which also increases the stereo
transparency without influencing the mono compatibility.
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Stereo meter (correlation gauge): This provides a graphical display of the phasing of the audio signal.
You can use it to check the alignment of the signal in the stereo panorama and the effect of the stereo
enhancer. To maintain mono-compatibility, the "cloud" shown should always be higher than it is wide.

Limiter

The limiter prevents clipping by automatically lowering the level if it is too high. Quiet parts remain
unaffected. In contrast to the compressor it tries to leave the basic sound as unaffected as possible.

Mixer

The Mixer can be opened by pressing the »M« key or in the menu going to "View" > "Mixer".

Mixer channels
In the mixer, every project window track is represented by a corresponding mixer channel. The mixer
channel offers a series of options for regulating the audio signals of objects in the track.

FX: Opens the audio effects rack for the corresponding track.

Auto: Activates the volume and panorama automation of the corresponding track.

Volume: You can set the volume of a track using the large fader.

The fader can be fine-tuned in the following way:

n Press the Shift key while setting the fader. This makes the control range of the fader ten times
larger.

n While setting the fader, move the mouse away from the fader horizontally. The control range of
the fader will increase in accordance with how far the mouse is from the fader.

Stereo panorama: Use the knob to define the stereo position of each track.
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Note: Double-clicking on the volume or panorama control resets it to its default passive setting in
which no processor output is required. Double-clicking again sets it back to its former position.

Solo/Mute: The "Solo" button switches a track to solo mode, i.e. sound playback for all tracks which
have not been switched to solo mode will be deactivated. "Mute" mutes the track.

Effects channels
In addition to the normal mixer channels assigned to tracks in a project, two separate effects channels
can be created. This allows you to send part of a signal from a normal channel to an effects channel,
where it will be processed by additional effects. This is a common practice in professional audio
production.

Two FX send controllers (FX1 and FX2) are located on every mixer channel under the buttons
FX and Auto. You can determine how much of the track's signal is sent to the available effects channels.

The FX tracks are usually hidden in the mixer. They will be displayed to the left of the master section
as soon as one of the FX send controllers is used.

An effects channel is an entirely additional mixer channel with volume and
panorama controller and effects rack.

In the first effects channel, the reverb feature is activated by default, since it is
the most common way of using send effects.

The volume controllers serve to regulate the volume of the effects channel and
corresponds to an AUX return controller. The "Mute" button is used to switch
the FX feature on and off. The "Solo" button enables you to listen to the effects
channel separately. The peak meters of the tracks, which send to the FX track,
are displayed in gray.

Master channel
The master channel is located to the right of the individual channels. This controls the overall sound and
also offers all editing options: volume, panorama, plug-ins and effects.
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The FX button and the plug-in slots function exactly as in the other channels. The FX button will open
the master audio effects rack. The complete mixer settings including the effect channels can be reset
with the "Reset" button.

Mastering: Opens the MAGIX Mastering Suite.

5.1 Surround: This button switches the mixer to Surround Mode.

Both faders control the total volume.

Link buttons: If the link button is deactivated, the volume of the right and left
channels may be set individually.

Volume and panorama automation
You can automate the volume and panorama curves of a track. This means you can move and record
the track volume faders and panorama controls during playback. This way, for instance, you can
simulate the movement of a sound source from left to right and make volume adjustment instantly
during playback.

As long as the Auto button in a track is active, all movements of the volume and panorama
controller are recorded.

The automation is displayed as a curve in the project window and can be edited later with the mouse.

Note: Unlike the automation curve of the mixer, the dynamic effects are track-dependent, i.e.
irrespective of the objects contained in the track.

5.1 Surround/Multichannel

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

With MOVIE STUDIO, you can play back and export multichannel audio tracks.

What you'll need
To edit audio tracks in Surround Mode you need a sound card in your computer which can operate the
following channels:

n front left (L) / right (R)
n center (C) / Subwoofer (LFE)
n back left (Ls) / right (Rs)

Surround playback is possible with all audio driver models (see Playback settings), (Wave,
DirectSound). Please adjust these in the program settings from the "Playback" tab.

DirectSound is supported by most of the standard sound cards.
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Wave drivers are similarly supported by many standard sound cards; however, individual sound cards
(for example, Soundblaster) require access to DirectSound.

Output of the six output signals is achieved in all driver models in the output channels in the same
(standardized) order:

Channels 1/2: L- R

Channels 3/4: C-LFE

Channels 5/6: Ls – Rs

Importing and exporting multichannel audio files
When importingMPEG-2 files with multichannel sound (e.g. VOB files from DVDs or DVB-TV
recordings), you can choose from two different applications:

n Mixdown: multichannel sound is displayed as an audio object under the video object, playback
of the multichannel track is reduced and recalculated to stereo playback. Use this option if you
want to export the multichannel sound without editing or if you think that a stereo export is
enough to meet your requirements.

n Multichannel sound mix: The individual channel pairs of the multichannel sound (L-R, C LFE,
Ls-Rs) are split into three audio tracks as separate objects and the mixer is then set to Surround
Mode. This mode allows you to change the multichannel sound mix.

MOVIE STUDIO can also import interleaved wave files (multichannel wave files), multichannel
Windows Media Audio and MP3 files. This will always create a multichannel sound mix.

Multichannel audio mix exports can occur in one of the following formats:

n 6-channel PCM files (interleaved wave)
n Windows Media files (as a multichannel soundtrack of a Windows Media Video or WMV-HD

disc)
n MPEG-2 files with multichannel audio

The export is performed using the same menu commands (e.g. "File > Export movie > Audio as wave")
like the normal stereo export. You will then be asked if the export should be in stereo or multichannel
format.

Export the multichannel sound using Smart Copy
You can also burn original material with multichannel sound to DVD again without the need for the
codec or you can export the corresponding MPEG files while keeping multichannel sound. To do this,
use the "Smart Rendering" option which transfers the unprocessed parts of the original material to the
destination file without renewed encoding.

The mixer in multichannel audio mode
To activate multichannel playback, open the mixer (M key) and click on "5.1 Surround" button in the
master.
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In the master, six peak meters for the individual channels are provided. The normal panorama button
turns into a representative display of the Surround editor (see below), which can be opened by clicking
on the display.

The Surround sound editor is also available to the effects tracks. For example, you can send the original
track to the front L/R speakers, the FX track however will remain at the rear L/R speakers.

The master volume is applied to all channels, here the left controller influences channels L and Ls, the
right controller; channels R and Rs and the middle value of both controller; the channels C and LFE.

The master plug-ins are only applied to the front channels.

In the master FX rack of the MAGIX Mastering Suite the full effect palette is not available in 5.1
Surround mode, but rather only the compressor and the parametric equalizer (from the Mastering
Suite). The settings of these effects have the same effect on all six channels.

5.1 Surround Editor

In the 5.1 Surround Editor of the mixer track you can arrange the audio signal of a track (displayed as
two red sound sources) in the "imaginary" room. The signal is dispersed to the 5 (blue) loudspeakers
which represent the individual surround channels.

There are 6 channels:

n L: Front left
n R: Front right
n C: Center
n Ls: Back left/left surround
n Rs: Back right/right surround
n LFE: Sub bass (Low Frequency Effect) channel

Dispersing the signal to the 5 loudspeakers occurs after the so-called sound source emits a sound field
of a certain level (displayed as red circles). The further away a loudspeaker's source is, the less its share
of the corresponding loudspeaker channel. The position of the source and the loudspeaker can be
moved with the mouse.
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The subbass share (LFE) is set directly in the corresponding value table. It can also be changed by
dragging the mouse.

There are various modes in which you can use the source signal:

n Mono: The (stereo) source signal is seen as mono material, the left and right channels are
mixed together and arranged together. The original stereo information is lost here.

n Stereo 1: Similar to mono mode insofar as the left and right channels are moved together,
however, only a portion of the left source is audible in the loudspeakers Land Ls, and only a
portion of the right source in the right channels R and Rs. The stereo information remains as
faithful as possible.

n Stereo 2: The left and right channels can be moved individually. The distance between the left
and right source is retained when you move the left source. You can move an individual source
by holding down the "Alt" key. You can move an individual source by holding down the "Alt"
key.

n Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn solely from the
right channel. This mode is only of importance when importing Surround material.

"Width" determines the level of the sound field of an individual source.

Automation:

Panning of the sound source on the loudspeaker can be automated to simulate movements in the room.

For this to happen "Automation"must be activated. There are two methods to create automations:
record and draw.

To record (when automation is on) the sound source is moved between the loudspeakers during
playback. When recording the automation, the "Record" checkbox lights up red.

The draw function is an alternative way of recording complex movements. If drawing mode is activated,
all panner movements are transmitted to the time interval between the start and end marker (when the
mouse button is held). You can thus draw the entire movement curve for the selected time range.

"Reset" deletes surround automation from the track.

Note: There is no automation of the parameters for width and LFE, of the distance between the left
and right source in "Stereo 2" mode, or of the loudspeaker positions.

Scrubbing

Scrubbing is used to quickly preview individual passages of a film or a piece of music. The function plays
short samples at the original speed.

Note: To listen to an audio object the whole way through use the Mouse mode "Preview".

n Scrubbing can be activated by right clicking the speaker button.
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No scrubbing: Scrubbing is deactivated. Sound will not be played when the playback marker is set or
moved.

Scrubbing (1 frame): Scrubbing is active and samples are only 1 (video) frame in length. The speed is 25
fps, i.e. 1/25 second. This mode is suitable for positioning the playback marker exactly.

Scrubbing (long): Scrubbing is active, the sample length amounts to approx. 0.5 seconds. In this mode,
locating specific events is particularly easy.

Play 1x during scrubbing: if this option is active, the current position will be played one time. If it is
inactive, then it will be repeated.

If the scrub mode is selected, set the playback marker to a certain location in the timeline using the
mouse. Hold the mouse key and move the playback marker to various locations in the project.

Scrubbing may be used also by employing the jog and shuttle wheel on the program monitor, as well as
through various hardware controllers.

Import audio CDs

Importing an audio CD works the same way as adding other audio files into the project:

n Insert an audio CD into the drive.
n Go to your drive in the Media Pool. The individual CD titles appear in the file list.
n Double-click on an entry to preview it.
n Drag & drop the track from the CD into a track of the current project and it will be digitally

scanned and copied to the hard drive. The files will be saved in the import folder (may be
specified in "File" > "Settings" > "Program" > "Folder").

The CD track appears in the track as an audio object and can be played back or edited immediately.

Import Audio CD track(s)

There is an additional custom option for audio CDs in the "File" > "Import audio CD track(s)" menu,
which allows a more convenient import with additional features.

This option opens the CDManager where you can select tracks from audio CDs and partially or fully
import them into the project. Audio tracks are saved in the directory of your choice in WAV format and
imported into the project.

Track list

The tracks in the list can be selected with a mouse click or by using the keyboard shortcuts "Shift +
arrow keys" or "Ctrl + click".

The transport console in the dialog opens the monitoring function. The play arrow starts the audio
playback of the first selected track.

MOVIE STUDIO 2023 | MANUAL

Audio Import audio CDs 171



Select all tracks: This option will select all audio tracks, e.g., for copying the complete CD.

Save the selected tracks: This button opens a dialog for saving the selected tracks. This can be saved
either as all tracks in oneWAV file or as a WAV file for every track. In either case, a new object is
created in the project for every track.

CD Drive options: This option opens the "CD/DVD Drive list" dialog.

n Configuration: This button opens the configuration dialog where you can make various special
settings.

n Add: Creates a new drive in the list that requires special settings.
n Delete: Deletes a selected drive from the list.
n Load setup: Loads the current drive list and all configuration data from a *.cfg file.
n Save setup: Saves the current drive list and all configuration data in a *.cfg file.
n Reset: Restores the default settings of the drive.
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WIZARDS

Slideshow Maker

TheWizard is ideal for converting still images into moving pictures, adding background music, and
effects. You can access this under "Edit > Wizards".

This button plays a preview. Play around with templates and effects to see which you like best.

Style templates

Select a template that best matches your needs.

Intensity

Controls the portion of video and image objects that feature effects. "Normal" will give you a balanced
amount, "Weak" and "Strong" provide fewer or more effects accordingly.

Transitions

Transitions can be individually activated or deactivated using this button.

The slider in the transitions dialog can be used to adjust the amount of each type of transition.

n Transition duration: Set the length of the transitions in seconds.
n 3D transitions use Stereo 3D mode: If this option is activated, 3D transitions use Stereo 3D

mode.
n Random transitions: The transitions are set to random values.

Effects

Various effects can be individually activated or deactivated using this button.

The slider in the dialog controls the amount of each effect type.

n Random effects: The faders that control the amount of effects are set randomly.
n Treat special image formats intelligently: Panoramas and portrait photos can be treated

"intelligently". If this option is activated, then panoramas and portraits will be treated with
special effects adjusted to the format. These effects can also be selected and unselected in the
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detail view.
If this option is not selected, then these images will use the same effects as all other images.

n List of effects/transitions: The list icon activates or deactivates effects or fades in each
corresponding category individually. The arrow below the program monitor plays a preview.

Properties & titles

Film length

n Resulting film length: This is an estimation of how long the film will be after adjustments made
with MovieshowMaker.

n Available music: This is the complete length of the music that is currently selected.
"Background music" enables detailed settings for the pieces of music to be used.

n Adjust movie length to the music: It will be attempted to adjust the length of the photo objects
to the background music. If the film is too short, the music will be cut. If the film is too long, the
music will be repeated.

n Adjust music length to the film: Photo objects have a set length, and the resulting film is filled
with music. Music at the end of the movie is faded out.

Include video objects

n Process videos: If this option is set, then videos will be automatically processed with effects
and transitions.

n Length: Settings may be made here about whether the original length of the video should be
maintained or if it should be shortened.

Opening and closing credits: Set the text for opening and closing credits here.

n Custom text: Enter text for opening and closing credits to be added by MovieshowMaker.
n Use file: A title template, a video, or an image file may also be used.

Note: Titles created using Movieshow Maker may also be edited at any time.

Group associated images together

If this option is active, an attempt is made to detect associated events via their date information and to
separate them from each other optically. Detection of individual events is based on the time span of
these events to achieve a sensible separation.

n Begin group with fade through black: A black fade is added between the different events.
n Begin group with data/time below black fade: A black fade is added between the different

events. A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, provided the
events take place over multiple days.

n Begin group with data/time below image: A black fade is added between the different events.
A title is also faded in with a suitable duration after the black fade, e.g. 1st/2nd/3rd day,
provided the events take place over multiple days.

Background music

Here you can set the pieces of music to be used as background music.
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Use background music: Background music is inserted.

Load file(s): A file selection dialog will open in which you can select a folder with audio files, and
choose the corresponding file or files you want.

Remove: The highlighted music files will be removed from the list and no longer used.

Insert random:MOVIE STUDIO selects random pieces of music from the folder Import > My Media >
Slideshow music in the Media Pool.

Preview: This button previews the selected piece of music.

Volume ratio: This slider controls the volume ratio between the original sound and the background
music.

Tip: Pieces of music in the fifth track are listed and used for background music.

Travel Maps - Travel route animation

MAGIX Travel Maps is an easy-to-use software for creating travel route animations.

Quick Start
Once you have started MAGIX Travel Maps, you can choose from different maps in the start screen:
Maps are included, Travel Packages can be expanded from the MAGIX Store, or load your own maps as
image files.
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1. Select the map you want to use for your animation by clicking it. The corresponding map opens.
2. Click on the map to set locations for a route. Routes can contain an unlimited number of

locations. You can alternatively add specific locations using the search.
3. Personalize your travel route with photos and various effects and click the play button to start the

animation.
4. Click the Finish button and create a WMV or mp4 video file.

General menu functions

Menu drag handle: Allows you to move the menu to reveal sections of the map which are
being covered by the menu.

Create new travel route: Creates a new travel route. You can create multiple travel routes
on the same map.

Load travel route: Allows you to load a travel route which has already been created and
saved. Once loaded, you can make changes to the route.

Save open travel route: Saves the currently open travel route.

Playback menu: Plays the currently open travel route. This is what the finished travel route
animation looks like.

Fullscreen mode: The program uses the entire screen.

Open/close menu: Lets you close the menu to reveal sections of the map which are being
covered by the menu. To continue editing your travel route, simply click this button to open
the menu again.
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360° Control

You can use the 360° Control to change the map's display as well as adjust the rotation and skew at
any time.

Zoom in and out

Keyboard shortcut: Mouse wheel

Skew map (Live Maps only)

Keyboard shortcut: Ctrl + Mouse wheel

Rotate map

Keyboard shortcut: Shift + Mouse wheel

Double-clicking on the 360° Control or the individual faders will reset the values. If you are using image
maps or your own maps, the original map section will be restored.

Photos
Pictures in JPG format can be added to travel routes by going to "Photos" > "Select photos" and
importing them, and then dragging them from the overview onto the travel route.

n Photos can also be assigned to specific destinations or set as the background image for a
destination.

n The images assigned to each destination are briefly displayed when the animation reaches the
destination and are once again hidden when the animation moves on.

Slideshow properties:

In the Slideshow properties you can set transitions, display times and transition lengths for the photos in
your travel route.
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Playback menu
Here you can preview your current travel route.

Place the mouse over the icon (do not click) to adjust the length of the animation.

Current
position

Provides a preview in which you can move along your travel route. Use the slider to
move along the travel route.

Animation
duration

Move the slider to adjust the length of the animation.

Constant
speed

Every part of the route will be traveled with the same speed. Uncheck the box to set
the animation time for each location individually.

Use the keyboard shortcut Ctrl + spacebar to play and pause the animation.

Map (Start screen)
Click on "Map" to return to the start screen and select another map. You can use this feature to change
the map (e.g. from standard to satellite) used for a travel route — even routes which you've already
created.

Back to main interface Click here to return to the open travel route.

Load existing project Open an existing MAGIX Travel Maps project.

Search
If you are using a real map (e.g. from OpenStreetMaps), you can search for locations and save them as
locations in the map.

To add a destination using Search, enter an address in the search field, select one of the listed results
and then press the "+" icon.
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Path & Avatar
Use this menu item to edit each individual location as well as the entire route.

Click on the pencil on the left side and select a single location or the complete
route. The coloring of the buttons indicate which section is enabled for editing.

Path & Avatar
Complete
route

Settings for the complete route.

Location list A list of all locations with various settings options for customizing each location.
Click on the location description field to change the name.

Change path properties

The path properties can only be changed for the complete route. These can be found under "Path
& Avatar" > "Complete Route". Then, activate the path properties symbol on the right.
"Draw curves" lets you create paths with soft, curving lines. You can also adjust the width, color,
transparency and shadow of paths the way you want.

Customize location properties

These properties can be customized for individual or all the locations (complete route). For
instance, you can set location symbols, adjust their size, set the duration of a location during the
animation, select font and much more.

Fade in/out or delete the route or individual locations:

Click on the eye icon to hide all or several locations. The location will remain in the list, but will be
hidden on the map and will not appear in the route. Click on the eye again to display the location
(s) again.
This removes the entire route or just a certain location and then adjusts the route.

Customize avatar

Choose an avatar for the entire route or for individual locations. You can change avatar as much as
you like along your travel route. For example, you can start your trip by plane and later continue it
by car.

Align to path

This option can be enabled for 3D objects such as cars and airplanes to ensure that the object is always
pointing in the direction of travel, even on curves.
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Load and export GPX tracks

You have the option to save your route as a GPX file and import routes created on navigation devices or
in GPS programs. MAGIX Travel Maps supports the following formats: gpx, kml, kmz, tcx and trk.

For example, you can export a route created with Google Maps as a .kml or .kmz file and import it into
MAGIX Travel Maps to create an animation of your journey.

Tips for designing routes:

Adding additional locations:

If you have already created your travel route and want to add locations later, click on the desired
location on the path and a location will be added.

Moving locations.

If you want to move a location, move the mouse to the bottom of the location until the
mouse pointer changes and a highlighting circle is displayed. Move the location by left-
clicking the mouse and dragging it to the desired position.

Depicting "meandering paths":

Use hidden locations to create non-linear routes. That will allow you to depict "meandering paths".

Complex routes with several locations:

If you want to create a complex route with several locations, first create the entire route and then
specify "Hide all locations" under "Path & Avatar > Complete route" > "Location properties". Then,
switch to the location list and unhide the most important locations individually.

View
You can add frame and height profile to your animation to customize its appearance.

Elevation profile Enhance your route by adding information about the elevation profile. To
do so, you will need geodata from a gpx file.

Click Edit to customize the appearance of the elevation profile.

Click Save to save your custom configuration.

Click on Open to open a saved configuration.

Borders Select a border for the visible portion of the map.
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Animation
You can specify additional details under Animation in the menu.

Behavior

Animate
locations:

Adds a soft fade-in to the location. Use the slider to set the animation duration.

View follows
path:

Makes the visible portion of the map move to follow the course of the path.
When this option is disabled, the map remains static as the animation moves
along the travel route.

Fly-in options

Activate fly-in Start your route's animation by flying in on the map.

Activate the additional "View follows path" option for a more impressive
start to your animation.

Rotation/Skew When using a fly-in animation, you can adjust the angle at the start and end.
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Finish your animation
Export your travel route as an image or video.

Single

frame
export

Takes a single screenshot of the current visible portion of the map, along with your
travel route. Enter a unique file name for the screenshot and select a destination to
save it to.

Export
folder &
name

Specify a target folder and file name for the video you want to export. Click on the
folder icon.

Export
format

You can export the video in mp4 or wmv format.

Resolution Adjust the resolution of the video.

Start

video export

Saves the travel route animation as a video.

Edit video: If this option is enabled, the finished video of the travel route video is opened in the
linked program for further editing. You can specify the associated program in the
Tune-ups (⇗183).

If the program is open in the background, another window will be opened after the
export. The route will not be automatically inserted into an open project.
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Tune-ups
You can access the program settings via the start screen ("Map" menu).

Smooth
GPX data

By activating GPX data smooth, intermediary points will be calculated and added to
the GPX route. This provides a smooth and fluid animation, but can cause a loss to
performance for routes with a lot of locations.
n Auto searches for the best method of interpolation for the given track

(recommended).
n No smoothing - no interpolation
n Maximum smoothing - minimum distance between locations is used as

basic interpolation (poor performance)
n Moderate smoothing - arithmetic mean employs a distance calculation

(locations that are very close to each other but have little relevance are
ignored)

Maximum
animation
duration

The display duration for the animation can be set here. Choose from 1, 5, 10, 30 or 60
minutes.

Edit with Here you can choose from the installed MAGIX programs in which you can continue
to work with the created travel route animation after its export.

Language Select a language for the program. Changes will first take effect after the next
program restart.

Soundtrack Maker

Music tracks that match the mood are generated automatically by Soundtrack Maker. Mood changes
are even possible too.

Open Soundtrack Maker via "Edit" > "Wizards".

1. Choose music genre

Choose a musical style first.

The option "Apply to selected range only" limits the length of the background music you want to create.

Note: The "Apply to selected range only" function will only work if an emotion has not been set
outside of the selected area. Otherwise, the soundtrack will be used up to the point where the selected
emotion is in place, so that there are no gaps in the soundtrack.

Range start and end may be set with the left and right mouse button if Soundtrack Maker is open.
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2. Set mood change

You can select a mood from the list.

Preview: Here you can preview your selected emotion.

Position:With the position slider you can go to a certain position to set the emotions at a certain
position. The playback marker may be moved instead with the left mouse button. The preview will be
displayed in the program monitor simultaneously.

Add emotion: This button inserts the selected mood at the current position. Soundtrack Maker will then
suggest a new position for the next emotion by repositioning the position slider. You can also position it
elsewhere and add different moods.

Delete emotion: Removes the currently set emotion.

3. Generate background music

Clicking "Create soundtrack" creates a new soundtrack. "Progress" shows the current status.

Note: Soundtracks you create are beat-based. In most cases the length of the soundtrack will not
match the marker positions, so that the track can play. These are frame-based and as such, can be set
to a more precise grid than a beat-based soundtrack.

Variations: If the background music that has been created is not suitable, a variation may be created.
This process may be repeated for the entire background music as well as for individual emotions:

n If you want to vary the entire background music, then click on "Create variations".
n If you only want this to apply to a certain emotion, then move to it with the position slider first

in the dialog (or the play marker on the main screen). Then activate the option "Vary only
selected emotions". Now click on "Create variation".

Automatic clip adjustment: This option re-arranges the video and photo objects in your project to
match the music. Make sure to deactivate this option if you do not want this function.
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ADDITIONAL FUNCTIONS AND TOOLS

Markers

Keyboard Shortcut

In MOVIE STUDIO you can set various types of markers within your project.

The Lock button (at the very front, next to the time ruler) lets you lock all markers (jump markers,
chapter markers) against accidental moving or deleting.

Playback markers
The playback marker indicates the point from which the material – either the project or a selected file
from the Media Pool – will be played back. There is a playback marker below each project monitor and
an additional one above the timeline in the project window.

The playback marker is displayed as a red triangle below the monitors. In the project window it is
displayed as a red triangle.

In order to move the playback marker, double-click on the desired area below the monitor. Alternatively,
you can move the playback marker by dragging it with the mouse. While being moved, the current
image will appear on the monitor, letting you see where in the material you are located.

The playback marker in the video monitor can also be moved by clicking on the lower section of the
time scale in the project window. The playback marker will also be moved on the program monitor, as
both markers are coupled to each other.

The exact position of the playback marker can be seen in the time display at the top left, below the
corresponding monitor. There, you can change the displayed values (Hour:Minute:Second:Frame) per
mouse click to reach a certain point in time. Enter the desired value and the playback marker will jump
to the corresponding position.

Tip: In the "Playback" tab under "File -> Settings -> Program", you can set whether repeatedly
pressing the space bar during playback resets the playback marker to the current position or moves it
to the original position.

Project markers

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.
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The "Edit" menu or the keyboard shortcut "Shift + numerical keys 1-0 (0 for the tenth marker) allows
you to set a project marker at the current position of the playback marker. These function as a mental
marker or indicate certain positions or events within the project.

After selecting the menu item, a dialog appears to input a name for the marker to be created. The first
ten project markers may be accessed via Ctrl + number keys 1-0.. This allows you to jump to a particular
position of a longer video immediately, without scrolling and searching.

Project markers may be deleted or renamed via the context menu at any time. This does not provide
direct influence on the result, but they do make the workflow much easier.

Snap markers and transients

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Objects, object edges, markers or the playback marker will jump automatically to particular "Key
positions" when you move them close enough with the mouse. This is called "snapping". Select a
location in the object with a snap marker to indicate where another object should snap in. This can be
helpful, for instance, if you want a title to be shown at a specific position in a video object. You can find
the "Snap Marker" in the Media Pool under "Effects" > "Audio effects".

Set snap markers

n To set a snap marker, select an object and place the playback marker at the position where you
want to place the snap marker.

n Now click on the button "Set snap marker".
n You can move a snap marker with the mouse using drag & drop.

You can set as many snap markers as you like per object.

Align snap marker with transients

Transients are signal peaks in audio material that can also appear in video footage; e.g. a door slamming
shut. Transients in video footage can be used as a starting point for editing - for instance, fading in a title
or making a picture-in-picture effect appear. The "Align snap marker to transients" feature analyzes the
signal peaks of the selected object and sets snap markers to these locations. This moves snap markers
that have already been put in place near the transients into the new locations.

Note: Combination objects must be displayed separately so that transients can be seen clearly. In the
context menu of the combination object, select the command "Audio functions" > "Video/Audio on
separate tracks". Snap markers are set independently of this setting.

Delete all chapter markers
A chapter marker defines the beginning of a new chapter. Chapters serve to improve navigation when
burning the project to disc. The following options are provided via "Edit > Marker" or by right clicking on
the playback marker.

MOVIE STUDIO 2023 | MANUAL

Additional functions and tools Markers 186



Set chapter markers

Places a chapter marker at the position of the playback marker. This creates a chapter entry in the
disc menu in case the movie is being burned to disc.

You can rename the chapter markers by right clicking and selecting "Rename" in the context menu. The
new name will also appear in the chapter menu.

Set chapter markers automatically...

This option automatically sets chapter markers in the project according to specific rules that will then
appear as chapters in the film menu of a disc. This is useful if you need to burn a disc immediately after
recording.

At the beginning of a movie: The movie contains only one chapter

At object starts in a track: Every object in a track creates a chapter, Track 1 is preset.

At the position of existing title objects: Subtitles, for instance, as faded-in subheadings, give the
position of the chapter markers.

Provide interval (in minutes)/provide quantity: If the chapters are separated without any particular
method and are just needed for quicker navigation, chapter markers may also be inserted in pre-defined
intervals or as a pre-defined number of chapter markers.

Naming chapter markers

No marker name:Marker name and marker number are not specified.

Custom: You can use a custom name. A sequential marker number will be attached to it.

Apply object name: The marker name is taken from the object name and the text in the text object. No
sequential marker number is specified.

Options

Delete existing chapter markers: Deletes chapter markers that have already been set.

Only take the selected area into account: The chapter marker is automatically set to the area between
the start and end markers only.
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Delete chapter markers/delete all chapter markers

Delete one or all chapter markers. This removes chapter entries in the disc menu if the film is burned to
disc.

Range markers(In & out points)
Range markers are the "in points" (range start) and "out points" (range end). They are used in the
monitors to highlight a particular area that can be played with the "Range playback" button below the
corresponding monitor.

To the left, you can see an in point (range start), and an out point is visible (range end) to the right

Note: The value between both markers shows the length of the selected area according to the pattern
Hours:Minutes:Seconds:Frames.

Change playback range

There are various options for changing the playback area and the start/end markers.

Move entire range

n Press and hold the Ctrl key.
n Click in the blue area between start and end markers.
n Move the mouse to the left or the right while simultaneously holding the Ctrl key and clicking

and holding the left mouse button.
Move range borders:

n Click one of the markers in the upper bar in the project window and drag it.
n Click on one of the markers below the program monitor and move it to the desired position by

dragging it.
Reset the range edges

n Operation with mouse and keyboard: Set the playback marker at the desired position and
press "Set start of range (in-point)" or "Set end of range (out-point)" underneath the program
monitor to set the in and out points of the range.

n Start of the range using the mouse:
Left-click at the desired position in the top bar of the project window.
The beginning of the range will be set at this position.
If you click behind the end of the range, the playback range will be set to the entire length of the
movie.

n End of the range using the mouse: Right-click at the desired position in the top bar of the
project window.
The end of the range will be set at this position.
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If you click in front of the end of the range, the playback range will be set to the entire length of
the movie.

Scene markers
Scene markers separate a complete video into scenes. You can load any video into MOVIE STUDIO and
have it divided into scenes.

Load the desired video into the project window. Then, right-click on the video and select "Scene
detection". The following dialog appears:

After clicking »"START SEARCH"«, an overview of the detected scenes will be displayed underneath
the scene control.

Delete scene markers: Here you can delete individual markers by selecting them from the list.

Delete all markers: Deletes all project markers.

Action on OK: You have three options. Either MOVIE STUDIO splits your video into individual scenes
("Cut at all markers"), a scene is selected and cut only at this position ("Cut at selected marker"),.

After deciding in favor of one of these options, red scene markers will appear on the timeline in the
project window. The scenes can then be split according to the selected option and edited.

Note: An important difference between a scene and a chapter marker is that a scene marker can be
set only within a continuous video, while a chapter marker can include several consecutive videos.

More information about Scene recognition can be found here.

Split and trim

This function refers to the editing and structure of sound and image material for the finished film. It's
also known as cutting, because the process used to involve the cutting of celluloid strips using a scissors
on a cutting table and then manually sticking back together again. With digital material and MOVIE
STUDIO cutting these days is a much easier, non-destructive process.

In this section we'll explain digital cutting technology and how to trim cut material. Also covered under
this topic are transitions, which can be used to combine cut material together again.
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Simple cut
All objects can be split. Each object section then becomes an independent object:

n Select the object to be cut.
n Position the playback marker at the position where the movie is to be cut.
n Select "Cut" among the cut functions in the toolbar or press the T key on the keyboard.

Cut button: Here you can choose between various Cut modes.

In order to rejoin these split objects at a later stage, simply select the individual parts and select the
command "Group" to join the selected objects into a group. Orders all selected objects into groups.

Note: If the commands "Split" and "Remove beginning/end" are applied without a selection, all
objects at the position of the playback marker are cut.

Separate sound from videos
Normally, videos are edited together with original sound to ensure that the appropriate sound is always
played back in sync with the video. This is implemented in MOVIE STUDIO by grouping the video
object with its respective audio object and displaying them together on one track by default.

Videos with audio material appear in the project window as a combination
object (audio and video in one object).

You can separate audio and image material:

1. Right-click on the the object.
2. In the context menu, select the command "Audio functions" > "Video/Audio on separate tracks".

Result: The audio object and the video object will be displayed as an object group on two tracks.
3. Select the object group.
4. Open the "Edit" menu and select the "Ungroup" function

- or -
select the corresponding button on the toolbar.
Result: The objects are ungrouped and both can be edited independently of each other.

The objects can be regrouped together using the "Group" function.

J-L Cuts

Audio and image material can also be separated temporarily. A popular editing technique, for example,
is to introduce a small portion of the audio of the next scene before showing the picture (or vice versa).
The resulting shape of the object arrangement is reminiscent of a J or L, hence the name.

J-L cuts lets you perform edits like these without having to ungroup the video from its original audio
track:
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1. Hold down the »ALT KEY« and click on the outer edge of the audio or video object. The program
will switch to"J-L" editing mode.

2. Move the edge so that the audio and video objects no longer start and end in the same place.
Result: The grouping remains the same, but the lengths of the audio and video tracks can now be
modified independently.

If you drag out one of the objects to the length of the other, the edges will snap together and "J-L"
editing mode will end.

Trim objects
Trimming indicates exact setting of object borders or transitions. MOVIE STUDIO has two different
trimmers, which can be opened using the context menu of a video or image object.

General advice for operating both trim editors

Play functions: The trim window contains its own play functions that allow the object to be played
individually or in relation to the projects.

The right play button plays the project normally. Replays can sometimes appear shaky because the
processor may be over-worked. Those frames that the processor cannot calculate quickly enough are
left out.

The middle play button plays the arrangement “frame by frame”, which means no frames are left out.
Depending on the processor load, playback may thus be slower, but still smooth.

The left play button renders material before playing, i.e. the current settings are calculated first and
then exported. This method ensures a smoother playback.

With the fast forward and rewind functions you can change the range start in the timeline. This allows
for complete control of transitions between two videos.

Increments: A click on the arrow buttons in both trim editors moves the handle or the material within
an object exactly by one frame. With the Ctrl key you can increase the frame rate gradually to 5 frames
per mouse-click.

Edit trimmer

A schematic display of the selected transition and its handles can be found at the center of the trimming
window.
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Left arrow button (1): This button moves the last frame of the first object while adjusting the second.
The length of the transition remains. The display indicates the relative change in comparison with the
starting situation when the trimmer was opened.

Position (2):Moves the second object. The length of the transition is changed. This corresponds to
shifting an object in the project window.

Object content (3): This moves the movie “underneath” the second object. This is done without
changing the length of the object and the transition.

Crossfade (4): Changes the transition’s length between both objects. The objects remain of equal
length. The length can be numerically entered.

Middle arrow buttons (5): Shifts the existing transition. Both objects remain in their positions, only the
transition’s center point moves.

Transition (6): Displays the type of transition. A mouse-click opens a pop-up window from which you
can select a transition.

Right arrow buttons (7):Move the first frame of the second object. The first object and the transition
remain. Only the length of the second object changes.

Start fade out/last frame (8): Switches the left monitor between the start of the transition and the last
frame of the object.

First frame/End fade in (9): Switches the right monitor between the first frame of the following object
and the end of the transition.

Next cut (10)/next object (11): The buttons below and to the right skip to the next/previous object
and/or cut in the arranger. These buttons make it easy to move and trim cuts in the project without
having to leave the trimmer.

Object trimmer

A schematic display of the selected object and its handles can be found in the center of the trimming
window.

Fade in/out (4, 5): These buttons adjust the upper fade handles of an object.

Object content (3): Here you can move the video material that is to be played without changing the
object length.

Position (2):Moves the object on the track.

First frame/End fade in (7): Toggles the left monitor between the first frame of the object and the end
of the transition.
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Start fade out/last frame (8): Toggles the right monitor between the start of the transition and the last
frame of the object.

Left/Right arrow buttons (1, 6): Adjusts the lower object handles.

Next object/cut (9, 10): The buttons below and to the right skip to the next/previous object and/or cut
in the project window. These buttons make it easy to move in the project and trim objects without
having to leave the trimmer.

Move the contents of trimmed objects
Use the "Move object content" mouse mode to move the content of a trimmed object within the object
borders.

This function is particularly helpful when you don't want to mix around the arrangement of objects, but
want to have an object begin with a different first frame.

1. Select the trimmed video object.
If the video has not been trimmed, the video object contents cannot be moved, because the
entire video will be shown.

2. Use the »"MOVE OBJECT CONTENT"«mouse mode and drag the video object content to the
left or right in order to move it.

Alternatively, you can use the object trimmer for frame-accurate positioning of content.

Transitions
When importing video files into the project window, individual objects usually follow directly after one
another. This is called a "hard cut". However, you can make scenes blend or “transition” into each other.

This means that for the duration of a transition, two objects are shown at once and can be mixed
"faded" together in different ways. You will find numerous blends in the Media Pool’s transition folder.

Simple crossfade

A simple transition can be created in the project window by dragging one object over another. A
crossfade will be created automatically. During this standard transition, the brightness of both objects
are added together; the first clip fades out while the second clip fades in. The duration of the crossfade
is displayed in the project window by white crossing lines. You can adjust the length of the crossfade by
dragging the upper handle of the second object to the left or to the right.
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Transitions from the Media Pool

Tip: Use transitions sparingly. Look closely when you are watching movies in the theater or on TV.
You will notice that hard cuts are used as a rule and transitions are used less frequently. Videos
appear unprofessional and too ornate if transition effects are added to every change of scene.

n To open the transition folder, click on the "Transitions" button in the template folder located in
the Media Pool.

n Double clicking on an entry provides a preview of the transition.
n Drag the transition you want onto the border between the two objects. Only when the mouse

pointer is placed over a scene change will it turn from a lock icon into an object icon, i.e. you can
place the transition at that position. The object at the back will be shifted to the front to
accommodate the duration of the transition.

Most transitions can have any length, and if a transition is shortened, it means that the resulting effect is
speeded up.

Some transitions can be set even more exactly. To do so, click on the transition icon again and select
"Settings..." at the bottom of the menu. Thus, a transition icon in the Media Pool can represent an entire
group of different effects.

The so-called alpha transitions (in the subfolders "Mold and Objects" "Iris", "Random", etc.) are actually
pre-produced black and white videos that are combined with the alpha keying effect to be used as
transitions.

Other transitions use sound effects. Look around at all the contents to form an idea of what you can use
in future projects.

Custom fades with Alpha-keying

Alpha keying extends the range of transition effects used in MOVIE STUDIO to produce black & white
movie transitions or selected color fade-ins and fade-outs. You can create such a video from any video
material (also color) by exporting it as a transition (File > Export movie > Export as transition).

The loaded movie is then exported as a black and white video in mxv format and stored in the fade
directory. Afterwards, it will be available in the Media Pool and the fade menu.

3D transitions

3D effects offer exciting and varied opportunities to create transitions between two videos.

The following transition settings are available:

Anti-aliasing: An undesirable step effect is usually created at the borders of 3D objects. Anti-aliasing
reduces this effect, but also requires more computer power. The setting applies globally to all 3D fades,
switching on anti-aliasing during 3D fades has the effect that all other 3D fades are also affected by this
setting.
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Horizontal/Vertical mirror: Use these options to influence the path of the 3D objects within the fades.
"Horizontal" mirrors the movement of the object horizontally, i.e. along the X-axis. "Vertical" mirrors the
movement of the object vertically, i.e. along the Y-axis.

3D series

The 3D series are a further development of 3D transitions, where the transitions are thematically sorted.
For instance, you can let photos appear on a notice board or make it look as if the photos were hung on
the walls of a gallery.

n Click on "Templates" > "Transitions" > "3D series" in the Media Pool. Select the desired 3D
series and drag it onto the first scene or image transition where the 3D series should start.

You can select how many of the subsequent fades should be replaced by the 3D series in the dialog.

Musical editing adjustment and BPMWizard

Behind the "Musical editing adjustment" option in the "Edit" menu allows the possibility to adjust an
existing project with cut scenes to the rhythm of a piece of music and turn it into a video clip. It is
necessary that the piece of music contains information about tempo and beat for this function.

n Place a project with video sequences on the top track (track 1) for which Musical editing
adjustment should be made. The project should be as long as the accompanying song and
include plenty of cuts.

n Load the song that is to serve as the basis for the editing adjustment onto a track below it.
n Select "Edit" > "Musical editing adjustment".

In most cases, an info dialog will now appear informing you that there is no beat and bar information
available for the selected audio object.

n Click on the "Open Assistant" option in the dialog.
Then, the BPMWizard "MAGIX Remix Agent" dialog will open.

BPMWizard

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

This tool can analyze the song's rhythm.
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After determining the BPM value (i.e. beats per minute) of the song, the song will be subdivided into
short passages of equal length. The individual objects having the duration of exactly one bar at first stay
grouped, so as not to accidentally "rearrange" the song. Of course, if you like, you can do just that. To do
so click on "ungroup".

The resulting object borders are important for editing. Because all objects may snap to each other on
their edges, videos may be arranged to transition exactly to the beat of the music: the points along the
track where videos lock together are exactly in time with the music.

The analysis takes place in four steps:

Step 1: Checking the start marker

Step 2: Tempo recognition

Step 3: Specifying beat starts

Step 4: Applying BPM and bar recognition

Step 1: Checking the start marker

Before you start the analysis you should set the start marker at the position where the rhythmic music
begins. This means that if the song has a long ambient intro, the start marker should be set after the
intro. If the wizard can't detect any rhythm it will ask if the start marker has been set after the intro. If
not, you can move it to a better position in the dialog.

If the beginning of the song does not have a definite rhythm, you will be asked if you want to move the
start marker.

Step 2: Checking the automatic tempo recognition

The Remix Agent will analyze the audio material and try to determine the tempo. The object is played
back while a metronome click can be heard and numbered green beat lines appear in the waveform.
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Under the waveform on the left side the established tempo is displayed in BPM. There is a small
transport console in the middle to make navigating easier. The slider serves as a position controller. To
set the metronome volume, an additional fader and mute button are provided on the right-hand side.

The automatic tempo recognition doesn't always work right away. If you don't hear the metronome
clicking in time with the music, click the "No" button in the upper section of the dialog in order to access
the manual tempo input dialog.

To correct the metronome speed and any timeshift that may occur between the metronome clicks you
can use the tempo correction as well as the "Tap tempo" button:

Tempo correction: The Remix Agent offers various speed settings. The most probable tempo detected
by the Remix Agent is preset. If this tempo isn't correct, you can choose another one from the list. The
next time you play back the song it should be in sync with the metronome.

On/Off beat correction: Now it may happen that the tempo is right, but the beats have been displaced.
"On/off beat correction" provides a number of alternatives for moving the beats according to the
complexity of the rhythm. Try out various alternatives until the metronome clicks are in sync with the
beat.

Tap tempo: Instead of selecting the tempo under "Change Tempo", you can click rhythmically on the
"Tap tempo" button or press the "T" key. Additional blue lines are displayed in the wave display. After at
least four taps, the Remix Agent attempts to select the correct tempo from the list in "Tempo
correction". The display next to the "Tap tempo" button displays the current status. Keep tapping until
the red display showing "Unlocked" changes to the green "Locked" setting.

Use the "0" key to manually set the quarter beats while the music plays. Surrounding markers will
automatically be removed to ensure that the set tempo remains intact.

You can move the markers with the mouse. If you hold down the "Ctrl" key simultaneously, the
subsequent markers are also moved.

If the metronome clicks now correspond with the music, you can continue to the next step.

Step 3: Determining the start of a bar:

Next you can set the time signature. The default setting is 4/4 but you can adjust this if necessary. The
beat at the start of the bar should coincide with the high sound of the metronome, or the red line in the
waveform display.

It can now be corrected in one step: If the start of the bar can be heard, click on "Tap One" once using
the mouse or press the"T" key on the keyboard.

Alternatively, select how many quarter notes the "One" is to be moved back.

Use the "0" key to manually tap the position of the beginnings of the bars during playback. This allows
you to correct the beginnings of the bars in longer sections.

Continue to the last step if the starts of the bars are now correct.

Step 4: Applying BPM and bar recognition

Select which action should take place:
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Create remix objects mode: The object is positioned in the remix object according to bar length. What
"Audio Quantization" is activated, remix objects are precisely arranged on the bar grid. The remix
objects can then be re-organized in a different rhythmic sequence, mixed with loops or remix objects
from other tracks etc.

Tempo adjustment: If the object and arrangement tempo are to be aligned, you can either adapt the
object tempo to that of the arrangement via timestretching or, vice versa, you can change the
arrangement tempo to that of the object. As most music has slight tempo fluctuations, the time
synchronization is often not perfect: After some time the arrangement and the music "drift" apart. If the
object tempo is to match the arrangement tempo, this can be prevented using audio quantization.

Save only tempo and beat information: Tempo and beat information will be added to the audio
material, object and VIP are unchanged. The images on track 1 will be repositioned according to this
information.

Automatic scene detection

In the "Effects" menu automatic scene recognition can be opened. The scene recognition function plays
each video and scans it for drastic changes in color or movement.

Note: In film speak, people talk about takes, i.e. sequences filmed continuously at one time.

Digital video “time stamps” (points in time at which the device was switched on and off) are also
recognized as separate scenes.

n Click on the "Start search" button located below "Scene change".
The search for possible scene transitions will then start. If you have a large amount of material,
this can take a while, but the image analysis has to be done just once for each recording. The
results are saved together with the video file.
If the scene recognition is performed again with the same source material, the scene transitions
found are immediately displayed. If you are still not happy with the resulting scene partitioning,
simply repeat and correct where necessary.

n All found scene transitions in the list can be checked in the dialog. Every scene marker can be
selected or deleted. Select a scene transition from the list of found scene transitions and use the
preview images to check whether the found transition is really a scene change or not.
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Tip: This option is helpful, for example, if a camera flash was captured in the source footage. The flash
from the camera would cause a sudden brightness modification even though there was no actual
scene change.

The preview always displays the end of the previous scene and the beginning of the new scene. If the
images do not differ except for the brightness, the scene may have been falsely recognized. In this case
select "Delete scene marker".

Via the zoom +/- buttons you can enlarge the part of the project window where the selected scene
begins or previous scene ended.

You can use the "Sensitivity" controller to change the sensitivity of the scene recognition, so that
different scene changes can be found depending on the setting.

With "Action on OK" you can specify whether the movie should be cut at the selected scene transition.

Preview rendering

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

With MOVIE STUDIO, you can pre-render specific sections of your movie. This is especially useful if
smooth playback is not possible due to the applied effects and transitions. The advantage versus the
option "Combine audio and video" in the "Edit" menu is that all of the objects will be maintained in the
project. The rendered material will only be played in the background when the playback marker reaches
the corresponding position.

Preview rendering is available in timeline mode and multicam mode.

Note about multicammode: Only the source tracks will be rendered, not the target tracks.

MOVIE STUDIO offers two options:

n It can automatically indicate all sections that can be rendered.
n Or, alternatively, you can indicate the section that should be pre-rendered manually.

Automatic preview rendering
When using automatic preview rendering, you don't have to think about which sections could be
affected. MOVIE STUDIO analyzes your computer's performance and determines which sections can
be considered for preview rendering.

To perform automatic preview rendering, proceed as follows:

1. Click on the preview rendering button in front of the timeline.

MOVIE STUDIO will then analyze which sections should be pre-rendered.
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A dialog will appear, indicating how many areas have been located:

These sections will be additionally marked in the MOVIE STUDIO timeline using red bars.

2. Select "Yes" in the dialog to start preview rendering.
The red bars will appear green after preview rendering is over. If you make changes in the pre-
rendered section, it will appear red again and will have to be updated.

3. If you choose "No" instead, you can still conduct preview rendering later.

Manual preview rendering
In manual preview rendering you first have to select a range that contains problems with hanging,
choppy preview playback.

1. Place an in and out point above the range to be rendered.

2. Finally, click on the "Preview rendering" button. A preview rendering dialog will appear.

3. Selected "Section".
The preselected range will now be rendered. After rendering, a green line appears in the timeline to
symbolize that this range has been rendered.

The section will remain green as long as no further changes are made to it. The green line will then turn
red and can be updated again.

Update preview rendering
Preview rendering is effective only as long as no changes are made to the pre-rendered area. You can
recognize a prerendered area from the green bars appearing above it on the timeline. As soon as an
object in the section has been edited, the green bar will turn red. You can update this section at any
time.

1. To do this, place the playback marker inside the section to be updated.
2. Click on the "Preview rendering" button.

MOVIE STUDIO 2023 | MANUAL

Additional functions and tools Preview rendering 200



3. In the preview rendering dialog select "Section" in order to update just the section selected by the
playback marker.
If you select "All", all non-rendered (red) sections will be rendered.

Using proxy files, proxy editing

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

If performance deteriorates and playback becomes shaky due to hardware limitations, hi-res source
material or very complex projects, it is recommended to use proxy files for editing. Lower resolution
copies of the original file in a format that is better for playback are created and used for the editing
process. The original files in a higher resolution are then used for the export process by default.

Create proxy files

This feature is disabled by default. When this option is activated, proxy files will automatically be
created for all video files imported to the project window project folder. Proxy files are not created for
the preview on the program monitor.

n Enable the »CREATE PROXY FILES AUTOMATICALLY« option under »FILE > SETTINGS >
MOVIE. > GENERAL MOVIE SETTINGS«.

The rendering process can be canceled by pressing the Esc key.

Notes:

n Make sure there is sufficient memory available if proxy files are going to be created.
n It is not possible to create proxy files on an FAT file system (such as on an SD card) so the

source material for proxy files should be saved on an NTFS drive (Windows standard).

Use proxy files generated

n Right-click on the button in the program monitor»USE PROXY OBJECTS« to use proxy
files.

This is useful during proxy editing if you want to quickly check how an effect will look on the original
material.

Multicam Editing

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Multicam editing enables easy cutting of various recordings of the same scene from different camera
perspectives.

The program monitor shows the image material from up to 4 sources next to each other, from which
the "program" can be cut in real time using your mouse – just like in a real studio.
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Preparation

Multicam editing is a special mode in the project window. The top two tracks serve as target tracks for
copying sound and video from two different source tracks. The two most upper tracks need to therefore
be empty when changing into multicam mode, if required the objects will be moved onto another track.

First you can load various video recordings of the same scene one under the other starting on track 3 in
the arranger.

It is important that the individual sources are synchronized to each other exactly. It is best to find a
noticeable movement, or some kind of audio cue if sound was recorded.

Note: To localize the sound in the audio track exactly you will have to create a wave display of the
track. To do this, right-click on the audio track and select "Waveform display".

If you have one, you can use a clapper to signal the start of a scene. If not, simply having one of the
"actors" clap their hands can have the same effect. Set a snap marker in each source object, with to-the-
frame precision. You can now move the source objects over each other, so that the grid points are
aligned.

In each case two video sources with audio tracks can be automatically synchronized using their audio
material. To do this, use the "Align with other audio objects" function in the audio object context menu.

It is also important that you carry out all output material effect processing (e.g. video or audio cleaning)
on the objects on the source tracks and master audio track before the multicam cut. These object
effects are transferred to the object in the target track when editing. Otherwise, you will have to apply
the effects from every single object to the target track.

You can activate "Multicam" mode with this button or with the "Multicam" command in the "Edit"
menu.

Source tracks and preview images
The source tracks for multicam editing will be selected automatically. When the multicam mode is
activated, the source tracks will be assigned to all tracks containing video objects starting from track 3.

You can also conduct or change the assignment manually. To do so, right click on the trackbox of the
corresponding track to active or deactivate a track as a source track.

The source tracks are marked using color.
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A preview appears in program monitor for every assigned track, and the source track's color
corresponds to the frames around the preview images in the program monitor so that you can quickly
assign each preview image.

If the objects created using multicam cut are located on the target track, a preview image of the
corresponding source track highlighted with a yellow frame will be shown for length of playback.

Multicam edit functions
You can edit various sources in the the target track during playback in real time or during stopped
playback.

Real-time multicam editing

You can edit various sources together during playback in real time:

1. Start playback.
2. Click the desired source in the program monitor. The corresponding video is added into the target

track starting from this time point.
3. To switch the source, click in the program monitor on another source. A new object will be

created using another source from this point in the target track.
4. You can repeat this process as often as you like.

For precise editing in the target track, use the usual edit functions or the Trimmer. Bear in mind only to
move the object borders and not the objects themselves as long as you are in Multicam Cut Mode.
Gaps or jumps can arise if you use the Multicam Cut functions again afterwards.

Replacing an object's source

Replacing the video material of an object in the target track with another source:

n Select the object in the target track for which the source is to be replaced.
n Click on the source in the program monitor that should replace the video material in the object.

The video material will now be replaced by the new source. The object length is not changed.

Insert cut

Insert material from one of the sources between any position on the target track and the next object.

n Place the playback marker on the desired position.
n Click the desired source in the program monitor.

The material from this source will now be inserted into the target track. The new object ends at the next
object. The portion below an existing object is overwritten in the process.
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Overwrite range

You can overwrite a selected area of the target track with one of the source videos.

n At the upper edge of the project window, select an area to edit by determining the in point by
clicking with the left mouse button and the out point by right-clicking. Or use the corresponding
buttons in the transport control.

n Click the desired source in the program monitor.
n The target track will be overwritten with the video material from the selected source in the

selected area.

Master audio track

Normally, videos in the source track are edited together with their audio tracks. Since the original sound
can differentiate from camera to camera due to different camera positions, you will probably prefer
using either the soundtrack from only one camera for all settings, or to replace the soundtrack
completely. (For music videos, for example, you will use the studio version of the original track).

Right-click on the track box of one of the source audio tracks or a different audio track and select
"Multicam: master audio track" from the context menu to assign a master audio track for multicam
editing. The master audio track will be appear in a dark color.

Now, during every multicam cut, material from the master audio track will be inserted on track 2,
independent of the source track used.

Synchronize video objects using the audio track
Video objects can be synchronized using their audio tracks. This is done by comparing the audio tracks
for similarities. If videos come from the same recording environment, the same acoustic events will be
found on their audio tracks (e.g. the sound of the clapper board).

Synchronization of multiple objects on one track is possible.

n First, on the reference track, select all audio objects that are to act as reference positions.
n Then, on another track, select all audio objects that should be moved.
n Choose the "Align with other audio objects on this track" function from the audio object context

menu.

Note: If the desired audio track is found in a combination object, you will find the "Align with other
audio objects on this track" option in the "Audio functions" submenu.

MOVIE STUDIO attempts to locate the acoustic events in the reference objects of the second track and
to move these to the corresponding position. Because the audio objects are grouped with their
corresponding video objects or comprise a common object, videos are synchronized in the process.
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Image optimization for individual objects

The context menu features various adjustment options for selected video and image objects.

Right-click on the the object in the project window.

Interpolation
for interlace
footage

Choose this option to remove interlace artifacts from your video image. If, for
instance, you extract still shots from a video, interlace artifacts appear in sequences
which feature movement.

Anti-interlace
filter

Choose this option to remove interlace artifacts from your data. This filter reduces
line flickering during TV playback.

Border
cropping
adjustment

Select this option if the edges are cropped during playback on your television. The
values defined under "Film effect settings" will be applied.

Object tracking
Attach to picture position in the video

You can attach an image object or a title to moving image content of a video, which is known as object
(or motion) tracking. The attached object (overlay object) automatically completes the movement of
the image content from the video. For example, you could use this method to insert a hat that stays on
someone's head throughout, even if the person hops through the picture.

1. To do this, switch to Timeline Mode (⇗43).
2. Insert an image object on a track below the background video (reference video).

Make sure that the reference video and overlay object are positioned on different tracks in
parallel. You should also ensure that the reference video is on a track above the overlay object.

3. Move the object to the desired position in the reference video and resize it if necessary.
Size/Position/Rotation (⇗119)

4. Right-click the image object and select »ATTACH TO PICTURE POSITION IN THE VIDEO«.

Note: If you want to attach two objects, e.g. a title and a speech bubble, an additional dialog
appears, which lets you select the objects you want to attach to your video.

5. Select an image range in the program monitor, which you would like to use for the movement of
the overlay object. Use the mouse to draw a frame around the image content you want to track.
The movement of the object will then be tracked automatically.

Create Panorama

This special feature can be applied to selected photos by going to »"EFFECTS" > "VIDEO OBJECT
EFFECTS" > "CREATE PANORAMA"«. Using it, you can combine several photos into a wide
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panorama photo.

Tip: It's a good idea to optimize your photos beforehand so that the transitions can't be seen in the
finished panorama.

1. Load all necessary images into the film project. The images that should make up the panorama
should be selected one after the other while holding down the Ctrl key. Select the entry
»CREATE PANORAMA« from the context menu.

2. Sometimes photos are accidentally loaded in the wrong sequence. To sort the photos properly,
click on the »INVERT SEQUENCE« button.

3. If you click on »CREATE« the panorama image will be processed. Depending on the resolution
and number of original images this may take some time. The original photos are replaced in your
slideshow with the panorama image in the movie. The original files on your hard disk are not
affected.

Note: You can use up to six images to create a panorama image. Click on »MORE OPTIONS«, to find
out more about the upgrade.

16-bit deep color support

The color depth support in MOVIE STUDIO expands available color depth in internal editing from 8-bit
to 16-bit per color channel and can theoretically reach over 281 billion color nuances.

Background knowledge:

Color depth is determined by the number of displayable color nuances. The number of nuances is
measured in bits and is known as the color depth of an image. The more nuances or bits are detectable,
the more brightness levels and color nuances can be displayed. This increase reduces ugly zigzags in
color gradients.

8-bit processing is currently the editing standard for DVDs, Blu-rays and most TVs and monitors.
Everything above was extremely difficult to achieve in home and semiprofessional environments due to
various technical limitations such as missing cameras and corresponding playback devices.

Furthermore, several video codecs and image standards use the process of color subsampling for data
reduction. There are different methods of subsampling, which make different selections when sampling
the color signals. Any perceivable loss of quality is quite minor.

The first internal color grading workflow processes in MOVIE STUDIO have already been switched from
8-bit to 16-bit deep color. Eventually, all internal processes will be switched to 16-bit. Effects such as
TimeStretch, DoFlip, Saturation, Fade and Crossfade are already supported.

Notes:
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n 16-bit requires more computing power.
n Material that has very similar hues and saturations profit enormously from additional color

depth
n In order to display and transmit color depth correctly, all devices (TV, Blu-ray player) as well as

the connection cable must support deep color.
Supported formats with deep color support in MOVIE STUDIO

Import

Video: AVC, HEVC

Photo: TGA, PSD, TIFF and RAW up to 16-bit

Export

Video: HEVC

Export movie, Menu (⇗210)
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FINISH MOVIE, DIALOG

Open the Export Wizard, which features the most important export options for your videos.

Please note that you will only export the current movie. Other movies in the project and the disc menu
will not be exported.

Upload to Vimeo

This option allows you to upload your movie directly to Vimeo.

First, log in to Vimeo.

Title: Enter the name of your movie here.

Description: Create a short description of your movie to describe it to other members of the
community.

Keywords:Enter terms to help users find your video (in addition to the description).

Send: Select whether the film should be private, accessible only to you and authorized persons, or
public – in other words freely accessible.

Export settings: Set various quality settings.

Output as video file

With this option you can convert a movie including all objects, effects settings, fades, texts and others
into a video file and save it to a computer.

Select a quality level (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog provides further
information about the properties of your selection. Please note that MOVIE STUDIO also adjusts quality
when you change file format if the right quality was not selected for your chosen format.

Note: Only the most familiar formats are listed as options. All available file formats are listed under
"File > Export movie".
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Export to mobile device

You can also transfer your project to mobile devices.

n Click on "Export to mobile device" in the export dialog.
n Select your mobile device from the list.
n Click on "Save video".

MOVIE STUDIO now creates a video file. You can keep track of the progress in a dialog.

A dialog will open as soon as the export is completed:

n If your mobile device is connected to your computer, click on "Folder".
n Select your mobile device and a sub-folder if applicable in the dialog and click on "OK".

Your video will now be transferred to the mobile device.

Upload online

This option allows you to upload your movie directly to YouTube. YouTube is the most well-known
portal for amateur clips.

Community: Select a platform here.

n YouTube
n Vimeo

Note: The following options will be displayed or faded out, depending on which community you select.

Title: Enter the name of your movie here.

Description: Create a short description of your movie to describe it to other members of the
community.

Keywords:Enter terms to help users find your video (in addition to the description).

Category (YouTube only): Select the category for your movie here.

Send: Select whether the film should be private, accessible only to you and authorized persons, or
public – in other words freely accessible.

Export settings: Set various quality settings.

MOVIE STUDIO 2023 | MANUAL

Finish movie, dialog Export to mobile device 209



EXPORT MOVIE, MENU
Keyboard Shortcut

A movie may be exported in different video formats via "File > Export movie". The options available vary
according to the selected format.

Presets: These are typical settings for the selected format for the most important applications.

n Clicking on Save will save your export settings.
n Clicking on Delete will remove these from the list.

Export settings: You can specify general export parameters like resolution, aspect ratio and frame rate.
Select the most frequently used values from the list fields; to set your own values click on the "..."
button. The Advanced button opens the specific settings for the selected video format. File enables you
to export your file to another folder than the default. The option Overwrite file without confirmation option
allows you to execute multiple exports in the same file.

For formats that support deep color, the color subsampling scheme and bits per color channel are also
displayed. In some cases, these may also be variable, if this is supported.

Color space: This will select a color space standard, which affects the playback of the file. BT.709 (also
known as Rec.709) is the current standard and set as default. Change this setting as necessary if you
want the video to comply with other standards and ensure more accurate color display.

Other

n Export selected range only
n Apply anti-interlace filter (suppresses flickering)
n Shut down PC after successful export
n Calculate video effects on GPU

Output after export: Some formats allow special playback options (e.g. DV-AVI on the camera or
WMV export with output via Bluetooth to your mobile phone).

Note: Burning a disc takes place on the "Burn" screen. Read more on this in the chapter "Burning a
disc".

Video as AVI

When exporting to AVI video you can set and configure the size and frame rate of the AVI video and
the compression codec for audio (audio compression) and video (Codec). Please also see the general
information provided on AVI video formats.
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Video as DV-AVI

This option exports the video as a DV encoded AVI. The project can be easily transferred to a
connected camera using a FireWire interface.

The dialog will provide further information on all available options. You can access it via Advanced in the
export dialog. You will also be asked for which video standard you want to export the DV data – PAL
(Europe) or NTSC (USA).

Video as MPEG video

MPEG stands for "Motion Picture Experts Group" and is a high-performance compression format for
audio and video files. We recommend finding a fitting preset from the list first, since there are many
various devices and applications for this format. You will also find intra-frame presets (starting with
"Intra422") for video playback in professional studio environments.

Details on the settings of the MPEG encoder can be found here.

Video as MAGIX video

Exports the project in MAGIX video format.

This format is used for video recording by MOVIE STUDIO video software and is optimized for digitally
editing high quality video material.

Uncompressed movie

When exporting an uncompressed AVI video file you can adjust the size and frame rate of the AVI
video you wish to create. The video material will not be compressed by a codec.

Note This will create very large files.

Video as Motion JPEG AVI

Opens the export dialog for AVI video in Motion JPEG format. This format is supported by digital
picture frames, for example.

Video as sequence of frames

This option exports the video as a series of individual images in bitmap format. This means a graphic file
will be created for each from of the video. The number of images can be set in the export dialog in
"Frame Rate".
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Video as Windows Media

Exports the project in WindowMedia Format. This is a universal audio/video format fromMicrosoft.
Accordingly, the settings options in the "Advanced" dialog are very complex.

Manual configuration

Audio/video codec: Various codecs corresponding to the various Windows Media versions (7, 8, 9)
are possible. Should compatibility problems arise on playback, try an older codec with a lower version
number.

Bit rate mode: Constant and variable bit rates are possible, most devices and streaming applications
require constant bit rates. For VBR two pass modes the movie is compressed in two passes in order to
optimally use the bandwidth for highly-compressed movies for the Internet.

Bit rate/quality/audio format: The bit rate is decisive in defining the display/audio quality. The higher
this is set, the better the videos will look and the larger the files and the required encoding time will be.
For variable bit rates, the bit rate is adapted dynamically to the requirements of the corresponding
picture or sound material. Either the quality value may be set between 1-100 or, for two-pass encoding,
an average or maximum bit rate. For audio, the bit rate is set additionally by the audio format.

Import: For the most common applications (other than for playback on mobile devices, for which you
should use the supplied presets) like Internet streaming, Microsoft provides diverse system profiles to
choose from. If you have the Windows Media Encoder 9 installed, which is available fromMicrosoft as
a free download, you can edit the profiles or create your own. These may be loaded by pressing the
"Import" button.

Clip info enables the title and artist names, copyright details, and descriptions to be entered.

Video as MPEG-4 video

MPEG-4 is actually a collection of highly efficient codecs for video and audio based on the MPEG
standard. Compared to MPEG-2, the same quality can be achieved with smaller file size.

Recommendation: Check the presets that the program offers to find the right preset for each application
and the right playback device. These presets are optimized for typical applications.

Advanced users can make specific adjustments using the advanced settings. More on MPEG-4-Encoder
can be found here.

In the presets there are also various 4K presets for exporting very high resolution material.

Video as HEVC

HEVC is the successor format to MPEG-4. HEVC allows for the same image quality across file sizes,
even when smaller file sizes are used. The improved image quality can be clearly seen, especially at
lower bitrates. More on this topic can be found here.
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Audio as MP3

Note: MP3 export requires Windows Media Player version 10 and up.
The MP3 encoder cannot be used as a codec for the AVI audio file audio tracks.

Options

Set the format and the compression of the audio file here.

Bit rate: The bit rate selection specifies the level of compression: The higher the bit rate, the higher the
quality of the exported audio file. On the other hand, the bit rate determines the final file size: The
smaller the bit rate, the smaller the files.

Mono/Stereo: Most mobile devices have only one loudspeaker. To save on memory, you can export in
mono for these devices.

Normalize: This function should always be activated. It guarantees that the music is not too
loud/overmodulated or too quiet.

Transfer format:

Specify here whether the created file should be transferred via device connected via Bluetooth or via
email.

Audio as WAV

The movie's audio track is exported in the wave (*.wav) audio format.

Export as transition...

The movie is exported as an alpha fade in the MXV format. The brightness value of the movie depends
on how the fade functions. The option »EXPORT THE SELECTED RANGE ONLY« also specifies that
only a small part specified beforehand via the in and out points will be exported.

If you do not change the save location, you will locate the saved fade in the Media Pool under
»TRANSITIONS > STANDARD«.

Single frame as BMP file

Exports the image located at the playback marker and displayed in the video monitor as a bitmap
(*.BMP) file.
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Single frame as JPG

Exports the image located at the playback marker and displayed in the video monitor as a JPEG (*.JPG)
file.

Single frame as a PNG file

Exports the image located at the playback marker and displayed in the program monitor as a PNG
(*.png) file.

HEVC Encoder

In the "Advanced Settings" you can make detailed adjustments to the HEVC data flow. The advanced
settings are divided into "Video", "Audio", and "Multiplexer". Below is an explanation of all the settings
that can be changed.

Open advanced settings: File > Export > Video al HEVC > Advanced

Note: The preset values and status of the control element (locked/unlocked) depend on the selected
export preset.
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Video

Average bit rate (kBit/s) The values entered here are applied to the video as an average as a
guideline. The size of the video to be exported can only be
approximated.

Maximum bit rate
(kBit/s)

This is the maximum bit rate in the video stream, i.e. maximum number
of bits, that may be transferred to the decoder. This parameter only
takes effect in the "Variable" bit rate mode.

CPB (Coded picture
buffer)

The entered value specifies the maximum amount of storage space for
an encoded frame. Higher values can improve quality, but might also
cause problems during export. If export is aborted, lower this value.

Maximum GOP length Determines the maximum GOP length. High values mean improved
compression. Lower values create stronger security protection and
enable improved access to individual frames for processing the video.
A general rule: The shorter the GOP, the more compatible the generated
video file.

Tip: A good rule of thumb is to enter the frame rate as the GOP
length.

GOP structure The GOP structure is the sequence of the various frames. At the
beginning of a GOP there is an I-Frame, at the end there are several B-
Frames, followed by a P-Frame. The sequence of B-Frames und P-
Frames repeats until the end of the GOP.

Level HEVC defines various levels. The level determines which bit rate and
resolution are possible for the video. With the "Auto level" option, the
encoder determines the level automatically on the basis of the set video
format, the specified bit rate and the profile.

Coding quality This is the easiest way to set the ratio between coding duration and
quality. Select the setting which best suits your needs.
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Hardware
Acceleration/Decoding

n CPU hardware: Activate this option if your computer is fitted
with a powerful processor and the CPU is more powerful than
the graphics processing unit. The corresponding processing
step is performed by the main processor and will be supported
by the graphics card, if possible.

n GPU hardware: Activate this option if you have a powerful
graphics card and the GPU is more powerful than the CPU. The
corresponding processing step is performed by the graphics
card and reduce the load on the processor. This is particularly
useful for 4K videos. The graphics card's encoder is used.

n Software: The encoders provided are used. The complete
encoding process is performed by the CPU, without the support
of the graphics card.

Audio

Sample rate Here you can see the sample rate for audio encoding.

Bitrate (kBit/s) The desired bit rate is entered here.

Multiplexer

Streamable The generated video is suitable for live playback on websites.
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SHORTCUT

Playback functions

Start / Stop Spacebar

Increase playback speed in stages L
Shift + L

Stop playback (playback marker is stopped at the current
position)

K

Reverse playback or rewind in stages J
Shift + J

Speed up fast forward Shift + right arrow (hold down
keys)

Speed up rewind Shift + left arrow (hold down
keys)

Restart beginning at playback marker Backspace

Playback marker back to the beginning Home

Playback marker to end End

1 Frame back/forwards (only in Timeline mode) Left/right cursor

5 Frame back/forwards (only in Timeline mode) Ctrl+left/right-cursor.

Previous/next object (only in Storyboard Mode) Left/right cursor

Set project marker Ctrl + Enter key

Play from range start to range end #

Playback at current frame +

Activate smooth playback for preview P

Monitors

Program monitor fullscreen Alt + Enter key

Other resolution Alt + G
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Adjust program monitor to movie settings Ctrl + G

Adjust program monitor to selected video. Ctrl + Shift + G

Anaglyph display Ctrl+.

Display partially interlaced (left image first) Alt + .

Standard 2D .

Side-by-side display (left picture on the left) Shift +

Project window view

Zoom in Ctrl + Up

Zoom out Ctrl + Down

Play movie fullscreen Alt + Enter key

Movie overview Shift + A

Optimize view Shift + B

Zoom 1 frame / 5 frames Ctrl + 1/2

Zoom 1s / 5s / 1min/ 10min Ctrl + 3/4/5/6

Entire movie Ctrl + 8

Move view and start marker

To next object edge Alt + W

To previous object edge Alt + Q

To movie start Home

To movie end End

To beginning of range Ctrl + Home

To end of range Ctrl + End

Scroll left by page Page up

Scroll right by page Page down
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To scroll grid unit to left Ctrl + Pg Up

To scroll grid unit to right Ctrl + Pg Dn

To next project marker Ctrl + Shift + PgDn

To previous project marker Ctrl + Shift + Page up

To next snap marker Ctrl + Alt + Pg Dn

To previous snap marker Ctrl + Alt + Pg Up

To next scene marker Shift + Page down

To previous scene marker Shift + Page up

To next chapter marker Alt + Pg Dn

To previous chapter marker Alt + Pg Up

Go to right marker W

Go to left marker Q

To next empty range <

To previous empty range Shift + <

To next selected object Shift + W

To previously selected object Shift + Q

Select next object Ctrl + W

Select previous object Ctrl + Q

Mouse modes

Mouse mode for single objects 6

All tracks mouse mode 7

Single track mouse mode 8

Curve mode 9

Object stretch mode 0

Preview audio objects Alt + 6

Context help Alt + F1
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Insert modes

Automatic 1

Single track ripple 2

Multitrack ripple 3

Swap 4

Overwrite 5

Context menu

The context menu includes familiar functions from the menus as well as the following additional
functions:

Set audio/video offset Alt + O

Object properties Ctrl + E

Audio and waveform display

Create waveform display Shift + E

Video/Audio on one track Ctrl+U

Video/Audio on separate tracks Ctrl + H

File menu

New project Ctrl + N

Open project Ctrl + O

Save project Ctrl + S

Save project as... Shift + S

Record audio / images / video... R

Export to device... H

Batch conversion... S

Load backup project Ctrl + Shift + O
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CleaningWizard Ctrl + Shift + Y

Close Alt + F4

Manage project

Add a new empty movie Ctrl + Alt + N

Remove movie from project Ctrl + F4

Export MAGIX movie file Ctrl + Alt + L

Export movie

Export as AVI Ctrl + Alt + A

Export as DV AVI Ctrl + Alt + D

Export movie as an MPEG Ctrl + Alt + P

Video as MAGIX video Ctrl + Alt + M

Uncompressed movie Ctrl + Alt + U

Video as Motion JPEG AVI... Ctrl + Alt + O

Video as sequence of frames... Ctrl + Alt + E

Windows Media Export Ctrl + Alt + V

Video as MPEG-4 video Ctrl + Alt + G

Video as HEVC Ctrl + Alt + I

Audio as WAV Ctrl + Alt + W

Export as transition Ctrl + Alt + T

Single frame as BMP file... Ctrl + Alt + B

Single frame as JPEG... Ctrl + Alt + J

Backup copy

Copy project and media into folder Alt + S

Copy movie and media into folder Shift + R

Settings
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Film E

Program Y

Shortcut Ctrl + Shift + U

“Edit” Menu

Undo Ctrl + Z

Redo Ctrl + Y

Cut objects Ctrl + X

Copy objects Ctrl + C

Paste objects Ctrl + V

Duplicate objects D

Delete objects Del

Select all objects Ctrl+ A

Cut

Cut scene T

Remove scene start Z

Remove scene end U

Remove scene Ctrl + Del

Split movie Alt + Y

Musical editing adjustment Ctrl + Shift + M

Edit range

Cut range Shift + Del; Alt + X

Copy range Alt + C

Delete range Alt + Del

Insert range Alt + V

Extract range Shift + X
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Insert empty space into selected range C

Group objects G

Ungroup objects Shift + G

Wizards

MovieShowMaker Ctrl+M

Soundtrack Maker Ctrl + Shift + S

Combine audio Shift + D

Combine audio and video Shift + M

Start preview rendering Ctrl + R

Markers

Set project markers Ctrl + Enter key

Set snap markers Ctrl + P

Set chapter markers Shift + Enter key

Set chapter markers automatically Alt + Shift + Enter key

Delete chapter markers Ctrl + Shift + Enter key

Delete all chapter markers Ctrl + Alt + Enter key

Set range start I

Set range end O

Jump to range start Shift + I

Jump to range end Shift + O

Select range above blank space X

Mute audio tracks (Multicam) Alt + Shift + M

"Effects” menu

Movie effect settings Ctrl + Shift +
H

Video object effects
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Scene recognition Shift + Z

Edit with MAGIX Foto Designer Alt + Shift + D

Video effects

Brightness Alt + Shift + H

Contrast Alt + Shift + O

Gamma Alt + Shift + G

Color Alt + Shift + F

Color correction Alt + Shift + C

Chroma key video level Alt + Shift + B

Sharpness Ctrl + Alt + S

Video effects plug-ins Ctrl + Shift + P

Load video effects Ctrl + -

Save video effects Alt + -

Reset video effects Ctrl + Alt + -

Copy video effects -

Paste video effects Shift + -

View/Animation

Position/Size Alt + Shift + I

Section Alt + Shift + P

Camera/zoom shot Ctrl + Alt + Z

Rotation/Mirror Alt + Shift + R

Audio object effects

Normalize Alt + N

Decrease in volume Alt + L

Audio cleaning Alt + A

Echo/Reverb Shift + H
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Timestretch/resample Ctrl + Shift +
Q

Load audio effects Ctrl + +

Save audio effects Shift + +

Reset audio effects Ctrl + Alt + +

BPMWizard Alt + Shift + K

Volume curve Ctrl+Shift+V

Title effects

Title editor... Ctrl + T

Load title effects... Alt + T

Save title effects Ctrl + Shift + T

Effects library

Audio and video effects Alt + Shift + E

Transition effects Ctrl + Shift + B

Title effects Alt + Shift + L

Window menu

Reset window arrangement F9

Edit trimmer N

Object trimmer Shift + N

Mixer M

Master audio effect rack B

Program monitor Shift + V

Media Pool Shift + P

Activate next window Ctrl+Tab

Movie overview Shift + A

Optimize movie view Ctrl + F
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Zoom horizontal

Zoom in Ctrl + Up

Zoom out Ctrl + Down

Zoom 1/5 frame(s) Alt + 1/2

Zoom 1/10 second(s) Alt + 3/4

Zoom 1 minute Alt + 5

Zoom 10 minutes Ctrl + Alt + 6

Zoom to selected range Alt+F

Zoom to complete movie length F

Zoom vertical

Zoom in Ctrl + Shift + Page up

Zoom out Ctrl + Shift + Page down

Help Menu

Help F1

Context help Alt + F1

Show tooltips Ctrl + Shift + F1

About MOVIE STUDIO Alt + Shift + F1

Edit keyboard shortcuts

You can open the keyboard shortcut dialog via »FILE > SETTINGS > SHORTCUTS«. In this dialog you
can specify keyboard shortcuts for all MOVIE STUDIO menu functions. This allows you to adapt
existing shortcuts to your requirements or to add new ones.

The settings are automatically saved in a file upon closing the program, i.e. they will be available the
next time the program is used.

The complete menu tree of MOVIE STUDIO is displayed in the dialog.

Add keyboard shortcut

To add a keyboard shortcut, follow these steps:
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n Look for the required menu item and select it with click. The currently selected menu item will
be displayed under »CURRENT MENU ITEM«.

n Then, click on the »NEW KEYBOARD SHORTCUT« field.
n Type in the keyboard shortcut. You can also use combinations of any key with "Shift", "Alt", and

"Ctrl".
n Then click on »ASSIGN KEYBOARD SHORTCUT«. If the shortcut has already been assigned,

a warning will display.

Note: Please do not use the spacebar, ESC or Insert key (0 in the number block), as the functions of
these keys are permanently implemented in MOVIE STUDIO and can not be changed.

Keyboard shortcut list

Reset: Activates all preset shortcuts again.

Load: Previously saved shortcuts are loaded and activated again.

Tip: MOVIE STUDIO offers additional presets for those switching over from other programs. These
settings make it much easier to switch to MOVIE STUDIO.

If you have used a version of MAGIX Video Pro before and want to use the same keyboard shortcuts,
load Video_Pro_X.ssc for this version.

Warning: The current settings will be overwritten during loading. Save your current keyboard
shortcuts in advance if you would like to keep them.

Save: The current keyboard shortcuts can be saved after naming the file.

List: This button opens a window where a complete list of current keyboard shortcuts appears. You can
click on »COPY« to copy the list to the Windows clipboard for editing and printing using a text editor.

MOVIE STUDIO 2023 | MANUAL

Shortcut Edit keyboard shortcuts 227



MENUS
The MOVIE STUDIO user interface contains a menu bar at the top of the program window.

File menu

Keyboard shortcut

New project

Creates a newMOVIE STUDIO project. The start dialog will also open.

Open

With this option you can load a project or a media file. Please note that all media files associated with it
must be loaded along with a project.

MOVIE STUDIO will search for all used sounds and video files in the folders in which they were located
when the move was saved.

Recently opened projects

This feature provides a selection of recently opened projects.

Save project

The current project is saved with the name displayed in the project window. If you have not specified a
name for your project yet, a dialog will open for you to do so.

Save project as...

A dialog opens where you can specify the path and a name for saving the project.

Manage project

n Add a new empty movie:
Use this option to create a new movie for your recordings and imported files. Since a film is
normally already opened, you will have to decide whether the movie should be inserted into the
existing project or if a new project should be created.

n Merge movies:
Using this function you can attach a movie to an opened one. This is then attached to the end of
the movie and automatically takes on the original movie's settings.

n Remove movie from project:
With this option you can remove the current movie from the project. However, it is still
available on the hard drive and can be loaded again at any time.

n Rename movie:
You can enter a name for your movie here.

n Import movie file:
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l Import a MAGIX movie file (*.mvd):
Use this option to load a movie into your disc project. Please note that all media files
associated with it must be accessible. MOVIE STUDIO will search for all used sounds
and video files in the folders in which they were located when the movie was saved.

l Import an EDL (Edit Decision List):
Create an edit decision list in Samplitude EDL format and import it into MOVIE
STUDIO for additional editing. It is important in this case that the folder structure
remains unchanged. During importing into MOVIE STUDIO, the file locations must
match the place where they were when the cut list was created using MAGIX
Samplitude/Sequoia.
▬ If an empty project is opened, the complete EDL file will be imported.
▬ If the tracks are muted before importing the EDL file, then they will not be

removed.
▬ If there are already objects in the project, then you will be asked the files

should imported into the project or if a new project should be created for them.
n Export movie file:

l Export a MAGIX movie file (*.mvd)
A dialog will open to enter a file name for the movie to be exported. The movie may
then be imported into other projects again.

Note: The movie file (*.mvd) contains all information about the used media files,
cuts, effects, and titles, but not the picture and sound material itself. This is always
contained in the recorded or imported media files, which remains unchanged during
editing with MOVIE STUDIO. In order to save a movie in its own folder, e.g. for use
on another PC, use the function »COPY FILM ANDMEDIA TO FOLDER« under
"File > Backups".

l Export an EDL (Edit Decision List):
Create EDL files for additional editing in other programs, e.g. MAGIX Samplitude or
Sequoia.
Use the check boxes to select whether video and/or audio should be exported. As
required, a selection may be made whether individual tracks should be rendered or
referenced as original files via EDL. Video rendering takes place in the DV-AVI
format, and audio rendering as WAV stereo. For Surround projects, 6 mono files will
be rendered.
An export directory can be defined within the selection dialog. The EDL file and the
rendered files will be stored there as required.
Check boxes may be used to select whether the EDL file should be loaded directly
into Sequoia (if present). The program will then be either started or the file will be
directly opened within the running application automatically. The user can define the
Sequoia path in the input mask.
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Export movie

This provides all export formats supported by MOVIE STUDIO that aren't covered by burning.

For more information, see the section Export movie.

Record audio/images/video

A selection window for the Recording will open to choose the desired recording type. This may also be
accessed via the "Audio or video recording" button in the transport controls.

Import Audio CD track(s)

A CD track may be imported via drag & drop from the Media Pool just like a normal file. If this
convenient method fails for some reason, then this menu command may be accessed via the CD
manager to insert tracks from audio CDs directly into the project. More about this is available in the
section "Import audio CD".

Export to device

Here, you can transfer your finished video to external devices. Select the target device from the list.

Export to mobile devices:

Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to
be able to play a video.

The menu is divided into various device classes to make choosing your device easier. The last three
selections are saved as favorites in the top part of the device list if you have more than one device or
want to present your movies to your friends.

If your device is listed here, you don't have to worry about the format settings, as the necessary settings
of the export dialog are automatically customized to the target device. Simply select your device and
click "OK".

Output DV/HDV:

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

n For digital output please select "File" > "Output audio/video" and then select »CAMCORDER«

in the device menu. For DV cameras you can select the device» DV CAMERA« for HDV
camcorder »HDV1« or »HDV 2 CAMCORDER.«

By clicking on »SETTINGS«, you can open the respective export settings dialog (DV-AVI export for DV
camcorder, MPEG export for HDV camcorder). For most applications you should use the settings
defined here. »ADVANCED« takes you to the DV export settings.

n Now connect your camera and follow the displayed instructions.
If you want to export a rendered (already edited) movie to DV, there’s no need to render it again.
Instead simply activate the “Play own DV file” option and select your DV video from the “My audio
video” directory.
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Tip: Digital cameras that can digitally record via a PC connection are usually more expensive. You
may be able to reduce your purchase costs considerably by buying a digital camera that cannot
transfer digitally and have the function activated by a camera specialist. You should enquire about
this option before making your purchase.

DV export settings

PAL/NTSC: PAL is used in Europe; the United States, Canada, and Japan use NTSC. This option usually
does not require changing.

Render edited scenes only: Non-edited original files are simply copied into a completed DV AVI.
Normally you have to decompress the DV data, add the set effect calculations and recompress it. If no
effect processing is pending these steps may not be necessary. This option can be permanently
activated.

Use references to original files: Unprocessed original files are played back directly, effects are
rendered in real time. Only use this option for finished films without effects or edits because processing
real time effect with DV files in their original resolution uses a lot of processing power. Errors can occur
during playback due to the increased strain.

Export after rendering: If you want to render your film but not export it then deactivate this option. You
can export your film at a later date by selecting the "Export own DV file" option from the export dialog.

My device is not in the list. What can I do?

User-defined:

If your device does not appear in the list, you can set up the export settings manually. You only have to
do this once as these settings can be saved as a preset.

Read the Instruction manual of your mobile device to find out which file format is required. If your
device supports multiple formats, you can experiment around with which format gives you the best
results.

Specify the file format by opening the target device's menu and selecting "User-defined" > "Video" >
"...Format". If you click on "Export", you arrive at the Export dialog of the selected file format where you
can set all the advanced settings.

For details on these settings, please consult your device manual. Explanations for the file formats'
settings can be found in the Overview of the device classes chapter, for the special settings of the
export dialogs see "Export movie" in the File menu chapter.

Tip: If the format settings for your device are not accessible, you can try out a different device from the
same manufacturer and, using it as a template, carry out customizations accordingly.

Tip: If you find working settings, we recommend saving these as a preset for further use.

Batch conversion

This menu item accesses the batch processing function. This quickly and efficiently converts multiple
files, movies, or projects into various video formats.

Vimeo
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n Upload current movie as video: Once you login to Vimeo, the upload dialog will open. Enter
the title, description, and keywords and select whether you want your film to be public or
private. "OK" uploads the current film.

n Upload selected media in Media Pool: Once you login to Vimeo, the upload dialog will open.
Enter the title, description, and keywords and select whether you want your media to be public
or private. "OK" uploads the selected media.

Online

Producer Planet: Producer Planet is the online store for creative artists in the area of multimedia. As
well as a wide range of content fromMAGIX, such as Soundpools, virtual instruments, sound FX, stock
footage, video plug-ins and LUTs, Producer Planet enables audio engineers, beat producers, cutters and
ambitious independent filmmakers to access content from both established and up-and-coming
manufacturers and producers.

Youtube/Vimeo: This is a direct connection between MAGIX and various online communities.

n Upload current movie as video: Uploads the current film to the selected portal or to the
selected community. Enter the data for video into the fields provided, so that the search
function for this portal can also find this video.
MOVIE STUDIO partially uses the H.264 format for this, which is a component of the MPEG-4
codec. Since most communities and portals use this format, the movie does not need to be re-
rendered on the corresponding server. This avoids loss of quality.
When HD material is uploaded, a resolution of 720p is used for the HD format.

n Upload selected media in Media Pool: Uploads the media selected in the Media Pool to the
corresponding portal or the selective community.

Import media backup: Content (e.g. 3D transitions) which you've bought and downloaded is stored
directly in the folder My files\MAGIX Downloads\Backup. If you have downloaded iContent from other
MAGIX programs, then you can use the command »IMPORT MEDIA BACKUP« to make them
accessible for use in MOVIE STUDIO.

Cewe photo prints/As photo book

You can order the images in your project or in the Media Pool as a photo book, calendar, photo mug or
in another gift format. MOVIE STUDIO transfers the images to a separate program called CEWE
Photoworld.

Note: CEWE Photoworld software must be installed to order personalized gifts from CEWE (photo
books, prints, mugs, etc.). If it is missing, you can find it on the CEWE website.

Manage login details: In this dialog you can enter and manage your login details (email address and
password) for all services accessible fromMOVIE STUDIO. This way, you don't have to log in every
time you use the program.

Backup copy

Files must be saved to be able to be easily retrieved in case of a hard drive crash or a mistake.
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For detailed information, see the section about Backups.

Load backup project

This option loads an automatically created project backup. This type of automatic backup gets the file
extension MV_ (underscore). This option is useful in emergencies, e.g. if you unintentionally saved your
changes during editing and wish to return to the previous version of the movie.

Cleaning Wizard

A disc image is created each time you perform the burn process, so the hard drive can quickly fill up if
you burn a lot of discs. The clean-up wizard helps delete projects from the hard drive, including all of the
media files and disc images used. Use this function to free up disk space for future projects.

Warning! If the files you used in the slideshow have also been used in other slideshows (like trailers,
opening music, etc.), then you should make backup copies of these files beforehand.

For detailed information, see the Cleaning Wizard section.

Settings

n Film settings: Opens the Film settings of the currently selected movie.
n Program settings: Opens Program settings.
n Edit keyboard shortcut: This menu entry opens a dialog for editing keyboard shortcuts. You

can adjust MOVIE STUDIO to suit your needs.
n Language: Change the language used in MOVIE STUDIO here. Normally, the language that is

used for installation is set as the program language.
n Reset standard program settings: Use this function to reset all Program settings you made in

MOVIE STUDIO to their original settings.

Close

Exits MOVIE STUDIO.

"Edit" menu

Keyboard shortcut

Undo

This command allows you to undo the last changes made. This way, you can try out different methods
for doing an important task. If you don't like the result, you can always revert to the previous state using
"Undo".

Right-clicking the button opens a list of changes made so far, allowing you to undo several changes
made in sequence.
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Tip: You can adjust the length of the list to your needs in program settings. A general rule: The longer
the list, the more RAM is used.

Restore

This function undoes the previous "Undo" function.

Right-clicking on the arrow next to the button opens a list of changes made so far, allowing you to
restore several undo actions made in sequence.

Empty undo and cache memory

This option deletes the memory for undo commands and clipboard (cache).

Cut objects

This function extracts the marked scene and copies it to the clipboard. You can then use the "Paste"
command to insert it into any movie.

Copy objects

This function copies the selected scene (or the selected object, if you are in the Timeline mode) to the
clipboard. You can then use the "Paste" command to insert it into any movie.

Insert objects

This command inserts the clipboard material (photo or object) at the current position of the playback
marker.

Duplicate objects

This command duplicates all selected objects. The copies appear beside the original and can be placed
in the correct position using drag & drop.

Delete objects

This function deletes the selected scene (or the selected object, if you are in the Timeline mode).

Select all objects

All objects found in the project are selected.

Cutting

Editing functions are also accessible using the toolbar. The last selected function will appear in the
toolbar as a button.

n Cut scene: This command cuts a selected scene at the point where the playback marker is
positioned. Two independent objects are created.

n Remove scene start: This command cuts a scene at the point where the start marker is
positioned, and deletes all material that precedes the start position simultaneously.

n Remove scene end: This command cuts a scene at the point where the start marker is
positioned, and deletes all material behind the start position simultaneously.
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n Remove scene: If you want to cut a scene on track 1 out of a movie in the timeline mode at a
later stage, this option automatically moves objects, titles, and transitions on all tracks forward
so that no gaps are created in the film.
Objects on other tracks which extend into the area of the scene in question will not be moved
automatically; they will remain in their current positions.

n Split movie: This command divides the movie into two individual movies at the position of the
playback marker.
The current project window retains the portion that is located in front of the playback marker.
The remaining part will be removed from the current project window and turned into a new
movie. You can open this movie from the "View" menu.

Musical editing adjustment

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

If you have edited your background music with the beat detection wizard and a musical tempo was
provided, then you can adjust the cuts to change automatically in time with the beat using this
command. All hard cuts (edits without transitions) will be moved to occur on the musical quarter notes.

Range

MOVIE STUDIO offers object-based functions as well as "band-oriented" editing functions. These
always refer to the whole project from the first to the last track as well as to the range between the start
and end marker.

n Cut: The area between the start and end markers is cut from the current project and placed on
the clipboard. This section can be reinserted elsewhere.

n Copy: The area between the start and end markers in the current project is copied to the
Clipboard. This section can be reinserted elsewhere.

n Delete: The area between the start and end markers is deleted from the current project and no
longer saved on the clipboard.

n Paste: The contents of the clipboard are added into the current project at the position of the
start marker.

n Extract: The area between the start and end markers is retained, all the material in front and
behind it are then deleted. Use this option to isolate a specific part of an arrangement for further
individual editing.

n Insert empty space: An empty section the length of the period between the start and end
marker will be added to the first visible track. The objects following this will be moved.

Note: This function only applies to the first visible track. Therefore, it is necessary to scroll
through the arranger to bring the track you want up to the line at the top.

n Insert still shot: The start of the range is inserted as a still shot over the length of the range.
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Note: This function only applies to the first visible track. Therefore, it is necessary to scroll
through the arranger to bring the track you want up to the line at the top.

Group objects

All selected objects are assigned to a group which may be selected and edited jointly by clicking the
mouse.

Ungroup objects

This command splits an object group into separate objects.

Wizards

n Slideshow Maker:
The SlideshowMaker Wizard is ideal for converting still images into moving pictures, adding
background music, and effects.

n MAGIX Soundtrack Maker:
Music tracks that match the mood are generated automatically by Soundtrack Maker. Even
mood changes are possible.

n Travel route animation:
This menu entry opens the separateMAGIX Travel Maps program. This enables simple creation
of animated travel routes with the help of online maps.

Combine audio

This option joins all audio objects in one audio file. Afterwards, the audio material will only occupy one
track and take up hardly any RAM (but will take up space on the hard drive [ca. 10 MB/min in stereo]).
This way you have a clear overview of other objects and more space for them.

MOVIE STUDIO automatically normalizes the audio file, i.e. the loudest point of the wave audio object
is identical to the highest value of the 16-bit resolution ceiling. This guarantees the same sound quality,
even if you repeat the mix down procedure in the project window or you combine the mix down file with
other wave audio objects again and again. The mix down function is very helpful if you want to go on
using the mix down object.

Tip: To create the final AVI or WAV (or any other multimedia) file, we recommend using the various
option of the submenu "Export movie" option in "File", instead of the mixdown function.

Combine audio and video

In addition to the "Combine audio" function (see above), all video objects including effects, fades, and
edits are combined in a single MAGIX video file. If your computer starts to approach its limits, this
enables you to free resources for further editing.

Start preview rendering...

You may also instruct MOVIE STUDIO to render specific sections that are you are almost finished
editing with. This is especially useful if smooth playback is not possible due to the applied effects and
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transitions. The advantage versus the option "Combine audio and video" is that all of the objects will be
maintained in the arrangement. The rendered material will only be played in the background when the
playback marker reaches the corresponding position.

See "Preview rendering".

Remove range(s) for preview rendering

Removes preview rendering ranges. If multiple sections were defined and the playback marker is placed
over one of these sections, you will be asked whether you would like to remove only this "Section" or
"All".

Marker

More information on the subject can be found in the section "Markers".

Move view

Using these commands, a viewable portion together with the playback marker will be moved in the
timeline. You can quickly skip between different markers (skip, chapter, scene or ad markers) and object
edges.

Multicam

Note: This feature is available in the Plus/Premium version of MOVIE STUDIO.

Click on this to switch to "MulticamMode". Find out more in "Multicam editing".

Mute audio tracks (Multicam)

Once you switch to Multicam mode, all audio from the source tracks will be muted. You will only hear
the audio track of the final movie. If you wish to deactivate this function, remove the check. Now, you
can mute the audio tracks manually using the track headers.

Effects menu

Keyboard shortcut

Movie effect settings

This menu item accesses the Movie effects settings. The settings affected here apply to the entire
movie.

Video object effects

n Scene recognition: Opens the automatic Scene recognition function, which "cuts up" longer
videos into individual scenes.

n Edit in Photo Designer: Graphics files (BMPs or JPEGs) can be edited retroactively with an
external graphics program within the project window. The selected image file will be loaded
automatically and used in MOVIE STUDIO in place of the original material automatically.
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n Create panorama: Opens the dialog for setting a panorama. Place as many photos in the
correct order as you like, and align brightness and color settings to get the best results. You
should make sure that the photos harmonize at the transitions.

n Video effects: Here you can find adjustable effects for video and photo objects. The effects can
be set only after selecting an object in the respective effects dialog. For more information,
please see Video effects.

n Movement effects: These are movement effects you can use to animate the frame by using
zoom and camera movements.

n Movement effect templates: Load templates for movements into the project using drag &
drop.

n Section: Places video objects in a particular part of the screen. Find out more under Video
effects.

n Stereo3D: Find out more about Stereo3D functionality in the Stereo3D section.
n Background design: Select a color, a picture, or any video on your hard disk, which you would

like to serve as the background for the photo displayed. This function is especially useful when
photos have black bars around them, or if they are reduced in size.

n Reset background: Resets the background design settings to default settings.
n Use as background: Uses the selected photo and video as the background.
n Load video effects: This command enables a saved effects combination to be loaded for the

currently loaded object. If multiple objects are selected, then the effects combination will be
applied to each selected object.

n Save video effects: This command saves the current effects combination for each object
separately.

n Reset video effects: This option allows you to deactivate all currently used effects. The
material will be reset to the state it was in before you applied the effect.

n Copy video effects: Effects settings for an object may be copied to the clipboard to add them
to other objects.

n Paste video effects: Video effects may be inserted into the selected object from other objects.
The settings must be copied to the clipboard beforehand to do so.

n Apply video effects to all: The current effects settings will be applied to all scenes and photos
in your movie.

n Apply video effects to all of the following: The current effects settings will be applied to all
scenes and photos in your movie which lie behind the selected object.

Audio object effects

n Normalize (maximum level): The function "Normalize" raises the level of an audio object to
the maximum possible level without clipping the material. This searches for the largest signal
peak in the audio material and raises the level of the object so that this position matches
exactly 0 dB (maximum overdrive).
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n Normalize (EBU R128): EBU R128 is a transceiver standard that normalizes the audio signal to -
23 LUFS (loudness units relative to the digital full level). Unlike normalizing to the maximum
level, this provides enough upward space for temporarily loud signals. This is used, for example,
by cinema productions and classical recordings.

n Adjust loudness of selected objects: Regardless of the standard level, the sound levels of the
selected objects are compared with each other with respect to volume. The clicked object is
used as the reference.

n Set volume: This function, located in both the effects menu and the context menu, control the
sound volume for individual objects, just like the object handles in the project window.

n Volume reduction: Read more about this in Volume reduction.
n Audio leaning: Opens the Audio cleaning dialog.
n Echo/Reverb: Read the sections Echo and Reverb for more information.
n Timestretch/Resample: Read more about this in Timestretch/Resample.
n Load audio effects: This command enables a saved effects combination to be loaded for the

currently loaded object. If multiple objects are selected, then the effects combination will be
applied to each selected object.

n Save audio effects: This command saves the current effects combination for each object
separately.

n Reset audio effects: This option allows you to deactivate all currently used effects. The
material will be reset to the state it was in before you applied the effect.

n BPMWizard: Read more about this topic in Musical editing adjustment.
n Edit wave externally: This opens the audio track or audio object in the included audio editor

MAGIX Music Editor.
n Volume curve: You can access the volume here. This is also located in the Media Pool under

"Effects > Audio effects > General" and can be animated.

Title effects

n Title editor: Opens the title editor.
n Load title template: Use this command to load previously saved title effects for the current

object.
n Save title template: You can save the current effect combination for each title object

separately and apply it to other title objects later.

Design elements

n Picture-in-picture: These are various effects presets for image stacking.
n Collages: These work similarly to normal picture-in-picture effects but more objects are used.

Depending on the collage, arrange the selected objects one after the other and drag the collage
onto the first object.

n Test images: These are professional test images for calibrating your system.
n Backgrounds: Here you can find static and animated photo and video backgrounds. Video

backgrounds are capable of being looped, meaning that their length can be extended by
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duplication. The special "custom" template opens a color selection dialog where you can
choose the desired color.

n Image objects: These are various image objects like black bars, thought bubbles for cartoons,
etc.

You can find additional information in the section "Design elements in Media Pool".

Effects library

Using these menu choices you can control the corresponding folders with the Media Pool.

"Window" menu

Keyboard shortcut

Window arrangement

n Standard: This option switches from the multiple monitor setting (see below) back to the
standard single monitor setting.

n Multimonitor with maximized program monitor: This option can be used when several
computer monitors are connected. It enlarges the program monitor for a fullscreen display on
one of the connected monitors. The other elements are displayed on a second monitor.

n Save: You can save any alignment and combination of visible windows. These can then be
easily switched between using menu commands. Click on "Save" and enter a name for the
current alignment. In the "Media Pool", you can define whether the selected tab (main
navigation) and section (subnavigation) should be saved along with the alignment.

The first three custom window layouts are automatically assigned the keyboard shortcuts
F10, F11 and F12. By going to »"FILE" > "SETTINGS" > "KEYBOARD SHORTCUTS..." YOU

CAN« assign keyboard shortcuts to additional layouts.

n Delete: Any custom window layouts you create can be deleted. Simply select the alignment
you want to delete in the dialog that opens, then click on the Delete button.

n Reset window arrangement: If you have moved the windows around in MOVIE STUDIO, you
can put them back to the original position using this command. (Keyboard shortcut: F9)

Edit trimmer

Opens the edit trimmer. This allows you to make fine adjustments to the position of the selected video
or image objects and their handles, as well as the transition characteristics (Transition type, length).
More about this is available in the "Editing" section.

Object trimmer

Opens the object trimmer. Calls up the video trimmer, which will help you fine tune the position and the
handles of selected video and image object More about this is available in the "Editing" section.
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Mixer

Opens the "Mixer".

Master Audio Effect Rack

Opens the Master Audio Effect Rack. More information on this is available in the Audio effects section.

Mastering Suite

Opens the Mastering Suite.

Program monitor

Hides or shows the program monitor.

Media Pool

This option hides or displays the Media Pool.

Project

Shows or hides the project window.

Project folder

Hides or shows the project folder.

Activate next window

Switch between the different windows (interfaces) of the program.

Movie overview

With this option you can display an overview of the entire arrangement on the program monitor. It is
particularly suitable for long and complex arrangements to prevent you from losing track. You can view
the whole movie and you are, despite this, able to access the sought object – you can zoom in directly
on the program monitor or move around the clip displayed in the project window.

Optimize movie view

The zoom level is set to 100% so that you can see every object and the entire film. The start and
end markers are set to the beginning or end, so that the entire movie can be played.

Zoom horizontal

Here you will find a range of functions for adjusting the visible time axis section.

Zoom vertical

The number of simultaneously visible tracks can be changed here. The more tracks that are visible, the
smaller they will appear.

Remove all movies from project
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All movies in the open project are removed. If you want to use these movies later with the current
changes like cuts, effects and titles, you can export them by selecting »"FILE" > "MANAGE MOVIE" >
"EXPORT"«. The current movie edits will be saved, but not the source material. If you delete the source
material, your edits can no longer be restored.

"Share" menu

Here you will find many options for for quickly and easily publishing your data from the program on the
web. Additionally, data transfer into other programs for specialized editing, if you have such programs
installed, is enabled.

Vimeo

Upload current movie as video: Once you login to Vimeo, the upload dialog will open. Enter the title,
description, and keywords and select whether you want your film to be public or private. "OK" uploads
the current film.

Upload selected media in Media Pool: Once you login to Vimeo, the upload dialog will open. Enter the
title, description, and keywords and select whether you want your media to be public or private. "OK"
uploads the selected media.

Youtube

Upload current movie as video: Uploads the current film to the selected portal or to the selected
community. Enter the data for video into the fields provided, so that the search function for this portal
can also find this video.

MOVIE STUDIO partially uses the H.264 format for this, which is a component of the MPEG-4 codec.
Since Flash supports this format directly and most communities and portals use the format, the movie
does not need to be re-rendered on the corresponding server. This avoids loss of quality.

When HD material is uploaded, a resolution of 720p is used for the HD format.

Upload selected media in Media Pool: Uploads the media selected in the Media Pool to the
corresponding portal or the selective community.

Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog, will appear when the codec is required.

Additional options

Additional options will be displayed depending on the programs installed on your PC. For example, you
can edit photos or graphics in Xara Web Designer or Xara Photo & Graphic Designer, the audio can be
improved in MAGIX Audio Cleaning Lab, or you can add audio dubbing to your movie with MAGIX
Music Maker.
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Cewe photo prints/As photo book

You can order the images in your project or in the Media Pool as a photo book, calendar, photo mug or
in another gift format. MOVIE STUDIO transfers the images to a separate program called CEWE
Photoworld.

Note: CEWE Photoworld software must be installed to order personalized gifts from CEWE (photo
books, prints, mugs, etc.). If it is missing, you can find it on the CEWE website.

"Help" Menu

Keyboard shortcut

Help

This command is available at almost every point of this program and opens the program Help at the
corresponding topic. You can use this command to get help on any function in MOVIE STUDIO.

Context help

The mouse cursor will turn into an arrow with a question mark. Click on any button in the main screen
to open program help.

Download manual (PDF)

Downloads the manual in PDF format. An Internet connection is required for this. It contains all of the
important information about the program, as well as the program Help, which can be accessed by
pressing F1.

Display online tutorial videos

Displays tutorial videos on different video editing topics in MOVIE STUDIO.

Tip: If you are using MOVIE STUDIO for the first time, we recommend you view the tutorial videos
first. They will give you a quick introduction to the most important topics.

Show tooltips

Tooltips are small information windows that open up automatically if the mouse pointer stops briefly on
a button or some other area. They provide information about the function of the button. They can be
switched on or off with this option.

magix.info

Directly from within the program you'll be able to access magix.info, the Multimedia Community from
MAGIX. You'll find answers to all the most frequently asked questions about MAGIX products and
multimedia in general here. Unable to find a solution to a specific issue? Just ask the question yourself
and you're sure to get help from the community in no time at all.

Finding the software course
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This opens a MAGIX webpage with offers for software courses for MAGIX applications.

Register online

If you are using a trial version of a MAGIX program, you can extend the period of use by registering the
product or purchasing a full version.

Update online

This option connects directly to the MAGIX online update page where you can get the latest version of
your program.

Install extra content

This opens a dialog where you can install additional codecs and extra content.

Activating content packs

Use this menu option to activate the additional programs included in the Premium version. Enter the
coupon code in the dialog for the content pack. The add-on software will be downloaded and installed
automatically. In addition, five free downloads will be added to the Store, which can be used for any
Store content.

Deactivate program

This menu item deactivates MOVIE STUDIO with immediate effect. After deactivation, it is possible to
immediately install and activate MOVIE STUDIO on another computer.

Download my Store content

Downloads all previously purchased and activated Store content and adds it to the Templates section of
the Media Pool.

Delete local Store content...

Deletes all previously downloaded Store content. Deleted content can be downloaded again at any time.

About MOVIE STUDIO

Displays copyright info and version number of MOVIE STUDIO.
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ACTIVATING AND USING CODECS
Special encoders/decoders are needed to use and generate various file formats.

Why does it have to be "activated"?

To import (decode) or export (encode) certain video and audio formats you will require a specific codec
to be able to read in and export these formats. As soon as a corresponding decoder or encoder is
needed, MOVIE STUDIO will notify you and ask you if you would like to activate it.

The integration of decoders and encoders from third parties usually costs software developers money.
These codecs are therefore added to MAGIX programs via a voluntary activation, which may be free or
require a charge for expensive specialist codecs. It is therefore possible for MAGIX to provide an
optimum price/performance ratio for your software in the future.

The following codes are automatically activated when needed:

MPEG-2/MPEG-4 basic (standard)

These codes are needed for importing and exporting MPEG-2 and MPEG-4 videos. The codecs are
activated individually and are free.

Use cases:

n MPEG-2:MPEG-2 import and export as well as burning DVDs and Blu-ray discs.
n MPEG-4:MPEG-4 import and export as well as burning AVCHD discs.

If there are file compatibility problems, you can optionally activate and test the following codec as an
alternative to MPEG-4 Basic (default). However, hardware acceleration is not available using this codec.
Activation is fee-based.

MPEG-2 Encoder (Intel)

In the "Advanced Settings", you can make detailed adjustments to the MPEG-2 data flow. The advanced
settings are divided into "Video", "Audio", and "Multiplexer".

Open advanced settings: File > Export > Video as MPEG video > Advanced

Note: The preset values and status of the control element (locked/unlocked) depend on the selected
export preset.
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Video

Bit rate mode The bit rate indicates how much data per second is saved in the video (playback
speed). This makes the bit rate the deciding parameter with regard to the file size
and quality of the video to be encoded. A higher bit rate means better quality, but
also a larger file size.

n Constant: The exact value entered in "Average bit rate" is applied which
enables precise calculation of the video size.Constant: The exact value
entered in "Average bit rate" is applied which enables precise calculation
of the video size.

n Variable: The value entered in "Average bit rate" is used as an
approximate guideline for the value applied to the video. This means that
the size of the video can only be estimated.

Average bit
rate (kBit/s)

The values entered here are applied to the video as an average as a guideline. The
size of the video to be exported can only be approximated.

Maximum bit
rate (kBit/s)

This is the maximum bit rate in the video stream, i.e. maximum number of bits,
that may be transferred to the decoder. This parameter only takes effect in the
"Variable" bit rate mode.

CPB (coded
picture buffer)

The entered value specifies the maximum amount of storage space for an
encoded frame. Higher values can improve quality, but might also cause problems
during export. If export is aborted, lower this value. The setting "0" means that
the encoder has determined the disk space.

Maximum GOP
length

Determines the maximum GOP length. High values mean improved compression.
Lower values create stronger security protection and enable improved access to
individual frames for processing the video.
A general rule: The shorter the GOP, the more compatible the generated video
file.

Tip: A good rule of thumb is to enter the frame rate as the GOP length.

GOP structure The GOP structure is the sequence of the various frames. At the beginning of a
GOP there is an I-Frame, at the end there are several B-Frames, followed by a P-
Frame. The sequence of B-Frames und P-Frames repeats until the end of the
GOP.
Example:

A GOP with a length of 20 and the "IBBP" structure will look like this:

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Frame I B B P B B P B B P B B P B B P B B P B
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Profile Profiles define the encoder properties that are supported.
n Main: This profile was originally intended for the broadcast industry and

for backup purposes. It has become less popular since the development
of the "High Profile" for this purpose.

n SIMPLE: Intended to be used as the basic profile for applications with
limited computational power, e.g. video conferences or mobile phone
videos. This profile does not allow B-Frames, which first and foremost
means more data traffic, but contributes to better reliability.

n HIGH: This profile is used for broadcast and backup applications and is
also sometimes used in the HDTV industry (High Definition Television).
This profile is used for Blu-ray discs.

Note: You should only change this setting when there are problems playing
back the generated video.

Level MPEG-2 defines various levels. The level determines which bit rate and resolution
are possible for the video. With the "Auto level" option, the encoder determines
the level automatically on the basis of the set video format, the specified bit rate
and the profile.

Coding quality This is the easiest way to set the ratio between coding duration and quality.
Select the setting which best suits your needs.

Hardware
Acceleration

n CPU hardware: Activate this option if you have a powerful processor
installed on your computer and the CPU is more powerful than the
graphics processor. The corresponding processing step is performed by
the main processor and will be supported by the graphics card, if
possible.

n Software: The encoders provided are used. The complete encoding
process takes place on CPU, without graphics card support.

Smart Copy If this option is activated, unedited MPEG-2 material with hard cuts is transferred
without changes. This drastically accelerates the encoding process. The transfer
always takes place on the GOP borders is not frame-precise.

HRD
(Hypothetical
Reference
Decoder).

When this option is activated, a virtual decoder checks the data stream for
compatibility with the video standard during the encoding process. This ensures
that the generated video is compatible with various playback devices, but it also
slows down the encoding process.
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Audio

Sample
rate (Hz)

Here you can set the sample rate for audio encoding. For DVDs the standard is set to
48 kHz. If you change the settings here, it may result in not being able to play back the
sound or the entire video.

Channels Determines the number of audio channels.
n Mono: 1 channel, mono sound
n Stereo: 2 channels, one for left and one for right.

Bit rate
(kBit/s)

The desired bit rate is entered here.

Audio
Encoder

This is where you define how audio material will be coded, or whether it should be
written to the exported file as an uncompressed PCM data. If PCM is used, you can no
longer adjust sample rate and bit rate.

Image Tab

Interlace: Specifies whether the video is coded in frames or fields (in interlaced scanning, also
"Interlaced").
n Progressive: The video is coded in frames.
n Bottom field first: The video will be interlaced. The lower lines (Bottom field)

are used for the first field and upper lines for the second.
n Top field first: The video will be interlaced. The upper lines (Top field) are

used for the first field and the lower lines for the second.

MPEG-4 encoder settings (Intel)

In the "Advanced Settings", you can make detailed adjustments to the MPEG-4 data flow. The
advanced settings are divided into "Video", "Audio", and "Multiplexer".

Open advanced settings: File > Export > Video as MPEG-4 > Advanced

Note: The preset values and status of the control element (locked/unlocked) depend on the selected
export preset.
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Video

Bit rate mode The bit rate indicates how much data per second is saved in the video (playback
speed). This makes the bit rate the deciding parameter with regard to the file size
and quality of the video to be encoded. A higher bit rate means better quality, but
also a larger file size.

n Constant: The exact value entered in "Average bit rate" is applied which
enables precise calculation of the video size.Constant: The exact value
entered in "Average bit rate" is applied which enables precise calculation
of the video size.

n Variable: The value entered in "Average bit rate" is used as an
approximate guideline for the value applied to the video. This means that
the size of the video can only be estimated.

Average bit
rate (kBit/s)

The values entered here are applied to the video as an average as a guideline. The
size of the video to be exported can only be approximated.

Maximum bit
rate (kBit/s)

This is the maximum bit rate in the video stream, i.e. maximum number of bits,
that may be transferred to the decoder. This parameter only takes effect in the
"Variable" bit rate mode.

CPB (coded
picture buffer)

The entered value specifies the maximum amount of storage space for an
encoded frame. Higher values can improve quality, but might also cause problems
during export. If export is aborted, lower this value. The setting "0" means that
the encoder has determined the disk space.

Maximum GOP
length

Determines the maximum GOP length. High values mean improved compression.
Lower values create stronger security protection and enable improved access to
individual frames for processing the video.
A general rule: The shorter the GOP, the more compatible the generated video
file.

Tip: A good rule of thumb is to enter the frame rate as the GOP length.

GOP structure The GOP structure is the sequence of the various frames. At the beginning of a
GOP there is an I-Frame, at the end there are several B-Frames, followed by a P-
Frame. The sequence of B-Frames und P-Frames repeats until the end of the
GOP.
Example:

A GOP with a length of 20 and the "IBBP" structure will look like this:

No. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Frame I B B P B B P B B P B B P B B P B B P B
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Profile Profiles define the encoder properties that are supported.
n Main: This profile was originally intended for the broadcast industry and

for backup purposes. It has become less popular since the development
of the "High Profile" for this purpose.

n HIGH: This profile is used for broadcast and backup applications and is
also sometimes used in the HDTV industry (High Definition Television).
This profile is used for Blu-ray Discs.

Note: You should only change this setting when there are problems playing
back the generated video.

Level H.264 defines different levels. The level determines which bit rate and resolution
are possible for the video. With the "Auto level" option, the encoder determines
the level automatically on the basis of the set video format, the specified bit rate
and the profile.

Coding quality This is the easiest way to set the ratio between coding duration and quality.
Select the setting which best suits your needs.

Hardware
Acceleration

Computers sometimes require a lot of time to process videos and images. You
can offload compute-intensive processes to your graphics card (GPU) or main
processor (CPU) to speed up decoding or encoding process.
n CPU hardware: Activate this option if you have a powerful processor

installed on your computer and the CPU is more powerful than the
graphics processor. The corresponding processing step is performed by
the main processor and will be supported by the graphics card, if
possible.

n GPU hardware: Activate this option if you have a powerful graphics card
and the GPU is more powerful than the CPU. The corresponding
processing step is performed by the graphics card and reduces the load
on the processor. This is particularly useful for 4K videos. The graphics
card's encoder is used.

n Software: The encoders provided are used. The complete encoding
process takes place on CPU, without graphics card support.

Smart Copy If this option is activated, unedited AVCHDmaterial with hard cuts is transferred
without changes. This drastically accelerates the encoding process. The transfer
always takes place on the GOP borders is not frame-precise.

HRD
(Hypothetical
Reference
Decoder)

When this option is activated, a virtual decoder checks the data stream for
compatibility with the video standard during the encoding process. This ensures
that the generated video is compatible with various playback devices, but it also
slows down the encoding process.
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Audio

Sample rate (Hz) Here you can set the sample rate for audio encoding.

Channels Determines the number of audio channels.
Stereo: 2 channels, one for left and one for right.

Bit rate (kBit/s) The desired bit rate is entered here.

Image Tab

Interlace: Specifies whether the video is coded in frames or fields (in interlaced scanning, also
"Interlaced").
n Bottom field first: The video will be interlaced. The lower lines (Bottom field)

are used for the first field and upper lines for the second.
n Top field first: The video will be interlaced. The upper lines (Top field) are

used for the first field and the lower lines for the second.
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